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Documentation Updates

To verify that the manual you are using is the most recent edition available, go to:
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Support

Please visit the HP OpenView support web site at:
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Overview

This chapter covers the following topics:
e Service Desk and Process Automation
e Service Desk reporting in context
e Three report packs for Service Desk:
— Help Desk Report Pack
— Change Management Report Pack
— SLM Report Pack
e Data collection or data export? (SD 4.5 and SD 5.0/5.1 differences)
e How to open reports and admin forms
e  Ways to customize reports

e Sources for additional information

Service Desk and Process Automation

Service Desk was created so that IT organizations could reduce unwanted errors, operate
faster and more efficiently, and gradually improve the quality of their services. These goals
were achieved by automating the internal processes that an IT organization uses to deliver
services to paying customers. The following internal processes are automated by Service
Desk:

e Service call processing

e Incident tracking

e Problem tracking

e Change approval

e  Work orders and work flow

e Service design and definition

e Compliance tracking

e End of evaluation period forecasting

Automating internal processes empowers the helpdesk analyst, the system manager, and the
service manager. The helpdesk analyst has immediate access to the background information
needed to resolve service calls as quickly as possible. The system manager can track incidents
and service calls, see the need for a change, and then respond to that need by starting the
change approval process, creating a work order, and tracking work flow from start to finish.
The service manager can design a service by specifying the components that support the



service, the customers that receive the service, a support level, and compliance criteria.
Service Desk calculates the current level of compliance, predicts what compliance will be like
at the end of the current evaluation period, displays availability and compliance calculations
in forms and views, and draws the service manager’s attention to configuration items that
have been associated with service calls and incidents.

Service Desk can answer many questions very quickly. What service calls are associated with
this particular configuration item? What incidents are associated with this particular
configuration item? What work group is handling this work order? Which tasks within this
particular work order have not been accomplished yet? Who has and hasn’t responded to my
change approval request? Although Service Desk can answer a lot of questions quickly, there
are some questions that Service Desk alone cannot answer. Here is a sampling of those
unanswered questions:

e How many service calls are we handling?

e  What portion of incoming service calls are we closing on the first call?

e What is our average close time for escalated database problems?

e Are we meeting our deadlines for system upgrades?

e How do we tell upper management what the help center is doing every month?

e Can we measure the progress we are making in improving service to customers?

e  What percentage of service calls are really enhancement requests?

¢ In which future product releases are we planning to address customer complaints?

e Management would like to know how customers were affected by a network outage. Can
we easily document the impact for management?

If you are intrigued by the notion that a set of interactive reports could answer these
questions, quickly and easily, then you will want to know more about HP OpenView
Performance Insight (OVPI) and the reporting solutions created for Service Desk.

Service Desk Reporting in Context

The Service Desk reporting solutions install on HP OpenView Performance Insight (OVPI).
OVPI is a performance management and reporting application. OVPI’s primary strengths are
long-term data collection, in-depth analysis of trends, and web-based reporting. The following
features are contributing to the product’s success:

e Distributed architecture

e External data sources

e Multi-company security model

e CODA/OVPA agent support

e Easy to scale (supports data collection from thousands of agents)

e Historical data storage

e Near Real Time reporting (periodic, as opposed to very near real time reporting)
e Forecasting

e Aggregation (by day, week, month; by location; by customer)

e Alerting
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OVPI runs many kinds of reporting solutions. We cover these areas:
e Infrastructure Usage
— Interfaces
— Devices
e LAN/WAN Edge
— Frame Relay (SNMP only)
— ATM (SNMP only)
e  WAN Core
— Frame Relay (multiple vendors)
— ATM (multiple vendors)
e Traffic Profiling
— RMON II
— NetFlow Interface/NetFlow Global View
e [P Telephony
— Cisco IP Telephony Call Detail
— Cisco IP Telephony Statistics
¢ Quality Assurance
— Cisco Ping
— Service Assurance
— IP Access Rate
e System
— System Resources
e MPLS VPN

In addition to the areas listed above, we have solutions aimed internally, at HP OpenView.
The OpenView products include Network Node Manager, Internet Services, OVPA, OpenView
Operations, Business Process Insight, the Smart Plug-ins that run on NNM and OVO, and
Service Desk. All reporting solutions have the following goals in common:

¢ Identify bottlenecks
e Improve capacity planning

¢  Produce compelling documentation for management

Three Service Desk Report Packs

If you have previous experience with OVPI, you know that an individual report belongs to a
bigger installable package known as a report pack. You also know that report packs are
installed using Package Manager and that Package Manager is part of the Management
Console. The May 2006 release of reporting solutions for OVPI includes three report packs for
Service Desk:

e Help Desk Report Pack 1.1 (30 reports)
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Change Management Report Pack 1.1 (10 reports)

SLM Report Pack 1.0 (11 reports)

Each report pack corresponds to a Service Desk module. If you have Service Desk 4.5, and you
are licensed to use the Help Desk and Change Manager modules, then you can install and use
the Help Desk Report Pack and the Change Management Report Pack. If you have Service
Desk 5.0 or 5.1, and you are licensed to use the Help Desk, Change Manager, and Service

Level Manager modules, then you can install and use all three report packs.

There are no dependencies between the Service Desk report packs. You may install all three
report packs, any two of them, or just one.

Help Desk Report Pack

The Help Desk Report Pack contains reports about service calls, incidents, and problems.

Service Calls

Average Duration of Service Calls
Service Calls by Category

Service Calls by Classification

Service Calls Closed before Deadline by Category

Service Calls Closed by Deadline
Service Calls Closed on First Call
Service Call Details

Service Calls by Closure Code
Incoming Service Calls (History)

Incoming Service Calls (Recent)

Incidents

Average Duration of Incidents

Incidents by Category

Incidents by Classification

Incidents Closed Before Deadline by Category
Incidents Closed by Deadline

Incidents Closed on First Call

Incident Details

Incidents by Closure Code

Incoming Incidents (History)

Incoming Incidents (Recent)

Problems

Average Duration of Problems

Problems by Category

Chapfer 1



Overview

Problems by Classification

Problems Closed before Deadline by Category
Problems Closed by Deadline

Problems Closed on First Call

Problem Details

Problems by Closure Code

Incoming Problems (History)

Incoming Problems (Recent)

Change Management Report Pack

The Change Management Report Pack contains the following reports:

Average Duration of Changes

Changes by Category

Changes by Classification

Changes Closed before Deadline by Category
Changes Closed by Deadline

Changes Closed on First Call

Changes Details

Changes by Closure Code

Incoming Changes (History)

Incoming Changes (Recent)

Service Level Management Report Pack

The reports in the SLM Report Pack are role-specific. The roles are:

Customer Business Manager
Customer Relationship Manager

Service Manager

The reports in the SLM Report Pack provide the following statistics:

SLA and SLO Compliance during SLA evaluation periods
SLA and SLO compliance at the end of periods
Service and CI availability over time

Service and CI Metric values over time

Objective thresholds in graphs (for metric values and compliance percentage)

Service hours and CI planned downtimes as grey areas in graphs



Customer Business Manager Reports

The following reports are for the Customer Business Manager:
e SLA Overview for Customer Business Manager

¢ SLA Detail for Customer Business Manager

e Service Detail for Customer Business Manager

e SLO Detail for Customer Business Manager

Customer Relationship Manager Reports

The following reports are for the Customer Relationship Manager:
e SLA Overview for Customer Relationship Manager

e  SLA Detail for Customer Relationship Manager

e Service Detail for Customer Relationship Manager

e SLO Detail for Customer Relationship Manager

Service Manager Reports

The following reports are for the Service Manager:
e Service Overview for Service Manager
e Service Detail for Service Manager

¢ Configuration Item Detail for Service Manager

Data Collection or Data Export?

If you are using Service Desk 4.5, you must install one datapipe for each report pack. The
datapipe uses a connection with the Service Desk database to collect data about service calls,
incidents, problems, and changes. If you have Service Desk 5.0 or 5.1, datapipes are not
needed. Service Desk 5.0 and 5.1 can export data to OVPI. The data export function, which
you control and monitor from the OpenView Console Reporting Administration workspace
view, eliminates the need for datapipes.

If you have Service Desk 5.0 or 5.1 and you want to install the SLM Report Pack, you must
install DimensionManager and DataFeeder on OVPI. These programs are distributed on the
Service Desk DVD. If you are not installing the SLM Report Pack, there is no need to install
DimensionManager and DataFeeder on OVPI.

Data will not appear in reports the same day you install the report pack. Data will not appear
in reports until after the first daily summarization. The first daily summarization will run at
2:00 a.m. Will the report you see tomorrow, after installing a report pack today, include
trending data for Service Desk events that took place last year, or last month, or last week?
The answer is no. OVPI does not gather historic data from Service Desk and generate
trending analysis based on historic data. OVPI takes new data from Service Desk and
assembles the historic view gradually, over time. Install a report pack today and tomorrow
you will see statistics for the events that took place today. You will not see your first weekly
summary until next week, and you will not see your first monthly summary until the current
calendar month ends and the next calendar month begins.
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How to Open Reports and Forms

Chapter 3, Installation in a Service Desk 5.0/5.1 Setting, mentions two consoles, the
Management Console and the OpenView Console. The Management Console is the front-end
GUI interface for OVPI. The OpenView Console is a front-end GUI interface. Only when OVPI
and Service Desk are installed on the same machine (standard procedure for report pack
demonstration purposes) can you access both consoles from the same machine. In a
production environment, this is not feasible. In a production environment the Management
Console and the OpenView Console are always on separate machines.

If you are using Service Desk 4.5, you have three ways to open reports:

e OVPI Report Viewer

e OVPI Report Builder

e Web browser

If you are using Service Desk 5.0 or 5.1, you have four ways to open reports:
e OVPI Report Viewer

e OVPI Report Builder

e Web browser

e OpenView Console

Opening Reports from the OpenView Console

To open a report from the OpenView Console, follow these steps:
1 Open a workspace view. Select one of the following workspaces:
e Change
e Service Call
¢ Problem
¢ Incident
e Service
e Service Level Agreement
¢ Configuration Item
2 The workspace view opens. Select an object in the view, then click Actions.

3 The Actions drop-down menu includes a list of reports. The object you selected is present in
each report.

4 Click the report you want to open.

Opening Reports from Viewer

To open a report using the OVPI Report Viewer application, follow these steps:
1  Go to the machine where the OVPI client applications are installed.
2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Viewer

3 Report Viewer opens. Select File > Open to display a list of reports.
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Opening Reports from Builder

To open a report using the OVPI Report Builder application, follow these steps:
1  Go to the machine where the OVPI client applications are installed.

2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Builder
3 Report Builder opens. Select File > Open.

From Report Builder you have access to parameters, elements, links, and properties. You will
see the parameters, elements, and links in a component tree. Properties appear in a list below
the component tree. The contents of the properties list will change depending on where you
are in the component tree.

Opening Reports from Your Web Browser

Follow these steps to open reports from your web browser:

1 Enter the address of the OVPI Web Access Server in your web browser.

2  Click Log On.

3 In the Connect To window, type your OVPI username and password and click OK.
4  Click Catalog.

5 Expand the System folder.

6 Expand the report pack.

7

Select a report.

Configuration and Logging Reports

There are multiple administrator reports, one per report pack:
e Help Desk Management Configuration and Logging Report
¢ (Change Management Configuration and Logging Report

e SLM Configuration and Logging Report

Each admin report displays status and error messages generated by OVPI. The Configuration
and Logging Report will populate with data several hours before the reports themselves
populate with data. You can open the admin reports from the OpenView Console, from the
OVPI Report Viewer, and from your web browser. You will find the admin report for each
report pack inside the Admin folder.

Opening Forms
Forms allow you to modify defaults. The only way to access forms is through the General
Tasks section of the Management Console. Follow these steps to locate General Tasks:
1 Ifnecessary, relocate to the machine that is running the OVPI client applications.
2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Management Console
3 The Management Console opens. The System pane is on the left.
4 Click the Objects icon.
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5 The Object Manager application opens.
6 Find the General Tasks section, lower right side of screen. The admin forms are listed here.

7  Click the form to open to open it.

Ways to Customize Reports

You can customize the contents of a report by applying group filters, by apply constraints (also
known as editing parameters), and by changing how tables and graphs display. While group
filters are used by service providers to create customer-specific reports, anyone can apply
constraints to a report and anybody can make use of table and graph view options. For details
about view options for tables and graphs, see Appendix C, View Options.

Group Filters

Overview

If you plan to share reports with your customers, you must follow these steps to configure
OVPI to produce customer-specific reports:

e Import custom property information (customer names, device locations, or both) using
Common Property Tables

¢ Create a group account for all of the users affiliated with a particular customer
e Create a group filter for the group account

For a fuller explanation of group filters, see the Performance Insight Administration Guide.

Editing Parameters

Editing a parameter applies a constraint. The constraint eliminates data you are not
interested in seeing. For example, if you edit the Service parameter, data for every service
except the service you typed in the Service field drops from the report. If you are looking at
reports in the SLM Report Pack, you may apply the following case-sensitive constraints:

e Service

e Service Manager
e Paying Entity

e SLA

e C(CI

If you are looking at reports in the Help Desk or Change Management report packs, you may
apply the following constraints:

e Start date
e End date

If you are viewing reports on the web, edit parameters by clicking the Edit Parameters icon at the
bottom right-hand corner of the report. When the Edit Parameters window opens, enter the
constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values. When the Modify Parameter Values
window opens, click the Current Value field. Type a new value and click OK.

3



Sources for Additional Information

Service Desk is described in the following documents:

e HP OpenView Service Desk 5.1 Release Notes

e  HP OpenView Service Desk 5.1 Installation Guide

e  HP OpenView Service Desk 5.1 Administrator’s Guide

e  HP OpenView Metric Adapter Developer Guide

e  HP OpenView Service Desk Differences Guide (4.5 - 5.0)

e  HP OpenView Service Level Manager Guide

e  HP OpenView Web API Programmers Guide

The following user guides and release notes are related to the Service Desk reporting solution:
e Service Desk HelpDesk45 Datapipe Release Notes

e Service Desk ChangeManagement45 Datapipe Release Notes

e Service Desk Change Management Report Pack 1.1 Release Notes

e Service Desk HelpDesk Report Pack 1.0 Release Notes

e Service Desk SLM Report Pack 1.0 Release Notes

e OVPI Report Packs, CD-ROM Release Notes, revised September 2006
The following user guides are related to OVPI core:

e Performance Insight Troubleshooting Guide, April 2005

e Performance Insight Guide for Building and Viewing Reports

e Performance Insight Administration Guide

e Performance Insight Installation Guide

To download manuals for any OpenView application, including manuals for OVPI and the
report packs that run on OVPI, go to this site:

http:/www.hp.com/managementsoftware/support

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for
Service Desk are listed under Service Desk. The user guides for OVPI are listed under Performance
Insight, while the user guides for report packs and datapipes are listed under Performance
Insight Reporting Solutions. Each user guide entry indicates the month and year the document
was issued. If a manual is revised and reposted, the date will change. Since we post revised
manuals from time to time, you should check the date on your PDF against the date on the
web edition, and use the web edition if it is newer.
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2 Installation in a Service Desk 4.5 Setting

This chapter covers the following topics:

e Software prerequisites

e Service Desk datapipes

e Connecting OVPI to the Service Desk database

e Installing views on Service Desk

e Installing Service Desk report packs and datapipes
¢ Changing the database server name in .pro files

e Verifying that data is being collected

¢ Incrementing the time period in .rep files (optional)

Guidelines for a Smooth Installation

Most OVPI reporting solutions have two basic ingredients, one report pack and one datapipe.
Some reporting solutions include multiple datapipes. By installing a datapipe, you configure
OVPI to create tables, collect data, and populate tables with data. Data collection is either a
matter of polling individual devices, reading a flat file created by a preprocessor, or reading a
file created by trend_export. By installing a report pack, you configure OVPI to create tables
for the report pack and process data in accordance with specific directives. The directives
instruct OVPI to calculate totals, calculate averages, and aggregate data in several ways, for
example, by customer, by location, by day, by week, and by month.

The Service Desk report packs are shipped as compressed files on a CD-ROM. The CD-ROM
contains many report packs, many datapipes, and several shared packages. When you insert
the CD in the CD-ROM drive and launch the package extraction program, the installer
extracts every package from the CD and copies the results to the Packages directory on your
system. When the extract finishes, the installer prompts you to launch Performance Insight
and start Package Manager. Before using Package Manager to install the Service Desk report
packs, be sure that you meet the software prerequisites, read the short piece below about the
Service Desk datapipes, and then execute the configuration tasks that begin on page 16.

Software Prerequisites

Be sure the following prerequisites are met before proceeding with installation:
¢ Your Service Desk server is running Service Desk 4.5 with Service Pack 14

¢  Your OVPI server is running OVPI 5.1 with Service Pack 3 or later

15
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e Your RDBMS for OVPI is Oracle 9.2.0.6
Service Desk 4.5 datapipes do not work with Sybase.

¢ Your RDBMS for Service Desk is Oracle 9.2.06 or MS SQLServer 2000 SP 3a
If you are not running the latest Service Pack for OVPI, you can download it from this site:

http:/support.openview.hp.com/cpe/ovpi/patch_ovpi.jsp

Datapipes for Service Desk Report Packs

Each Service Desk report pack requires a datapipe. The Help Desk Report Pack requires the
Help Desk Datapipe 1.0 and the Change Management Report Pack requires the Change
Management Datapipe 1.0.

When you install a Service Desk datapipe, you also install one or more views on the Service
Desk database. If you install the Change Management Datapipe, you install one view on the
Service Desk database. If you install the HelpDesk Datapipe, you install multiple views on
the Service Desk database.

Both datapipes follow the same steps to populate report pack base tables:

1 Once a day, at 4:00 a.m., the datapipe calls trend_export.

2 Trend_export creates a text file derived from a database view.

3 The datapipe calls ee_collect.

4  ee_collect moves data from the text file to a base table on the report pack side.

For more information about data flow and troubleshooting problems that may arise, see
Chapter 9, Troubleshooting the SD45 Datapipes.

Configuration Tasks Related to OVPI

Task 1:

The following configuration tasks must be performed before installing either of the Service
Desk report packs:

e Task 1: Connect OVPI to the Service Desk database
e Task 2: Perform manual steps related to the installation of views on Service Desk.

e Task 3: Change the database server name in .pro files

Connect OVPI to the Service Desk database

The Service Desk datapipes cannot collect data from Service Desk until OVPI recognizes the
Service Desk system as a supported database. Follow these steps to add the Service Desk
system to OVPTI’s list of supported databases:

1 If you do not know which port the Service Desk database is using, find out. The default
port for Oracle is port 1521. The default port for MS SQL Server is 1433. If the default
port is not the port being used, then look for the ORACLE or the MS SQL Server port
number in the following directory:

Windows: c: \Windows\system32\driver\etc\services

Unix: /etc/services
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2 On the OVPI Server, launch the Management Console by selecting Start > Programs > HP
OpenView Performance Insight > Management Console.

Click the Systems icon (left side of the Management Console).

Click “+” to expand the information under the OVPI system.

Right-click Databases and select Add Database. The Add Database Wizard opens.
Click Next.

Select Generic Supported Database.
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Click Next. The Database Connection Information window opens.

.. add Database Wizard ) X

Database Connection Information ﬁ @
Eriter the databasze connection information F

invent

HostMame or IP
Address of the
Hosthame ovpint 1B ind b com = ctvice Desk 4.5

. Part 1521
Uzer Mame with TCPRI P Port

access to Service
furnby
Desk 4 .5 Database. Description Service Desk 4.5 e
Thiz uzer should Dezcrigtion. Aswoid
have the Wendor Oracle LI paces and
althentication to Murmber
Create viewws over ;
Datahk =t 16
the tables of SD4.5 Fhase MEtance @\ ?ataghﬁ? vi;.ndilcr
Databaze. - Or =ervice Des
Databaze Uzername I |zervicedesk
Instance for the
Fazsweard for the Pazzwiord @ s

Databasze user.

= Back | Mext = Cancel

9 Add the following information:
Hostname — The hostname, or the IP address, of the Service Desk server.
Port — The TCP/IP port number.

Description — Use ServiceDesk. Do not use spaces and numbers. You will use the
description later, during the install sequence.

Vendor — Select the database vendor for Service Desk.
Database Instance — Specify the instance for the database.

Database Username — Username, with sufficient privileges to access the Service Desk
database and create views of the Service Desk database.

Password — Database password.
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10 Click Next. The Identify System window opens.

Add Database Wizard

X
Identify System 6 2
Eriter the idertifying natme and description for thiz system. The default values have been F

ohtained from the server.
invyent

Idertifving name of the Zervice
Ma Desk. This name will be
SrwDzkds ——  reflected as the external

reference database.

Description

ervice Desk 4.5

ive the Descrigtion here. t's
optional

N Type a system name. The name should be unique. Do not use spaces or numbers in the
name. Adding a description is optional.

12 Click Next. The Summary window opens.
13 Click Finish.

14 In the navigational window under System Information, click External Reference Databases.

HP Open¥iew, Performance Insight Management Console

File Edit “iew Tools ‘Wincow  Help
B

Systerm SystemiMetwork Administration

J System Information
e
# Wieh Application Server Pro|
J Databaszes
__| OWPI Databases Database Yendar IDran:Ie
= _j External Reference Dats
OvIS]

Database Instance Il:uvpinﬂ =3

Connection Pool zize |1 ]
Thiz name iz pazsed with -= S full ted to the datab E
option for trend_expart in uccessfully connected to the database.

SrvDsk_Hipd_Retrieve_Data.pro JDBC © p.carm:
and @ Conneckion Successkul!
SrvDzk_Chm_Retrieve Data pro

files:. QDBEC) 16 POR

Press this botton to test for n//( Test Connection

sucessful database connectio
after adding Zervice Desk az
external databasze.
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15 Select Service Desk and click the Test Connection button. You should receive a Connection
Successful message.

Task 2:  Prerequisites steps for automatic installation of views on Service Desk

OVPI collects data from Service Desk by initiating SQL queries against the table structures
stored in the Service Desk database. The queries sent by OVPI access attributes spread across
many tables. To make accessing these attributes easier and faster, four “integration views”
were created, three for the Help Desk side of Service Desk, and one for the Change
Management side of Service Desk. The Help Desk views are:

e ITSM_INCIDENTS_V

e ITSM_PROBLEMS_V

e ITSM_SERVICECALLS_V
The Change Management view is:
e ITSM_CHANGES_V

All four views are installed automatically. Although view installation is automatic, the
following manual steps must be performed before you install the datapipes:

1 Create a file named Serverfile.txt and copy the file to {DPIPE HOME}\data.

2 Add the name of the system (the same name you used when you configured the external
database connection) and, on the next line, the database-type name to the Serverfile.txt
file. Put ORACLE or SQLSERVER all in upper case. For example:

SD45_systeml
ORACLE

3 Ifyou want to collect data from multiple Service Desk installations, add each additional
system name and each additional database-type name to the Serverfile.txt file. Do not
insert any blank lines. For example:

SD45_systeml
ORACLE
SD45_system2
SQLSERVER

Installing Report Packs and Datapipes

Follow these steps to install Service Desk report packs and datapipes:

e Task 1: Extract packages

e Task 2: Using Package Manager, install packages

If someone has already extracted packages from the report pack CD, go directly to Task 2.

Task 1:  Extract packages from the report packs CD-ROM
1 Login to the system. On Unix systems, log in as root.
2  Stop OVPI Timer and wait for processes to terminate.
Windows: Select Settings > Control Panel > Administrative Tools > Services

Unix: As root, do one of the following:
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Task 2:

HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD in the CD-ROM drive and follow the instructions for extracting
packages from the CD to the Packages directory on your system.

Windows:

e Ifauto run is disabled, run the setup.bat command; the Main Menu opens.
e Ifauto run is enabled, the Main Menu opens.

Unix:

e Login as root.

e Ifthe CD does not mount automatically, mount the CD manually.

e Navigate to the top level of the CD directory.

¢ Run the ./setup command.

e The Main Menu opens.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

Using Package Manager, install the Service Desk report packs

1

Select Start > HP OpenView Performance Insight > Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.
Click Install. Approve the default destination directory or browse to the correct directory.

Click Next. The Report Deployment window opens. Accept the default to deploy reports;
accept the default for application server name and port; type the username and password
for the OVPI Application Server.

Click Next. The Package Selection window opens. Click the check boxes for the packages
you want to install. If you want to install both report packs, click the boxes for:

a SrvDsk_ChangeManagement

b  SrvDsk_ChangeManagement_Demo (optional)

¢ SrvDsk_ChangeManagement45_DP

d SrvDsk_HelpDesk

e SrvDsk_HelpDesk_Demo (optional)

t  SrvDsk_HelpDesk45_DP

Click Next. The Type Discovery window opens. Disable the default.
Click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package installation complete message appears.

Click Done.
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10 Restart OVPI Timer
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On Unix, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Change the Database Server Name in .pro Files

Change the database server name .pro files to the name you used when you connected OVPI
to the external database. Follow these steps:

1 Open this file:

{DPIPE_HOME}/packages/SD45 DATAPIPE/SrvDsk ChangeManagement45 DP.ap/
SrvDsk Chm Retrieve Data.pro

File Edit Miew Insert Format Help

Dl|d| SR sl =@ B

EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE
g

# Version B (#) SrvDsk Retrieve Data.pro

# Solutions Engineering Group

# Copyright 2005, Hewlett Packard.

# Package: ServiceDesk Reporting

#

R EEEE R E RS R E RS o b e o o o e oo d 100 1o 800008 4 44

# -5 = Specifies the server Change thiz name to the name that you have
# -z = No headers added as the external databasze for Service
o e DR R R e Desk during database configuration

# -r = Specifies the report file
# -o = Specifiez the output file

hegin: Changes wait

# The Customer needs to change the database server name for the -3 option accordir
{DPIPE HOME!/hin/trend export —Sa no -f tab -r {DFPIPE HOME}/lih/ITS3t
# Finally upload the collected Chandges
{DPIPE HOME!/hin/ee collect -a RIERVD CHANGES DATAPIPE.teel -mw "-X"

2 Replace each occurrence of server name following the —S option with the server name you
created.
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3 Open this file:

{DPIPE HOME}/packages/SD45 DATAPIPE/SrvDsk HelpDesk45 DP.ap/
SrvDsk Hlpd Retrieve Data.pro

File Edit “iew Insert Format Help

DR Sl sl o|=(m| &

begin: incidents wait

# The Customer needs to chahge the database server name for the -3 option accordi:
{DPIPE HOME!/hin/trend export -3 8ervicedesKra no -f tab -r {DPIPE HOME}:/lih/IT3!
# Finally upload the collected Incite
{DPIPE HOME!/hin/ee collect -a RIERVD INCIDENTS

ATAPIPE.teel -mw "-XE"

Change theze names to name that you have
Fadded as external database for Service Desl
during database configuration

end:
begin: problems wait

# The Customer needs to chahge the database 3erxer
{DPIPE HOME!/hin/trend export -3¢ Servicedesk
# Finally upload the collected Probhlems
{DPIPE HOME!/hins/ee collect -a R3IERVD PROELEMZ DATAPIPE.teel -mw "-X"

Hatme for the -3 option accordi:
f tab -r {DPIPE HOME}/lih/IT3!?

end:
begin: servicecalls

# The Customer needs to chahnge the datsbhase 3e
{DPIPE_HOME}/bin/trend export -3
# Finally upload the collected Jervicer
{DPIPE HOME!/hins/ee collect -a R3IERVD SERVICECALLS DATAPIPE.teel -mw "-X"

1 |

wer name for the -3 option accordi:
#a no -f tab -r {DPIPE HOME}/ lih/IT3!

For Help, press F1

4  Replace each occurrence of the —S database server name with the name you created.

5 Optional. If you intend to collect data from more than one Service Desk 4.5 installation,
perform these additional steps:

a Open this file: SrvDsk Hlpd Retrieve Data.pro

b  Replicate the incidents, problems, and service calls sections.

¢ Replace each occurrence of the -S database server name with the name you created.
d Open this file: SrvDsk Chm Retrieve Data.pro

e Replicate the changes section.

f  Replace each occurrence of the -S database server name with the name you created.
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The window below shows entries replicated in SrvDsk Chm Retrieve Data.pro.

_Chm_Retrieve_Data - WordPad
Wiew Insert Format Help

a| sl al o [=@|o] B

= Specifies the serwver

= Mo headers

= Delimiter to use

= Specifies the report file
= Specifies the output file

Changesl wait

Customer needs to change the database serwver name for the -2 option according to
O,

E_HOME} /bin/trend export -8

E HCOME}/ likh/ITSM CHANGES.rep -o {OFIFE HOME}/tmp
ally upload the collected Changes

E HCOME} /binfee collect -a RSERVD CHANGES DATAPIPE.teel -mw "-E"

Faw.tLxt

=0 4.5 installations
Changes2 wait

Customer needs to change the database serwver n
O,
E HOME!/bin/trend export -3 a2 no -f tak -r

E HOME}/ lih/IT3M CHANGEZ.rep -o {DFIFE HOME}/tmp/Changes Raw.Lxt
ally upload the collected Changes

E HCOME} /binfee collect -a RSERVD CHANGES DATAPIPE.teel -mw "-E"

for the -2 option according to

Veritying Data Collection

If the datapipes you installed are working properly, the following tables on the report pack
side will be populated:

e RSERVD_PROBLEMS_DATAPIPE

e RSERVD_INCIDENTS_DATAPIPE

e RSERVD_SERVICECALLS_DATAPIPE
e RSERVD_CHANGES_DATAPIPE

If these tables were populated with data, you can query OVPI to see how many rows of dat
were collected for each table. Follow these steps:

1 Login to OVPI database.

2 Run the following queries at the sql prompt:
e select count(*) from RSERVD_INCIDENTS_DATAPIPE;
e select count(*) from RSERVD_PROBLEMS_DATAPIPE;

Installation in a Service Desk 4.5 Sefting
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e select count(*) from RSERVD_SERVICECALLS_DATAPIPE;
e select count(*) from RSERVD_CHANGES_DATAPIPE;

For each query, the system displays the number of rows collected. If the system indicates that
no data was collected, follow the advice in Chapter 9, Troubleshooting the SD45 Datapipes.

Changing the Time Period in .rep Files

If you want to import more data at a time, more data than the default (3 days) permits, you
can do that by incrementing the Time Period in the following .rep files:

e ITSM_INCIDENTS.rep
e ITSM_PROBLEMS.rep

e ITSM_SERVICECALLS.rep

e ITSM_CHANGES.rep

All .rep files are located in the following directory:

{DPIPE_HOME}/1lib/

The time period in a .rep file must not be greater than the retention period of the
corresponding base table. This rule applies to the base tables listed below.

.rep File

Base Table

ITSM_INCIDENTS.rep

RSERVD_INCIDENTS

ITSM_PROBLEMS.rep

RSERVD_PROBLEMS

ITSM_SERVICECALLS.rep

RSERVD_SERVICECALLS

ITSM_CHANGES.rep

RSERVD_CHANGES

If the time period in the .rep file is greater than the retention period of the corresponding base
table, data mapping errors will result. Follow these steps to increment the Time Period in
each of the .rep files listed above:

1 Using Report Builder, open the .rep file.

Click Time Period

u A 0N

Change the value.

Navigate as follows: Elements > ITSM_table name > Data > Query

In the Property-Value table, locate the Length field.

) The value you enter can be more than 10 only if the retention period for the
corresponding base table is more than 10.
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EHP Open¥iew, Performance Insight, Report Builder 5.1 [trendadmi@oypintb.india.hp.com:oypintb.india.hp.com] - C24

File
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AP H@E Xt 2 BODE
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3 Installation in a Service Desk 5.0/5.1 Setting

This chapter covers the following topics:

e Software prerequisites

¢ Installing DimensionManager and DataFeeder on OVPI

e Using Package Manager to install the Service Desk report packs
¢ Configuring a destination for exported data

e Enabling the Reporting Administration workspace

e Exporting Help Desk module data to OVPI

e Exporting Change Manager module data to OVPI

e Exporting SLM dimension data to OVPI

¢ Changing defaults related to data aging (SLM Report Pack only)
¢ Changing defaults related to logging level

Guidelines for a Smooth Installation

Most OVPI reporting solution have at least two basic ingredients, a report pack and a
datapipe. While the datapipe creates tables, collects data, and populates base tables
maintained by the report pack, the report pack contains instructions for OVPI that specify
how to process data, what to calculate, and how to aggregate the results. The reporting
solutions for Service Desk 5.0 and 5.1 are different. There are no datapipes. Datapipes are not
needed because Service Desk 5.0 and 5.1 are designed to export data to OVPI.

The Service Desk report packs reside on the report pack CD-ROM. The report pack CD-ROM
contains many report packs, many datapipes, and several shared packages. Every package is
compressed. After you insert the CD in the CD-ROM drive and launch the package extraction
program, a script extracts each package from the CD and copies the results to the Packages
directory on your system. When the extract finishes, you will be prompted to launch
Performance Insight and start Package Manager.

Before using Package Manager to install Report Packs, you must verify that the software
prerequisites are met. Once you have verified that, install DimensionManager and
DataFeeder on OVPI, install the report packs, and then configure full and incremental data
exports to OVPL. Once the data exports have run, you can verify that data is reaching OVPI
by checking the Configuration and Logging Report for each report pack that you installed. If
data is reaching OVPI, the Configuration and Logging Report will include status messages
related to hourly processing.

27



Software Prerequisites

Be sure the following prerequisites are met before proceeding with installation:

Your Service Desk Management Server is running Service Desk 5.0 with the latest
Service Pack, or Service Desk 5.1

Your RDBMS for Service Desk is Oracle 9.2.0.6 or MS SQLServer 2000 SP 3a
Your OVPI server is running OVPI 5.1 with Service Pack 3 or later
Your RDBMS for OVPI is Oracle 9.2.0.6

If you are not running the latest Service Pack for OVPI, you can download it from this site:

http:/support.openview.hp.com/cpe/ovpi/patch_ovpi.jsp

Installing DimensionManager and DataFeeder on OVPI

If you install the SLM Report Pack, then you must install DimensionManager and
DataFeeder on the OVPI server. DimensionManager receives dimension data (property data)
from the Service Desk server, while DataFeeder receives fact data from the Service Desk
server. The export of dimension data is a manual step, which you will take when the SLM
model is modified. The export of fact data takes place automatically. No user intervention is
necessary.

Follow these steps to install DimensionManager and DataFeeder on OVPI:

1

4
5
6

Check that the port defined in the slmreporting.ini file on the Service Desk machine
matches the port defined in the slmreporting.ini and slmreportingservers.ini
files on the OVPI server. The port value is usually 1085. If you change this value, you
must execute the ovconfchg registration tool again.

Relocate to your OVPI server and insert the Service Desk installation DVD in a drive on
the OVPI server; navigate to the reporting directory.

or

From the installation DVD, copy the reporting folder and the packages folder to a
directory on the OVPI server; navigate to the reporting directory.

Do one of the following:

Windows

In the reporting directory, click this file: reporting 5.XX.XXX setup.exe
Unix

Type reporting 5.XX.XXX setup.bin from the command line.

When the HP OpenView installer GUI opens, select Accept License Agreement.
Click Next and continue clicking Next until you see a list of java components.

Click Install.

DimensionManager and DataFeeder are now installed on OVPI.
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Installing the Service Desk Report Packs

You may install one report pack, two report packs, or all three report packs. There are no
interdependencies between report packs, that is, no report pack is a prerequisite for the other
report packs.

Perform the following tasks to install the Service Desk report packs:

e Task 1: Extract packages from the report pack CD-ROM.

e Task 2: Start Package Manager and install the report packs

If the package extraction step has already taken place, go directly to Task 2.

Task 1:  Extract packages from the report pack CD

1 Log in to the system. On Unix systems, log in as root.
2 Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b  Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On Unizx, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive and follow the instructions in the menu
for extracting packages from the CD to the Packages directory on your system.

Windows:

e Ifauto run is disabled, run the setup.bat command; the Main Menu opens.
e Ifauto run is enabled, the Main Menu opens.

Unix:

e Log in as root and mount the CD (if the CD does not mount automatically).

e Navigate to the top level of the CD directory.

e Run the ./setup command.

e The Main Menu opens.

4  Type 1in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

Task 2:  Using Package Manager, install the Service Desk report packs
1 Select Start > HP OpenView Performance Insight > Package Manager.
2 The Package Manager Welcome Window opens. Click Next.

3 The Package Location window opens. Click Install. Approve the default destination
directory, or browse to the correct directory.
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10

Click Next. The Report Deployment window opens. Accept the default to Deploy Reports;
accept the default for application server name and port; type the username and password
for the OVPI Application Server.

Click Next. The Package Selection window opens. Click the check boxes for the packages
you want to install. If you want to install all three report packs, click the check boxes for:

a SrvDsk_ChangeManagement

b  SrvDsk_ChangeManagement_Demo (optional)

¢ SrvDsk_HelpDesk

d SrvDsk_HelpDesk_Demo (optional)

e SLM_Integration

t  SLM_Integration_Demo (optional)

Click Next. The Type Discovery window opens. Disable the default.
Click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package installation complete message appears.

Click Done.
Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On Unix, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Post-Installation Steps

Some post-installation steps are generic, applying to any Service Desk report packs, while
some post-install steps are specific to one report pack. If you installed all three report packs,
perform all of the following steps:

Create a report connection object

Give Service Desk the address of the DataFeeder server (OVPI)

Set up the Reporting Administration workspace

Set up full and incremental data exports to OVPI

Export Dimension data to DimensionManager on OVPI (SLM Report Pack only)
Use the OVPI Report form to configure user access to OVPI reports

If desired, modify the defaults in SLM admin forms
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Give Service Desk a Destination for Exported Data

To configure the Service Desk client, perform these tasks:

e Task 1: Create a Report Connection Object that specifies OVPI server parameters.

e Task 2: Add the address of the DataFeeder server to the SLM Administration object.
e Task 3: Enable the Reporting Administration workspace.

Task 1:  Create a Report Connection Object

You cannot export entities until you create an OVPI Report Connection object in Service Desk.
Service Desk reads the OVPI Report Connection object to determine a destination for
exported data.

Follow these steps to create an OVPI Report Connection:
1 Start the OpenView Console.

2 Right-click in the OV Configuration workspace group and select Add Workspace from the
pop-up menu. The Add Workspace window opens.

Add Workspace i x|
¥ Ohject

" URL Workspace

=

= OVPI Report

Report Connection

3 Select the Object button, then scroll down the list of workspaces and select the OVPI Report
Connection workspace.

4 Click OK. OVPI Report Connection appears as a new workspace under OV Configuration.

5 Right-click the OVPI Report Connection workspace and select New OVPI Report Connection
from the pop-up menu.

31::, Mew OYPIReport Connection
Edit

gl Lipdate Al

% Delete
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The OVPI Report Connection form opens.

*" New - O¥PI Report Connection 2 E@

File Edit “iew Action Toolz Help

32

[ = viEB 20 BhD +3
Hostrare % | | | Parameters
Username # | trendadm | Wieh Server Port |8El X
Passward % | [P | Detault Report Path
faysten/
Canfirm Passwiard | EEEEEEEE |
Fole Mapping
Perzon Role; Text O%PI Role; Text
Custotner Business Manager Custotner Business Manager
Customer Relstionship Manacer Customer Relationship Manager
Service Manager Service Manager
Service Administratar Service Administrator

6 Add entries in the Hostname, Username, Password, and Web Server Port fields.

) You must have administrative privileges to make these changes; the default
username for a user with administrative privileges is trendadm.

) The Web Server Port must be the same as the OVPI web server port.

7 Do not change the values under Role Mapping.
8 Save and close the OVPI Report Connection form.
9 Load the updated parameters by restarting the Object Server.

Once the OVPI Report Connection is established, Service Desk has a destination for exported
data. If you installed the SLM Report Pack, perform the next task below, Task 2. This step will
give Service Desk an address for DimensionManager and DataFeeder. If you did not install
the SLM Report Pack, skip the next task and go directly to Task 3.
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Task 2:  Add the address of the DataFeeder server to the SLM Administration object.

1 In the SLM Administrators group, select the SLM Administration workspace object. The
SLM Administration form opens.

min SLM Admin - SLM - SLM Administration

File Ecit “iew Action Tools Help

: ~n LB
B B &l B H o0 LD+ e
i i i Reporting Data Feeder | |j i
SLM Mame | SLI Adin | Metric Adapters | Data Collectar | Calculation Endgine | P o | Life Cycle Status Mapping
SLM Hostname | cuthbert.emea hpogcorg . net | RDF Hosthame |
Wax SnF Files Tata.. |0
Server Heartheat . |EU E | P =t Flies fota |
Server Status () Avaisbie | Reload Period (in d...| 1

Reload Time | September 15, 2004 1:00:00 Pw

Last Reload Date |

|:| Force Reload

Meeds Reload

If the SLM Administration object is not visible, right-click a group, select Add Workspace,
and then select SLM Administration.

2  Click the Reporting Data Feeder tab in the SLM Administration form.
3 In the RDF Hostname field, enter the fully-qualified hostname of the OVPI server.

Task 3:  Enable the “Reporting Administration” workspace.

If the Reporting Administration workspace is not visible, you must add it to the OV
Configuration group. Follow these steps:

1 Right-click in the OV Configuration group and select Add Workspace from the pop-up
menu. The Add Workspace window opens.

2 Select the Object button, select Reporting Administration, and click OK.

The Reporting Administration workspace appears under the OV Configuration group. Details
about data export, for each report pack you installed, are visible from this view.

[P OpenviewConsole -l
File Edi “iew Action Tools Help
S Mew v | £5 | = | 25 Uy W | ) Advanced Find... »
tl. OYPIReport Connection & Reporting Administration
=4 0Pl Report | || Moskie Mame [ Expo] Ena. | stert] Expo| Last] Last] Last] Last]
=4 Reporting Administration HelpDesk owpl [T Mare. 1 June . @ c. @
> Service Desk | Changetanagement OwPl [ Marc. 1 dune @ E2 @
| & service Today ;l
I 2 Reporting Administration(s) I =" =
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Check the Status of Reporting Daemons

Two reporting daemons, ovsdreport and ovsdslm, were installed by default when you installed
Management Server software on the Service Desk server. To verify that the reporting
daemons are running, use the ovc -status command. This command displays the status of
the following Management Server components:

¢ Control

e Login server

e Object server

e SLM OVSD Metric Adapter

e C(Certificate server

e Apache WebServer Service

¢ Communication Broker

e Service Desk Reporting

e Service Level Management

¢ Tomcat Servlet Container Service

If the reporting daemons are not running, start them by typing the ovc -start command
from the command prompt:

ovc -start ovsdreport

If the Management Server is installed on multiple servers, you must unregister the reporting
daemons on any server that you do not want to export data to OVPI. Follow these steps to
unregister the reporting daemons on servers that are not exporting data to OVPI:

Windows:
C:\Program Files\HP OpenView\lbin\report\unregisterSDReporting.bat
Unix:

/opt/OV/1bin/report/unregisterSDReporting.sh

Export Help Desk Data to OVPI

The first export of Help Desk data initializes the OVPI database with all current Help Desk
data. The second export is an incremental export that updates the OVPI database. If an
incremental export fails, you can perform a full export to repopulate the OVPI database with
all current Helpdesk module data. The full export can take several minutes, depending on the
amount of data being exported.

Follow these steps to perform a full export of Help Desk data:

1 Login to the Service Desk server and start the OpenView Console.

2 In the OV Configuration group, select the Reporting Administration workspace.
3 Right-click the HelpDesk module and select Full Export from the pop-up menu.

You can monitor the status of the export in the Reporting Administration view. The export will
take several minutes. While the export is in progress, the status is In Progress. When the
export completes, the status changes to Completed.
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Exporting Data by Running a Script

You have the option of exporting data by running the OvObsReportAdmin script.
Windows
C:\Program Files\HP OpenView\bin\OvObsReportAdmin.bat-moduleName=HelpDesk
Unix

/opt/0OV/bin/OvObsReportAdmin.sh-moduleName=HelpDesk

Set Up an Incremental Export of Help Desk Data

An incremental export exports changes to Help Desk module data (service calls, problems,
and incidents) that occurred since the previous export. Only one incremental export can run
at one time. If two incremental exports are scheduled to run at the same time, they will run
sequentially.

Follow these steps to set up incremental exports of the Help Desk module:
1 In the OV Configuration group, select the Reporting Administration workspace.

2 Right-click the HelpDesk module and select Edit from the pop-up menu. The Reporting
Administration dialog box opens.

3 Copy the value that appears in the Last Successful Full Export field to the Start Date field.
This is the time from which scheduling of incremental exports begins.

4 In the Export Period field, enter a value for the number of hours between incremental
exports. The value you enter cannot be less than 1.

5 Check the Enable/Disable box.

Once the incremental export is enabled, you cannot run a full export. However, you can
easily disable the incremental export by clearing this check box. Running a full export
manually may be necessary if an error occurs during an incremental export and you want
to repopulate the OVPI database.

6 Click File > Save & Close.

The incremental export process schedules the next export for the specified period. After the
export runs, the Incremental Export Results tab shows details about the incremental export.

Export Change Manager Data to OVPI

The first export of Change Manager data initializes the OVPI database with all current
Change Manager data. The second export is an incremental export that updates the OVPI
database. If an incremental export fails, you can perform a full export to repopulate the OVPI
database with all current Change Manager module data. The full export can take several
minutes, depending on the amount of data being exported.

Follow these steps to perform a full export of Change Manager data:

1 Login to the Service Desk server and start OpenView Console.

2 In the OV Configuration group, select the Reporting Administration workspace.

3 Right-click the Change Manager module and select Full Export from the pop-up menu.

You can monitor the status of the export in the Reporting Administration view. The export will
take several minutes. While the export is in progress, the status is In Progress. When the
export completes, the status changes to Completed.
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Exporting Data by Running a Script

You have the option of exporting data by running the OvObsReportAdmin script.

Windows

C:\Program Files\HP OpenView\bin\OvObsReportAdmin.bat-moduleName=ChangeManagement

Unix

/opt/0OV/bin/OvObsReportAdmin.sh-moduleName=ChangeManagement

Set Up an Incremental Export of Change Manager Data to OVPI

An incremental export exports changes to the Change Manager module data that occurred
since the previous export. Only one incremental export can run at one time. If two
incremental exports are scheduled to run at the same time, they will run sequentially.

Follow these steps to set up incremental exports of the Change Manager module:
1 In the OV Configuration group, select the Reporting Administration workspace.

2 Right-click the Change Manager module and select Edit from the pop-up menu. The
Reporting Administration dialog box opens.

3 Copy the value that appears in the Last Successful Full Export field to the Start Date field.
This is the time from which scheduling of incremental exports begins.

4 In the Export Period field, enter a value for the number of hours between incremental
exports. The value you enter cannot be less than 1.

5 Enable incremental export by checking the Enable/Disable box.

Once the incremental export is enabled, you cannot run a full export. However, you can
easily disable the incremental export by clearing this check box. Running a full export
manually may be necessary if an error occurs during an incremental export and you want
to repopulate the OVPI database.

6 Click File > Save & Close.

The incremental export process schedules the next export for the specified period. After
the export runs, the Incremental Export Results tab shows details about the incremental
export.

Export Dimension Data to OVPI

Task 1:

If you installed the SLM Report Pack, perform the following tasks:
e Task 1: Verify that the BBC Communication Broker is running.
e Task 2: When necessary, export dimension data to Dimension Manager on OVPI

e Task 3: Check the Configuration and Logging Report

Verify that the OpenView Communication Broker is running

Service Level Manager communications are under the control of the OpenView BBC
Communication Broker. The Communication Broker must be running for SLM to operate
correctly. To display a list of services that are running, type the following command from the
command line:

ovc -status
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If the OV Communication Broker is not running, start it by typing the start command:
ovc -start ovbbccb
To start the SLM server, type this command:

ovc -start ovsdslm

Task 2:  Export Dimension data to DimensionManager on OVPI

Follow these steps to export the service model to the OVPI dimension tables:

1 Run the following batch file:
$OvInstallDir/bin/ReportingConfigTool.bat
DimensionManager generates .csv files and stores them in the following directory:
{DPIPE HOME}\data\ImportData\SLM\Dims

Every 5 minutes trend_timer calls a script; the script scans the Dims directory and
imports data into OVPI property tables.

2 To verify that the import was successful, look for .csv files in this directory:
$SDPIPE HOME/packages/SLM Integration/SLM Integration.ap/csv/dims

The files will be imported in about 5 minutes, so five minutes after the import starts,
the.csv files will disappear from the dims directory.

If you encounter a problem, see Chapter 11, Troubleshooting Dimension and Fact Data.

) The export of fact data to OVPI is automatic, no user intervention is necessary. Each time the
SLM core receives a metric value from a metric adapter, or each time there is a change in
status for the facts managed by SLM, Service Desk sends fact data (including data pertaining
to service hours, planned downtimes, and SLA evaluation periods) to DataFeeder on OVPI.

Modify the Defaults for Data Aging (SLM Report Pack Only)

Use the following forms to customize SLM report pack parameters:

e Evaluation Period Data Aging

¢ Time Shift Data Aging

Follow these steps to open the SLM administration forms:

1 Select Start > Programs > HP OpenView Performance Insight > Management Console
2 In the Systems pane, upper left portion of the screen, click Objects.

3 The administration forms are listed under General Tasks. Click to open.
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Evaluation Period Data Aging

Specify the number of days information about a particular evaluation period is kept. The
default is 365 days.

[%| /admin/SLM_Reporting_Forms/SLM_EvalPeriodAging.frep™

X

walue using the drop down then olick'DF or pply to
SLM use this level. Click 'Cancel to leave the lag level
unchanged. invent

Evaluation Period Aging

i= = IEI
- Thiz ferm allows you to change the number of days SLA
Service Desk ittt hiobie sl iy (ﬁf]

Current aging (days): 385

Mew Aging level (days): |369]

Time Shift Data Aging

Specify the number of days time shift information is kept. The default is 90 days.

[ /admin/SLM_Reporting_Forms/SLM_TimeShiftagingfrep

=

o II:I
= This form allovs you to change the number of days
Service Desk Saacion ok s Sl Plane £ Bl Bhcods o ba
kept in db. Select a newvalue using the drop down

SLM then olick "0k or'Apply to use this lewel. Click
'Cancel ta lesve the log level unchanged. invent

Service Hours and Cl Planned Downtime Aging

Current aging (days): 50

Mew Aging level (days): Ign

Modify the Defaults for Logging Level

Each report pack provides a Logging Level form. Use the form to indicate the level of detail
you want to see in log messages. Your options are:

e Errors

e  Warnings

e Debug and Dev

Follow these steps to locate the Logging Level form:

1 Select Start > Programs > HP OpenView Performance Insight > Management Console

2 In the Systems pane, upper left portion of the screen, click Objects.
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3 The logging level form is listed under General Tasks. Click to open..

1% /admin/SLM_Reporting_Forms/SLM_LoggingLevelfrep E =]
SEI’ViCE Desk Thiz form allons you to change the level of detail used é
in log messages for the various SLM processes. Selact ﬁ
a naw lewsl using the drep down han olick' 01 or
SLM "pphy to use this lovel. Clisk 'Canssl fs leave thaleg | 0o o0y
level unchanged.
Logging level
Current logging level: Errors, Warnings, Debug and Dev
New logging level:
=38 I Apply [ Cancel |
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4 Help Desk: Service Calls

Administration

¢ Configuration and Logging Report

Service Calls

e Average Duration of Service Calls

e Service Calls by Category

e Service Calls by Classification

e Service Calls Closed before Deadline by Category
e Service Calls Closed by Deadline

¢ Service Calls Closed on First Call

¢ Service Call Details

e Service Calls by Closure Code

¢ Incoming Service Calls (History)

¢ Incoming Service Calls (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B,
Scheduling Reports.

Ul and DB Rules for Closure Code

If you are familiar with Service Desk, you know that a closure code is assigned to a call when
the call is closed. When a closure code is assigned, Service Desk automatically assigns a date
and time to the closure code. The date and time assigned to the closure code is known as
Actual Finish. There is a Ul rule in Service Desk 4.5 that states that Actual Finish is the
same as System Date. The Ul rule reads as follows:

Actual Finish to system date when [status is] CLOSED

Service Desk 5.0/5.0 replaces the Ul rule with a database rule. The impact of the database
rule in Service Desk 5.0/5.1 is the same as the Ul rule in Service Desk 4.5. If you upgraded
from Service Desk 4.5 to Service Desk 5.0/5.1, the database rule is making the necessary
association between Actual Finish and System Date, so there is no need to recreate the Ul
rule.
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Configuration and Logging

This report displays configuration information relating to data import for the Help Desk
Report Pack. This report provides a list of the most recent log tarble entries for report pack
internal procedures. The report is limited to the 200 most recernt entries.

Field/Drop-Down Description

Current logging level Options (one or any combination):
e FError
e Warning
e Information

Log entry Time the log entry was created

Component to which the log entry refers
Message
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Service Desk
Help Desk
Configuration and Logging

This report displays canfiguration information relating to Semnice Desk Reporting data import, it
liztz the most recent log table entries for ReportPack internal procedures. The report iz limited to
the 200 most recent entries.

[

invent

Time
Tue Dec 07 12:30 PM
Tue Dec 07 12:30 PM
Tue Dec 07 1226 PM
Tue Dec 07 12:25 PM
Tue Dec 07 12:24 FM
Tue Dec 07 12:24 PM

Current Logging Level:
Errors, Warnings and Info

ReportPack Log Entries

{most recent first)

Component Message
SenD_Problems_map_p Info: 5242 rows inserted
SenD_Prmoblems_map_p Info: 5342 rowe in datapipe table

SenD_Senicecalls_map_p Info: 32679 roves inserbed

SenD_Senicecalls_map_p Info: 32679 rome in datapipe table
SenD_Incidents_map_p Info: G39 rowes inserted
SenD_Incidents_map_p Info: 539 rows in datapipe table
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Average Duration of Service Calls

This report shows the average duration of service calls in days per classification, category,

priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date field

The start of the evaluation period.

End Date field

The end of the evaluation period.

Total service calls table

Total number of service calls and average duration
(in days).

Classification table

Number of service calls and average duration per
classification.

Category table Number of service calls and average duration per
category.
Priority table Number of service calls and average duration per

priority code.

Tabbed area with bar charts

Average duration of service calls at weekly, monthly
or quarterly intervals (where applicable) within the
evaluation period.

Help Desk: Service Calls
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Service Desk

Help Desk

Thiz repart shows the average duration of senvicecalls in days (with a creation time between the
Start and End dates selected) per classification, categony, priority and wokigroup, Choose a day

forstart and end periods. Start Date <= Registration Time < End Date

Average Duration of Servicecalls

A

invent

Lfar Dale

Erd Dafe

II‘\."Ion Dec 08 2003 Ll

Classification
API_SYSTEM

Search task

Clazsificatie relaties

EIDH addprog

Prob. dizpatch

Mairtenance Function Keys
Create Distribution list

“iew related SC's

hain screen employes
Workorders multi rec.

Print Prak. Cl name

Open Wo's by supportgraup
Maintenance service hours Prob
Drmb Cranili ko

Friority
Unktiowt
Critical
Maone
Escalated
hdedium
Loy
Serious

Weekly | Manthty | Quarterly |

Jan 07 2004

[ar] o
[==] =1
=] =]
ol ]
[=] -+
— ]
w o
o =]
] ]

Jan 21 2004

Feh 04 2004

II‘\."Ion Dec 08 zuoaﬂ

# Servicecalls

&1
i
72
62
g9
aa
a0
73
73
93
71
63
78

a7

# Servicecails

Feb 18 2004

Mar 03 2004

4,140
4,221
4166
2120
4,116
4102
4,082

Avg
4592 =
43.30
4280
41.09
40.91
35.82
3550
3525
36.96
3327
3315
3309
32356

= 79;'

Avg
1905
19.06
17 B9
1749
17.01
16493
1605

Category
Enhancement request
Suggestion

Incident

Reqguest for Information

Qrganization
HP Openview M
HP Openview TehP
HP Openview SPls
Unktioseet
HP Operview Lk
HF Openview Performance Insight
HP Openview SIP
HP Openview Operstions

WeekKkly Average Duration of Servicecalls

Mar 17 2004

Mar 31 2004

Apr1d 2004

Apr 28 2004

May 12 2004

Jul 21 2004

Jun 09 2004
Jun 23 2004
Jul 07 2004

& May 26 2004
o

Aug 04 2004

Aug 18 2004

# Servicecalls

27,017

Sep 01 2004

Average
Duration (days)
17.64

# Servicecalls

Sep 152004

Sep 29 2004

3,958
7 B8
7576
7.785

# Servicecalis

3,522
3,60
3,550
3,662
3,580
3,618
1,819
3,656

Oct13 2004

Oct27 2004

Avg
1784
17.79
1776
17.29

Avyg
2036
1880
1832
1775
1714
1650
1621
1545

Moy 10 2004
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Service Calls by Category

This report shows the total number of service calls in the selected category with a further

breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Category table Number of service calls per category. Click the drill

icon to display information for a particular category.

Total service calls table

Total number of service calls.

Impact table Number of service calls opened per impact code in
the selected category.
Priority table Number of service calls opened per priority code in

the selected category.

Classification table

Number of service calls opened per classification
code in the selected category.

Tabbed area with bar charts

Number of service calls at weekly, monthly or
quarterly intervals (where applicable) within the
evaluation period and in the selected category.

Help Desk: Service Calls
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Service Desk This report showes the total number of servicecalls (with a creation time bebween the Start and End

dates selected) for the selected category perimpact, priority and classification. Select dates for

start and end periods. Stant Date <= Registration Time < End Date
Servicecalls by Category

[

invent

Start Date
II'\."Ion Dec 08 2003 |+ | Category # Servicecalls Opened # Servicecails Opened
Inciclent 343 1,151
End Date Request for Information 327

II‘\."IDn Dec 06 2004 v | BUEEREIER Ay
Enhancement request 164

# Servicecalls - # Servicecalls . . # Servicecalls
Impact Opened Priority Opened Classificalion Opened
Loy [ 1 person affected) a7 Critical B5  Maintenance Language 4=
Paszed on by %5 Unknown 53 Owerview SLA detail 4
High (Department affected) 53 Serious 53 API_CODES 4
Medium (Group f Unit affected) 52 Mone 52 Integration (Email, LDAP, Mansg. .. 4
Top (Site J Organization affected) 52 Medium %1 Unknown 3
Mane 45 Low 41 Search Cl 3
Unknoy 23 Escalsted 28 Open SC for caller JCHESLA 3
Search Prob. 3
Search Cltemplate 3
Mairtenance category & code 3
Mairtenance Service Hours 3
Open time of SC by category 3
Muaruicws T ko chonna i ;I

Weakly | Manthty | Quarterty |

WeeKly Total Servicecalls
for the Selected Category

Seniicecal

May 26 2004 4
Jun 08 2004 $
Jun 23 2004
Jul 07 2004
Jul 21 2004
Oct 13 2004
Oct 27 2004

o o
=] =]
=] =]
] ]
=] =+
— ]
w w
I I
] ]

Jan 0oy 2004
Jan 21 2004
Feb 04 2004
Feh 18 2004
Mar03 2004
Mar 17 2004
Mar 31 2004
Apr14 2004
Apr 28 2004
May 12 2004
Al 04 2004
Aug 18 2004
Sep 01 2004
Sep 182004
Sep 28 2004

Date

Mow10 2004

Mow 24 2004
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Service Calls by Classification

This report shows the total number of service calls with the selected classification, with a

further breakdown by category.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Service Calls table

Total number of service calls.

Classification table

Number of service calls per classification. Click the
drill icon to display information for a particular
classification.

Category table

Number of service calls per category with the
selected classification.

Tabbed area with bar charts

Number of service calls at weekly, monthly or
quarterly intervals (where applicable) within the
evaluation period and with the selected
classification.

Help Desk: Service Calls
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Service Desk
Help Desk

This report showes the total number of servicecalls (with a creation time
betueen the Start and End dates selected) for the selected classification with ﬁ
a further break down by categony. Select dates forstart and end periods.

Start Date <= Registration Time < End Date inwvent

Servicecalls by Classification
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Service Calls Closed Before Deadline by Category

This report shows the percentage of service calls closed before the deadline in the selected

category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Service Calls closed table

Total number of service calls closed

Number of service calls closed before deadline
Percentage closed before deadline

Number of service calls closed after deadline

Drill-down category table

Per category:

e Number of service calls closed

e Number of service calls closed before deadline
e Percentage closed before deadline

e Number of service calls closed after deadline

Click the drill icon to display information for a
particular category.

Closure code table

Per closure code in the selected category:

e Number of service calls closed

e Number of service calls closed before deadline
e Percentage closed before deadline

e Number of service calls closed after deadline

Tabbed area with bar charts

Number of service calls closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period and in the
selected category.

Help Desk: Service Calls
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Service Desk

Help Desk

This report shows the percentage of servicecalls closed before the deadline (with a
creation time betmween the Start and End dates selected) for the selected categony
and closure code. Select dates forstart and end periods. Start Date ==
Registration Time < End Date

Servicecalls Closed Before Deadline by Category

K3

nwvent

Start [ ate End [ ate
IMon Dec OF 2008 | IMDn Dec 08 2004 | # Servicecalls  Ciosed Before o Closed After
Closed Deadiine Deadine
27,017 9,174 33.96 17.843
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Service Calls Closed Before Deadline

This report shows the percentage of service calls closed before the deadline per classification,
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls

that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date field

The start of the evaluation period.

End Date field

The end of the evaluation period.

Service Calls closed table

Total number of service calls closed

Number of service calls closed before deadline

Percentage closed before deadline

Number of service calls closed after deadline

Classification table

Per classification:

Number of service calls closed

Number of service calls closed before deadline
Percentage closed before deadline

Number of service calls closed after deadline

Category table

Per category:

Number of service calls closed

Number of service calls closed before deadline
Percentage closed before deadline

Number of service calls closed after deadline

Priority table

Per priority code:

Number of service calls closed

Number of service calls closed before deadline
Percentage closed before deadline

Number of service calls closed after deadline

Organization table

Per organization:

Number of service calls closed

Number of service calls closed before deadline
Percentage closed before deadline

Number of service calls closed after deadline

Tabbed area with bar charts

Number of service calls closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period.
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Service Desk

Help Desk

This report shows the percentage of sewicecalls closed before the deadline (with a creation time

between the Start and End dates selected) per ¢lassification, categony, pricrity and wodgroup.
Select dates for start and end periods. Start Date <= Registration Time < End Date

Servicecalls Closed Before Deadline

[

invent

Start Date

End Date

II'\."Ion Dec 08 2003 ¥ | IMon Dec 06 2004 v | # Servicecalls  Ciosed Before - Closed After
Closed Deadine Degadiine
27,017 9,174 33.98 17,843
# Servicecalls Before After
. _ . Before After Cate . Pct .
Classification Servicecalls o * N0 pet o oo By Closed Deadiine Deadiine
Closed Enhancement reguest 3,955 1,372 23474 2,583
Databasze (table, index, key,... o5 47 4947 45 = Request for Information 7. 7es 2683 3446 5,102
Beta Product g9 32 4638 37 Suggestion 7 EOS 26805 3354 5,093
Cl Infarrmation 93 43 4624 50 Inziclett 7576 2511 3314 5,065
Maintenance progress monit... TG 39 4605 41
Cverviewy Service detail g3 38 4345 45
Overviewy SLA & service & . 94 42 4465 52
Overviewy SC breakdown 74 33 44358 41
Print change code 83 37 4458 45
Scanned Cl's per location fts] 39 44352 49
Priority-Target Set. Helpdesk 54 37 4405 47
Linking Praob. to change Eal 31 4366 40
Thanrias o rae TA 27 A A7 I
Priority # Servicecalis Before Pet After OEELT # Servicecalls Before Pt After
Closed Deadine Deadiine ¢ Closed Deadiine Deadiine
hedium 4116 1,418 3445 2695 HP Cpenvies Performance |.. 3618 1,289 3563 2,329
Critical 4221 1,448 34.30 2773 HP Openview Operations 3,656 1,260 3446 2,396
Serious 4082 1,400 3430 2682 HP Openview SPls 3,559 1,221 343 2,338
Loy 4102 1,406 3425 2696 HP Openview SIP 1,819 620 3405 1,199
Maore 4186 1422 33497 2,764 HP Operviensy Mk 3522 1,200 3407 2322
Linknotaen 4130 1,383 33.m 2,807 HP Operiesy 1M 3,580 1,213 3388 2,367
Escalated 2120 97 3258 1,423 Unkmossen 3,662 1,229 33456 2433
HP Openview TeMP 3,601 1,142 31 2,459
Waekly | tanthty | Cuartarly |
Weekly Closed Before Deadline Total
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=
= 4,000
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Service Calls Closed on First Call

This report shows the percentage of service calls closed on the first call per classification,

category, priority, and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Service Calls closed table

Total number of service calls closed
Number of service calls closed on first call
Percentage closed on first call

Classification table

Per classification:

e Number of service calls closed

e Number of service calls closed on first call
e Percentage closed on first call

Category table Per category:
e Number of service calls closed
e Number of service calls closed on first call
e Percentage closed on first call

Priority table Per priority code:

e Number of service calls closed
e Number of service calls closed on first call

¢ Percentage closed on first call

Organization table

Per organization:
e Number of service calls closed
e Number of service calls closed on first call

¢ Percentage closed on first call

Tabbed area with bar charts

Number of service calls closed on first call at weekly,
monthly or quarterly intervals (where applicable)

within the evaluation period.

Help Desk: Service Calls
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Thiz repart shows the percentage of sewicecalls closed on the first call (with a creation time
betwzen the Stat and End dates selected) per classification, categony, priority and watgroup.

Select dates forstart and end periods. Start Date <= Registration Time < End [ ate

Servicecalls Closed on First Call

A

invent

Start Date

End Date

IMon Dec 08 2003 :'

Classification

COLE Link option

Check scanned data

Auditing, Error Logs, etc.
External Applications
Crverviewy of Org.

ITC & Service Mavigatar Interf
Mutti rec. report Emg.
Workorders multi rec.

Cpen Probl. by Spec.

Legacy software (ITSM, Task...
Mairtenance screen specialist

Cuantity Cl by classification
apl DRORI FRd

Priority
Critical
Unknawn
Maone
Medium
Lowe
Serious
Escalated

Wieskly I Monthly | Quarterly |

[a] [a]
=1 =1
=] =]
] ]
(=] -+
— ]
= =
o o
) )

Jan 07 2004

II'\."IDn Dec 08 zooaﬂ

# Servicecalls

Jan 21 2004

Closed
108
104
102
101
100

99
95
95
a7
95
95
95

=13

# Servicecalis

Feh 04 2004

Closed
4221
4190
4186
4416
4102
4082
2420

Feh 18 2004
Mar 03 2004

# Closed on
st Caif

L T L)

# Closed on
Tst Calf

120

124

111

121

113

131

E5

Pci

283 =
1.82
0.95
1.95
4.00
404
510
408
206
1.04
417
312

:ﬂn;l

Pct

254
296
285
284
275
by
307

Categmry

Reguest for Information
Suggestion

Inciclert

Enhancement regquest

Qrganization
Unknown
HP Cpenview Operations

HP Openvieww Performance Ihsi...

HP Openviews TebP
HP Qperrviesn I
HF Openviews SPls
HP Operviens MRk
HP Openview SIP

WeeKly Closed on First Call Percentages

Mar 17 2004
Mar 31 2004
Apr14 2004

Apr 28 2004
May 12 2004 §

May 26 2004
Jun 09 2004
Jun 23 2004
Jul 07 2004
Jul 21 2004
Aug 04 2004

Date

# Servicecalls

Aug 18 2004

Closed
27,017

# Servicecalls
Closed

7785

7 G938

b=t

3,958

# Servicecalis
Closed

3 BE2

3656

3615

3601

3,580

3,559

3522

1419

Sep 01 2004
Sep 15 2004
Sep 29 2004

#

Oct13 2004

Closed on
1st Calf
785

# Closed on
st Calf

228

231

224

102

# Closed on
Tst Calf

103

111

99

118

95

104

101

48

Oct 27 2004
MNow 10 2004

Pct
291

2493
3.00
2496
2458

Pct

281
304
274
325
265
306
287
263

Mow 24 2004
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Service Calls Details

This report shows the service call records which have been received for reporting and

processing by the warehouse system.

The user selects start and end dates for the evaluation period. The user can also set filters to
reduce the selection and find specific cases. The primary table displays a limited set of rows
(defaulted to 500 at most) and the lower table provides further details for the selected item.

Field/Drop-Down

Description

Start Date

The date the evaluation period started.

End Date

The date the evaluation period ended.

Choose Category

Limits the report to service calls in the selected
category.

Choose Classification

Limits the report to service calls with the selected
classification.

Choose Workgroup

Limits the report to service calls for the selected
workgroup.

Choose Priority

Limits the report to service calls with the selected
priority code.

Choose Closure Code

Limits the report to service calls with the selected
closure code.

Choose Impact

Limits the report to service calls with the selected
impact.

Choose Organization

Limits the report to service calls for the selected
organization.

Change details

Details of the service calls which meet the selected
parameters. Select an object for further details.

Further details

Further details of the selected object.

Help Desk: Service Calls
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details forthe selected item.

Servicecalls Details

Thiz report shouws the senvicecall records which have been received far reporting and processing by
the warzhouse systemn. Use the filters to reduce the selection and find specific cases. The primany
table displays a limited set of rowvws (defaulted to S00 at most) and the lower table provides further

[

invent

Start Date

|Mc-n Moy 01 2004ﬂ

End Date

Man Dec 06 2004 -

Modification Time
Sun, Dec 3 417 P
Sun, Dec 5 407 P
Sun, Dec 5 4:07 Pw
Sun, Dec 5 4:07 PM
Sun, Dec 5 407 PMW
Sun, Dec 5 407 P
Sun, Dec 5 4:07 Pw
Sun, Dec 5 4:06 PM
Sun, Dec 5 4:06 PM
Sun, Dec 5 4:06 P
Sun, Dec 5 4:06 Pw
Sun, Dec 5 4:06 PM
Sun, Dec 5 4:06 PM
Sun, Dec 5 4:06 P
Sun, Dec 5 4:00 Pw
Sun, Dec 5 3:55 PM
Sun, Dec 5 355 MW
Sun, Dec 5 3:44 P
Sun, Dec 5 315 P
Sun, Dec 3 219 FM
Sun, Dec s 217 PMW

Sle, Dec 5 216 P
a4

|Ch005e Cateqgory

Kl

|Chuu5e Classification

L]

|Choose Waorkgroup

L]

|Ch005e Pricrity

4]

|Chouse Closure Code

Kl

|Ch005& Impact

L]

|Chuu5e Organization

Caller Org Name
HF Opetviesy MW
HF Opetiviesy TemlP
HP Cpernviewy 1k
HP Cpenvieww Operations
HF Openviewy Performance Insight
HF Opetivies MW
HP Cpenview SIP
HP Cpenviewy SPls
HF Opetviewy Performance Insight
HP Cperrviewy Wi
HP Cpenview Operations
HP Cpenviews TeMP
HF Opetview SPIs
HP Cperview Operations
Unkrawrn
HP Cpenvieswy 11K
HF Opetiviesy TemlP
HP Cperrviewy Wi
HP Cpenviewy TeMP
HF Operrviesw SIP
Unkdwn
HP Cpenviewy SPls

Servicecall Details
Onhly Recent Servicecalls Will Be Available

Category HName
Request for Information
Inciclert
Request for Information
Request for Information
Enhancement reguest
Suggestion
Suggestion
Suggestion
Request for Information
Ihcidert
Suggestion
Enhancement request
Erhancemert reguest
Ihcidert
Suggestion
Suggestion
Suggestion
Suggestion
Incident
Request for Information
Suggestion
Incident

Workgroup Hame
RFC Azsessment Team
Migration project team
Unknawvn
Unknawn
Documentation
Test & Cualty Assurance
Documentation
Design
Irtegration project tesm
Unknizwn
Test & Quality Assurance
Change Advisory Board
Currert Procucts
Migration project team
Current Products
Integration project team
Irtegration project team
Dezign
Current Products
Migration project team
Charge Advisory Board
Documentation

Kl

Classificatic
Customer satisfaction -
Canfigurable Extractor
EIDK addprog
Print change woarkorders
Prob. by group
[zelect & classification code]
Search Praok.
aintenance unigue Clnrs.
Prob. (mutti rec.]
Mairtenance Appointiments
laintenance messages
Mot applicable
Prob. by group
i screen escal. fproc.
Open Probl. helpdesk
Archived change
tain scr. stand. warkorders
Open Probl. by Spec.
Performance
Service call Replication
Archive problems
Default progress monitar

s

Further Details for the Selected Item

Creation Date
Sun, Dec 5 4:03 P

Deadline Date Actual Duration in hours

000

Folder Hame
Development

Workgroup Searchcode
Unknowwn
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Service Calls by Closure Code

This report shows the total number of service calls in the selected category with a further
breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field Description

Start Date The date the evaluation period started.
End Date The date the evaluation period ended.
Drill-down category table Per category:

e Number of service calls

e Number of service calls closed before deadline

¢ Percentage of service calls closed before deadline
e Number of service calls closed after deadline

Click the drill icon to display information for a
particular category.

Total service calls table Number of service calls closed before deadline
Total number of service calls

Percentage of service calls closed before deadline
Number of service calls closed after deadline

Closure code table Number of service calls per closure code in the selected
category.

Tabbed area with bar charts | Number of service calls closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period and in the
selected category.
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This report shows the total number of servicecalls (with 3 ereation time behween the Start and End
dates selected) forthe selected categony per closure code. Select dates forstart and end periods.
Start Date <= Registration Time < End Date

(A

invent
Servicecalls by Closure Code
Start Date
IMon Dec 08 2002 vl Cafeglor],u.r # Servicecalls  Before Pct  After Closed # Servicecalls Closed
Reguest for Information 7,785 2583 34 46 5,102 Before o d Pcit After
End Date Sugnestion 7698 2F05 3334 5093 Deadine ose Deadfine
I—_IMO” DecUf 2004w  Incidert 7 576 2511 3314 5085 9,174 27,017 3396 17,843
Enhancement regquest 3958 1,375 3474 2583

Closure Code
Salved in YWEBConnect 5.6.2
Solved in ITSM 512 pstch 04

# Servicecalls

11Dﬂ
108

Solved in YWEBConnect 1.6.3 107
Soived in iTSM 5.7 patch 04 106
Solved in ITSM 5.7 patch 03 106
Salved in Service Desk 3.0 SP3 104
Relsted to Change 102;|
Waakly I Manthly | Cuarterty |
WeeKly Closed Before Deadline Total
For the selected Category
L)
=
= 1,776
o
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E
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[ 1)
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|
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Incoming Service Calls (History)

This report shows the total number of service calls per classification, category, priority and

organization.

The user selects start and end dates for the evaluation period. The report shows service calls
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The date the evaluation period started.

End Date

The date the evaluation period ended.

Service Calls table

Total number of service calls opened.

Classification table

Number of service calls opened per classification.

Category table

Number of service calls opened per category.

Priority table

Number of service calls opened per priority code.

Organization table

Number of service calls opened per organization.

Tabbed area with bar charts

Percentage of service calls opened at weekly, monthly
or quarterly intervals (where applicable) within the
evaluation period.

Help Desk: Service Calls
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Qaiez selecied) per classmcauon, caregony, pronty ana organizanon.
end periods. Start Date <= Registration Time < End Date

DRIECT 03TEE TOF STAM ana x'f' '

invent

Help Desk
Total Incoming Servicecalls (Historical)

Start Date

End Date

# Sendcecalls Opened

Man Dec 08 2003
I ﬂ 1,151

IMon Dec 06 2004 Ll

Classification # Servicecalls Qpened Category # Servicecalis Qpened

Integration (Etrail, LDAP, Managex, MMM, Ra.. 10~ Incidert 343

AP|_CODES ] Reguest for Information 327

AP_CONFIGLURATICON g Sucestion HF

CMDE explarer ] Enhancement request 164

API_PROBLEM g

Rule Mahager ]

Search archived 3C g

Timezones 5]

Search Cl ]

GQuantity of SC by Cl supplier g

API_SERVICECALL T

Default progress monitor T

Mairtenance category & code 7

Ciran O T ;I

Priosity # Servicecalis Opened Qrganization & Servicecalls Qpened

Serious 189 HP Openviews TebP 165

Critical 182 HP Openview SPls 167

Unkrown 181 Unknown 162

Mohe 170 HP Openvieww Operations 156

Medium 168 HP Operviesn MM 154

Loy 163 HP Operviewn I 142

Ezcalated 95 HF Qpenview Performance Insight 135
HP Openview SIP ;1

Whaakhy | Menthly | Quarterly |

Weekly Total Servicecalls
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Incoming Service Calls (Recent)

This report shows the total number of service calls per classification, category, priority and

workgroup.

The user selects start and end dates and times for the evaluation period. The report shows
service calls that were registered on or after the start date and time, and before the end date

and time.
Field Description
Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Start Hour field The start time of the evaluation period.
End Hour field The end time of the evaluation period.

Service Calls table

Total number of service calls opened.

Classification table

Number of service calls opened per classification.

Category table

Number of service calls opened per category.

Priority table

Number of service calls opened per priority code.

Organization table

Number of service calls opened per organization.

Tabbed area with bar charts

Number of service calls opened at hourly or daily
intervals (where applicable) within the evaluation
period.

Help Desk: Service Calls
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SerVice Desk This repart shous the total number of senicecalls (with a creation time between the Start and End [bP]

dates selected) per classification, category, priarity and wokgroup. Select dates forstat and end

periods. Start Hour <= Registration Time < End Hour
Total Incoming Servicecalls (Recent)

inwvent

Start Date End Date
ISun Mov 28 2004 LI |Mc.n Dec 06 2004 LI # Servicecalls Opened
55

Start Hour End Haur
|Nov 28 5:00 AM Ll IDec £ 5:00 AM Ll
Classification # Senicecalls Opened Category # Servicecalls Opened
AP_COMFIGURATICN 2= Request far Information 17
Event configuration 2 Suggestion 17
Legacy software (ITSM, TaskManager, WEE.. 2 Inciclent 13
SC by group 2 Enhancement request ]
API_SERMICECALL 1
Application Server 1
Archived change 1
Archived problem overvies 1
Authorisation menu acces 1
Extractor Developers Kit 1
General 1
Open Probl. helpdesk 1
Mutti rec. repaort Emp. 1
Mein}nnanﬁf Timﬂvfnac\ 4 j
Priority # Servicecalls Opened Qrganization # Servicecalls Opened
Serious 11 HP Opretviesy [ 10
Critical 10 HP Operrviess TebdlP 10
Morne 9 HP Operviesy Operations 9
Unknaoswn 9 HP Openviesy Performance Insight 7
Loy g Unknaenen G
Medium 5] HP Opervvienns M 5
Escalated 2 HP Openviews SPls a9

HP Opetvien SIP 3

Haurty | Daity |

Hourly Total Servicecalls
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5 Help Desk: Incidents

Administration

¢ Configuration and Logging Report

Incidents

e Average Duration of Incidents

¢ Incidents by Category

¢ Incidents by Classification

¢ Incidents Closed Before Deadline by Category
e Incidents Closed by Deadline

¢ Incidents Closed on First Call

¢ Incident Details

e Incidents by Closure Code

¢ Incoming Incidents (History)

¢ Incoming Incidents (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B,
Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to Service Desk Reporting data
import. It lists the most recent log table entries for report packs internal procedures. The
report is limited to the 200 most recent entries.

Field/Drop-Down List

Description

Current logging level

Options (in any combination):
e Error
e Warning

e Information

Log entry

Time the log entry was created
Component to which the log entry refers
Message

64

Se rvice Desk This repaort displays configuration information relating to Senice Desk Reporting data impor, it

lists the most recent log table entries for ReportPack internal procedures. The report is limited to
the 200 most recent entries.

Help Desk
Configuration and Logging

[

invent

Time
Tue Dec 07 12:30 FM
Tue Dec 07 12:30 PM
Tue Dec 07 12:26 PM
Tue Dec 07 1225 PM
Tue Dec 07 12:24 PM
Tue Dec 07 12:24 FM

Current Logging Level:

Errors, Warnings and Info

ReportPack Log Entries

{maost recent first)

Component Message
SenD_Problems_map_p Info: G242 rowe inserted
SenD_Problem=s_map_p Info: 5848 rows in datapipe table

SenD_Senicecalls_map_p Info: 32679 rome inserted

SenD_Senicecalls_map_p Info: 32679 roves in datapipe table
SenD_Incidents_map_p Info: 539 rows inserted
SenD_Incidents_map_p Info: 539 roves in datapipe table
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Average Duration of Incidents

This report shows the average duration of incidents in days per classification, category,
priority and workgroup. Once you select start and end dates for the evaluation period, the

report shows incidents that were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date field Drop-down list. The start date of the evaluation
period.
End Date field Drop-down list. The end date of the evaluation

period.

Total incidents table

Total number of incidents and average duration (in
days).

Classification table

Number of incidents and average duration per
classification.

Category table Number of incidents and average duration per
category.
Priority table Number of incidents and average duration per

priority code.

Tabbed area with bar charts

Average duration of incidents at weekly, monthly or
quarterly intervals (where applicable) within the
evaluation period.

Help Desk: Incidents
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Thizs report showes the average duration of incidents in days (with a creation time betveen the Start
and End dates selected) per classification, categony, priority and wodgroup. Choose a daw for start
and end periods. Start Cate <= Registration Time < End Cate

Average Duration of Incidents

(A

invent

Sfzrf Dafe

End Daée

|Thu Dec 11 2003 Ll

Classification
Wiorkarder module
General

Additional software
Error in documentation
Interface standards
Platfaorm port
Unkriowsn
Configuration manager
Cost Manager

Report manager
System docutnentation
System adminiztration
Irtegration

D rblaien vemem oy

Priority
Medium
Mone
Escalated
Lowy
Serious
Unkriash
Critical

Whaakhy | Menthly | Quarterly |

Dec 17 2003
Dec 31 2003
Jan 14 2004

Jan 28 2004

Feh 11 2004

Feh 25 2004

IMon Dec 06 2004 Ll

# Incidents

34
42
35
38
19
2
33
|
43
34
|
23
%

A

# Incidents

hiar 10 2004

78
62
700
94
7
44
81

Avg

1386 2

7.36
6.90
665
B35
623
G.06
402
4.50
437
328

3.21 .

317

ﬁ:n;l

Avg
565
660
g.02
542
476
463
265

Category

Unknown

Confirmed for release

Proposed for release

Planned for release

Cancelled

Cust, Specific Custamization
Change Advizory Board decision
Eatly MNewFeature Customization
Change manager decizion
Upgrade of customization

Qrgarization
HP Openviews MR
HF Qpenview SIP
HP Operview I
HP Openviews SPls
HP Openviewy Performance Ihsight
Unknown
HP Qpenview TellP
HP Openviews Operations

Weekly Average Duration of Incidents

hiar 24 2004
Apr 07 2004

Apr21 2004

tay 05 2004

hay 19 2004

=+
=
=
ol
[==)
o~
=
=

o Jun 02 2004
Jun 16 2004
Jun 302004
Jul 14 2004
Aug 11 2004

ate

Aug 25 2004

_ Average
Rincidents — p ration (days)
500 5.55
# Incidents Avg
28 1083
58 5.9
51 5.2
54 591
45 443
55 452
=3 347
46 352
57 325
40 260
# Incidents Avg
55 1036
33 943
54 72
66 264
73 515
52 375
70 281
74 216

Sep 08 2004

Sep 22 2004

Oct 06 2004

Oct 20 2004

Moy 03 2004

Moy 17 2004
Mae 01 7004
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Incidents by Category

This report shows the total number of incidents in the selected category with a further

breakdown by impact, priority and classification. Once you select start and end dates for the
evaluation period, the report shows incidents that were registered on or after the start date,
and before the end date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Drill-down category table

Number of incidents per category. Click the drill icon
to display information for a particular category.

Incidents table

Total number of incidents.

Impact table Number of incidents opened per impact code in the
selected category.
Priority table Number of incidents opened per priority code in the

selected category.

Classification table

Number of incidents opened per classification in the
selected category.

Tabbed area with bar charts

Number of incidents at weekly, monthly or quarterly
intervals (where applicable) within the evaluation
period and in the selected category.

Help Desk: Incidents
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This report shows the total number of incidents (with a creation time between the Start and End

dates selected) for the selected categony per impact, priority and classification. Select dates for
start and end periods. Start Date <= Registration Time < End [Cate

Incidents by Category

O

invent

Start D ate
Thu Dec 11 2003 = Category # Incidents Opened # Incidents Opened
Cancelled 3 17
End Date Unknawn 2
Mon Dec 06 20048 |+ Change Advisory Board decision 2
Change manager decizion 2
Planned for release 2
Upgrade of customization 2
Confirmed for release 2
Early MewFesture Customization 1
Proposzed for release 1
# Incidents A # Incidents _ _ # Incidents
Impact Priority Classification
Qpened Qpened Opened
High (Department affected) 2 Critical 1 Report manager 1
Unknown 1 Low 1 System documentstion 1
Serious 1 Wiorkarder mocduls 1
Wiaskly I Manthly | Cuartery |
Weekly Total Incidents
for the Selected Category
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Incidents by Classification

This report shows the total number of incidents with the selected classification, with a further
breakdown by category. By selecting start and end dates for the evaluation period, you limit
the report to incidents that were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Incidents table Total number of incidents.

Drill-down classification table | Number of incidents per classification. Click the drill
icon to display information for a particular

classification.

Category table Number of incidents per category with the selected
classification.

Tabbed area with bar charts Number of incidents at weekly, monthly or quarterly

intervals (where applicable) within the evaluation
period and with the selected classification.

Help Desk: Incidents 69



70

Service Desk
Help Desk
Incidents by Classification

This report showes the total number of incidents (mith a creation time betveen
the Start and End dates selected) for the selected classification with a further
break down by category. Select dates forstart and end periods.  Start Date
<= Registration Time < End Date

(A

invent

Start Date

IThu Dec11 2003 |- I

End Date

IMon Dec 06 2004 vI

Classification
General

Unknower

Report manager
Workorder macdule
Error in documertation
Additional software
System documentstion
Platform port

Cost Manager
Document Recguirements

ekl | manthly | Quartsrly |

Incident Count

# incidents Qpened
17
2 ncidents Opened for the sefected Classification
Category # Incidents Opened
Unknowh

Change Advizory Board decision
Proposzed for release
Upgrade of customization

T SRR IR

Weekly Total Incidents
for the Selected Classification

Dec10 2003
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Jan 07 2004
Jan 21 2004
Feh 04 2004
Feh 18 2004
Mar 03 2004
Mar 17 2004

Mar 31 2004
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Incidents Closed before Deadline by Category

This report shows the total number of incidents closed before the deadline in the selected

category, with a further breakdown by closure code. The user selects start and end dates for
the evaluation period. The report shows incidents that were registered on or after the start

date, and before the end date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Incidents closed table

Total number of incidents closed

Number of incidents closed before deadline
Percentage closed before deadline

Number closed after deadline

Drill-down category table

Per category:

e Number of incidents closed

e Number of incidents closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Click the drill icon to display information for a
particular category.

Closure code table

Per closure code in the selected category:

e Number of incidents closed

e Number of incidents closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Tabbed area with bar charts

Number of incidents closed before deadline at
weekly, monthly or quarterly intervals (where

applicable) within the evaluation period and in the

selected category.
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Service Desk This report shows the percentage of incidents closed befare the deadline (with a
creation time between the Start and End dates zelected) for the selected categony
and closure code. Select dates for start and end periods. Start Date ==

HElp DESk Registration Time < End Date

invent

Incidents Closed Before Deadline by Category
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IT Service Manager 5.1 3

Waakly ] hanthly | Quartery |

Weekly Closed Before Deadline Total
For the selected Category

[ i)

£

=

m

et

o

=

=

=

[ )

w

=]

]

#0
o o =t =t =t -t =t =t =t -t -t =t =t -t -t -t =t =t -t -t =t =t =t -t =t =
= = = = = = = = = = = = = = = = = = = = = = = = = =
= = = = = = [ ) = = = = [ ) = = = = = = = = = = = = = =
(] [} (] (o] (] [} [} (] ('] (] [} [} (] (] (] [} (] (] (] [} (o] (] (] [} (] [
- — -t o — W [ ) =t == — W o [ ] [iu] = -t oo — W oo (] [tu) = () - —
— o — (o] — [an ] — (] = [} o) — = — o — (o] — (] o) (o] = (o] o) — =
= =3 = = = = = = = = = = = = = = = o o o o hxi hxi = = =
2 » @ o o & B2 Z 2 ®m @ 3 3 3 3 3 3 3 @ o g g 2 £ a
=) [ T B T L E =E = = =2 3 5 L L 1 = =Z C

Date

Chapter 5



Incidents Closed before Deadline

This report shows the percentage of incidents closed before the deadline per classification,
category, priority and workgroup. By selecting start and end dates for the evaluation period,
you limit the report to incidents that were registered on or after the start date, and before the

end date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Incidents closed table

Total number of incidents closed

Number of incidents closed before deadline
Percentage closed before deadline

Number closed after deadline

Classification table

Per classification:

e Number of incidents closed

e Number of incidents closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Category table

Per category:

e Number of incidents closed

e Number of incidents closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Priority table

Per priority code:

e Number of incidents closed

e Number of incidents closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Organization table

Per organization:

¢ Number of incidents closed

e Number of incidents closed before deadline
¢ Percentage closed before deadline

e Number closed after deadline

Tabbed area with bar charts

Number of incidents closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period.
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This report shows the percentage of incidents clozed before the deadline (with a creation time
between the Startt and End dates selected) per classification, categony, priority and wodgroup.

Select dates for start and end periods. Start Date <= Registration Time < End Date

O

invent
Incidents Closed Before Deadline
Start Date End Date
IThu Dec 112003 |+ | IMon Dec06 2004 v | # Incidents Ciosed Eefore - Closed After
Closed Deadiine Deadine
500 0 0.00 500
_ . # incidents EBefore ARter # incidents EBefore After
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Incidents Closed on First Call

This report shows the percentage incidents closed on the first call per classification, category,
priority and workgroup. By selecting start and end dates for the evaluation period, you limit
the report to incidents that were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Incidents closed table

Total number of incidents closed
Number of incidents closed on first call
Percentage closed on first call

Classification table

Per classification:

e Number of incidents closed

e Number of incidents closed on first call
e Percentage closed on first call

Category table Per category:
e Number of incidents closed
e Number of incidents closed on first call
e Percentage closed on first call

Priority table Per priority code:

e Number of incidents closed
e Number of incidents closed on first call

¢ Percentage closed on first call

Organization table

Per organization:
e Number of incidents closed
e Number of incidents closed on first call

¢ Percentage closed on first call

Tabbed area with bar charts

Number of incidents closed on first call at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period.
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Help Desk

This report showes the percentage of incidents closed on the first call (with a creation time

between the Start and End dates selected) per classification, categony, priority and wodigraup.
Select dates forstart and end periods. Start Date <= Registration Time < End Date

Incidents Closed on First Call

A

invent

Start D ate End Date
IThu Dec 11 2003 Ll |Mon Dec 08 Eﬂﬂ4ﬂ # Incidents # Closed on -
Closed 15t Calf
500 4 0.80
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Incidents Details

This report shows the incident records which have been received for reporting and processing
by the warehouse system. The user selects start and end dates for the evaluation period. The

user can also set filters to reduce the selection and find specific cases. The primary table

displays a limited set of rows (defaulted to 500 at most) and the lower table provides further

details for the selected item.

Field/drop Down List Description
Start Date The start of the evaluation period.
End Date The end of the evaluation period.

Choose Category

Limit the report to incidents in the selected category.

Choose Classification

Limit the report to incidents with the selected
classification.

Choose Workgroup

Limit the report to incidents for the selected
workgroup.

Choose Priority

Limit the report to incidents with the selected priority
code.

Choose Closure Code

Limit the report to incidents with the selected closure
code.

Choose Impact

Limit the report to incidents with the selected impact.

Choose Organization

Limit the report to incidents for the selected
organization.

Change details list

Details of the incidents which meet the selected
parameters. Select an object for further details.

Further details list

Further details of the selected object.

Help Desk: Incidents
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Service Desk
Help Desk
Incidents Detalls

This report showes the incident records which have been received for reporting and processing by the
wuarehouse system. Use the filkers to reduce the selection and find specific cases. The primany table
displays a limited s&t of rows (defaulted to 00 at most) and the lower table provides futher details far
the selected item.

in

[

vent

Start Date

|Wed Mowv 03 2004ﬂ |Ch005& Category

L]

End Date

Maon Dec 06 2004 |+

|Ch005& Classification

L]

|Ch005& Waorkgroup

L]

|Ch005& Priority

L]

|Ch005& Closure Code

L]

|Ch005& Impact

L]

|Ch005& Organization

Modification Time
Sun, Dec 5 10:538 &M
Sat, Dec 4 938 PM
Sat, Dec 4 9:38 PM
Sat, Dec 4 5:42 PM
Sat, Dec 4 4:36 PM
Fri, Dec 3 1:59 PM
Fri, Dec: 3 1:59 P
Fri, Dec 3 1:55 PM
Fri, Dec 310:27 AM
Fri, Dec 3 10:27 Al
Fri, Dec 3 10:06 &M
W, Dec 1 546 PM
Wed, Dec 1§53 AM
Mon, Moy 29 11:25 AWM
Mar, Mow 29 11:28 AM
Mon, Moy 29 11:27 AWM
Mon, Moy 29 11:27 Ak
Suh, Moy 28 3:50 PM
Sun, Mow 25 10:47 Ak
Sun, Moy 28 10:43 Ak
Sun, Mow 25 10:43 AM
SLfn, Mo 28 10:42 Ak

4

Caller Org Name
HP Openview SPls
HP Openview Operstions
HP Openview Operations
HP Openview Operstions
HP Openview SPls
HP Opervviews MR
HP Openview Operstions
HP Openview Performance Insight
HP Opervviewy MRk
HP Openview TehP
HP Openview TeP
HP Opernview IUM
HP Openview TeP
HP Openview SPls
HP Openview Operstions
HP Openview TeP
HP Openview Performance Insight
HP Opernview 1L
HP Openview Performance Insight
HP Openview Operstions
HP Openview SIP
HP Openview TelP

Incident Details

Only Recent Incidents Will Be Available

Category Mame
Proposed for release
Change manager decision
Change Advizory Board decision
Cancelled
Early MewwFeature Customization
Proposed for release
Change Advizory Board decision
Planned for release
Cancelled
Linknown
Change Advizory Board decision
Planned for releaze
Planned for release
Canfirmed for release
Planned for release
Upgrade of customization
Proposzed for release
Propozed for release
Planned for release
Canceled
Caonfirmed for release
Planned for release

-

Kl

Workgroup Name
Design
RFC Assessment Team
Future Products
Migration project team
Interface Design team
RFC Aszessment Team
Change Advizory Board
Irterface Desigh team
Technical Marketing
Interface Design team
Technical Marketing
Migration project team
Test & GQuality Assurance
Unkniown
Current Products
Future Products
Design
Migration praoject team
Unkniown

Classification Hame
Cost Manager
Proklem manager
Errar in cocumentation
System documentation
Additional software
General
General
Repart manager
Workorder module
Integration
Docurment Reguiremerts
Integration
System administration
Problem manager
General
System documentation
Error in documentstion
Probiletn matager
Platform port

Special Projects Engineering General
Special Projects Engineering Report manager

Unknawr

Further Details for the Selected Item

Creation Date
Thu, Oct 14 1:37 PR

Folder Hame
Developtnert

Deadline Date

Actual Duration in hours

.00

Configuration manager

Workgroup Searc
Lrknowh

Pri
Med &
Esc:
Mt

Seri
Esce

hcode
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Incidents by Closure Code

This report shows the total number of incidents in the selected category with a further

breakdown by closure code. By selecting start and end dates for the evaluation period, you can
limit the report to incidents that were registered on or after the start date, and before the end

date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Drill-down category table

Per category:

¢ Number of incidents closed

e Number of incidents closed before deadline
¢ Percentage closed before deadline

e Number of incidents closed after deadline

Click the drill icon to display information in a
particular category.

Total incidents table

Total number of incidents closed before deadline
Number of incidents closed
Percentage closed before deadline

Number of incidents closed after deadline

Closure code table

Number of incidents closed per closure code in the
selected category.

Tabbed area with bar
charts

Number of incidents closed before deadline at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period and in the selected
category.
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Help Desk

Incidents by Closure Code

This report showes the total number of incidents (with 3 creation time betueen the Start and End

dates selected) for the selected categony per closure code. Select dates for start and end periods. 6
Start Date <= Registration Time < End Date

invent

Start D ate

IThu Dec 11 2003 vl
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IMon Dec 06 2004 vl
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Proposzed for release Bl 0.0a 51 Ciosure Code # Incidents
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Lzo=celofestonization 4y 0D 40 Solved in Service Desk 4.0 5P4 &
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IT Setvice Mahager 6.0 4 Ll
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Incoming Incidents (History)

This report shows the total number of incidents per classification, category, priority and
organization. By selecting start and end dates for the evaluation period, you can limit the
report to incidents that were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents table Total number of incidents opened.

Classification table Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization table Number of incidents opened per organization.

Tabbed area with bar charts | Percentage of incidents opened at weekly, monthly
or quarterly intervals (where applicable) within the
evaluation period.
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Help Desk
Total Incoming Incidents (Historical)

This report showes the total number of incidents (with a creation time bebween the Start and End
dates selected) per classification, categony, priority and organization. Select dates for start and
end periods. Start Date <= Registration Time < End Date

A

invent

Start Date

End Date

|Thu Dec 11 2003 j

Classification

General

Error in documentation
Report manager
Wiorkorder moclule

Unknowvn

Additional oftware

System documentation

Platfartn port
Cost Manager

Document Requirements

Priority
Mone
Loy
Serious
Ezcalated
Lnkniosn
Medium
Critical

|Mon Dec 06 2004 ﬂ

Waakhy ] henthly | Quarterly |

Incident Caunt

# Incidents Opened

e S S

# Incidents Opened

Sl N LS (5 W R TV

Category
Cancellzd

Change Advisory Board decision
Change manager decision
Planned for release

Unknowen

Upgrade of customization
Confirmed for release

Early MewFesture Custarization
Proposed for release

Qrganization

HF Openview Cperations

HP Cpervviessy LR

HP Openview SPls

HP Cperviess M

HP Qpenvies Performance Ihsight
HF Openviess SIP

Weekly Total Incidents

# Incidents Qpened

17

# Incidents Opened

= = R} MR ORI R ORI

# Incidents Opened
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Dec 17 2003

Dec 31 2003

Jan 14 2004

Jan 28 2004

Feh 11 2004

Feh 25 2004

Mar 102004
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May 05 2004

May 19 20041

Jun 0z 2004
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Jun 302004
Jul14 2004
Jul 28 2004
Aug 11 2004
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=
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Aug 25 2004

Sep 082004

Sep 22 2004

et 06 2004 4

Oct 202004
Ny 02 2004

Maw 17 2004
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Incoming Incidents (Recent)

This report shows the total number of incidents per classification, category, priority and
workgroup. By selecting start and end dates, and start and end hours, for the evaluation
period, you can limit the report to incidents that were registered on or after the start date and
time, and before the end date and time.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.

End Hour The end time of the evaluation period.

Incidents table Total number of incidents opened.

Classification table Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization table Number of incidents opened per organization.

Tabbed area with bar charts | Number of incidents opened at hourly or daily
intervals (where applicable) within the evaluation
period.
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dates selected) per classification, categony, priority and wotigroup. Select dates forstart and end
periods. Start Hour <= Registration Time < End Hour

SerVice Desk Thiz report shovws the total number of incidents (with 3 creation time betuveen the Stat and End (ﬁﬁ]
HEIp DESk invent

Total Incoming Incidents (Recent)

Start Date End Date
ISun Naow 28 004 Ll |r-.ﬂon Dec 08 2004 ﬂ # Incidents Opened

1
Start Hour End Hour
INOVEE 10:00 AM Ll IDBCE‘IE:DD RM ﬂ
Classification # Incidents QOpened Cateqgory # Incidents Qpened
System docurnerntation 1 Cancelled 1
Prority # Incidents Opened Organization # Incidents Opened
Loy 1 HP Openview Operations 1

Haurhy I Daity |

Hourly Total Incidents

Incident Caunt

Date
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6 Help Desk: Problems

Administration

¢ Configuration and Logging Report

Problems

e Average Duration of Problems

e Problems by Category

e Problems by Classification

e Problems Closed before Deadline by Category
e Problems Closed by Deadline

¢ Problems Closed on First Call

¢ Problem Details

e  Problems by Closure Code

e Incoming Problems (History)

¢ Incoming Problems (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B,
Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to Service Desk Reporting data
import. It lists the most recent log table entries for report pack internal procedures. The
report is limited to the 200 most recent entries.

Field

Description

Current logging level

Options:

e Error

e Warning

e Information

(or any combination)

Log entry

Time the log entry was created

Component to which the log entry refers

Message

Service Desk
Help Desk
Configuration and Logging

This report dizplays configuration information relating to Semice Desk Reporting data import, it
lists the most recent log table entries for RepodPack intermal procedures. The report is limited to
the 200 most recent entries.

O

inwvent

86

Time
Tue Dec 07 12:30 PW
Tue Dec OF 12:30 PW
Tue Dec 07 1226 FW
Tue Dec OF 12:25 PW
Tue Dec OF 12:24 P
Tue Dec 07 12:24 PW

Current Logging Level:

Errors, Warnings and Info

ReportPack Log Entries

{most recent first)

Component Message
SerD_Problems_map_p Info: 248 rowes insered
SenD_Problems_map_p Info: 5343 rows in datapipe table

SenD_Semicecalls_map_p Info; 32679 mwe inserted

Send_Senicecalls_map_p Info: 32679 mows in datapipe table
SenD_Incidents_map_p Info: 539 roves ingerted
SenD_lncidents_map_p Info: 39 roves in datapipe table
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Average Duration of Problems

This report shows the average duration of problems in days per classification, category,
priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Total problems table Total number of problems and average duration,

measured in days.

Classification table Number of problems and average duration per
classification.

Category table Number of problems and average duration per
category.

Priority table Number of problems and average duration per

priority code.

Tabbed area with bar charts | Average duration of problems at weekly, monthly or
quarterly intervals (where applicable) within the
evaluation period.
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Help Desk

Thiz repart shows the average duration of problems in days (with a creation time bebueen the Start
and End dates zelected) per classification, categony, priority and wodigroup. Chooze a day forstart

and end periods. Start Date <= Registration Time < End D ate

Average Duration of Problems

[

invent

Lfarf Dafe

End Date

IWed Dec 10 2003 Ll

Classification

Idain screen Software Conf ftem
ACES

Upgrade

Default progress montor

Mait screen Org.

ITO msgrey

API_CODES

Unsuppoarted configuration
Prokl by Specialist

To Do overview SpecialistiGrou
Inventory Reconcilistion Mana
Drata

Pririt

ITD Crrwmardinen s

Priority
Mare
Unknowyn
Critical
Escalated
Lo
Serious
fedium

Weekly | Manthty | Quarterly |

II‘\."Ion Dec 08 2004 Ll

# Problems

10
12
12

=
= -~ W - W

n

# Problems

402
196
420
332
Erl)
392
392

Weekly Average Duration of Problems

Avg
38357 2
368.20
310.41
30857
29474
290.65
290.34
28651
27819
27281
270.50
25319
25074

A TR ;I

Avyg
13157
11285
10605
10537

9551

&5.20

a7 BR

Catagory
Enhancemert Reguest

Unkrowr
Knowen Error
Defect

Organization

Dec 17 2003 4
Dec 31 2003 £
Jar 14 2004

Jan 28 2004

Feh 11 2004 ]

Feh 25 2004

Mar 10 2004

Mar 24 2004

Apr07 2004

Apr21 2004
May 05 2004

May 19 2004 t

Jun 02 2004
Jun 16 2004
Jun 30 2004
Jul14 2004 ¢

[
i}
=
o

Jul 28 2004

Aug 11 2004

Aug 25 2004

Average
B AR Duration (days)

2,508 103.81

# Problems Avg

GE5 1133

722 103.21

364 100 60

734 a7

# Probiems Avg

Sep 08 2004

Sep 22 2004 ¢

Oct 08 2004 4
Oct 20 2004 1
Mov 03 2004

Mov 17 2004
MNer M1 7004
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Problems by Category

This report shows the total number of problems in the selected category with a further
breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Drill-down category table Number of problems per category. Click the drill icon
to display information for a particular category.

Total problems table Total number of problems.

Impact table Number of problems opened per impact code in the

selected category.

Priority table Number of problems opened per priority code in the
selected category.

Classification table Number of problems opened per classification code in
the selected category.

Tabbed area with bar charts | Number of problems at weekly, monthly or quarterly
intervals (where applicable) within the evaluation
period and in the selected category.
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Help Desk

Problems by Category

This report shows the total number of problems (with 3 creation time between the Stat and End
dates selected) for the selected categony per impact, prionity and classification. Select dates for

=tart and end period:

=. Start Date <= Registration Time < End [ate

(A

invent

Start Date

IWBd Dec 10 2003 vl

End Date

II'\."Ion Dec 06 2004w l

Catagory
Defect

Enhancement Request
Unkniowh

Knowen Error

Weekly Total Problems
for the Selected Category

# Problems
mpact
pa Opened
Top (Site F Organization affected) §  Critical
Lowvy [ 1 person affected) T Low
High (Depattmernt affected) 7Y Escalated
Mone 5 Unknown
Medium (Group J Unit sffected) 5 Mone
Unknown 3 Serious
hdedlivim
Waekly I Manthly | Quarterly |
E4
=
o
L]
§
S
2
o
i}
[zl o = =t -t = =t -t =t =t
= = = = = = = = = =
= = = = = = = = = =
(] [ (] ('] [ (] ('] [ (] (']
- — -t oo — uw = =t - —
— [an] — (o] — (o] — o = (o]
£ 2 £ £ &£ 2 5§ &5 5 &5
8 a4 8 35 2 2 = = £ &

# Problems Opened

# Probiems

BT Opened

May 05 2004
May 18 2004
O Jun 02 2004
Jun 16 2004
Jun 30 2004

ate

Jul14 2004

= Bk A D@ O

Jul 28 2004

33
27
22

Classification

Check List

Search article

At and Def. by module
Iain screen Cl

Linking S 1o Prok.

Main screen Crg.
Session monitar
Mairtenance user language
Maintenance warkorders
Wiorkarders by Spec.
Crwverview SC breakdown
Cuantity SC by Cl name

b s T b 1 s neaelise

Aug 11 2004
Aug 25 2004
Sep 08 2004
Sep 22 2004
Oct 06 2004

92

Oct 20 2004

# Problems Opened

# Problems
Opened

MNaw 03 2004

4 m e m e e e R
»

F1

Mow 17 2004
Mer N1 2004
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Problems by Classification

This report shows the total number of problems with the selected classification, with a further
breakdown by category.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date field Drop-down list. The start date of the evaluation
period.

End Date field Drop-down list. The end date of the evaluation
period.

Problems table Total number of problems.

Drill-down classification Number of problems per classification. Click the drill

table icon to display information for a particular
classification.

Category table Number of problems per category with the selected
classification.

Tabbed area with bar charts | Number of problems at weekly, monthly or quarterly
intervals (where applicable) within the evaluation
period and with the selected classification.
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Service Desk
Help Desk

Problems by Classification

Thiz report shows the total number of problems (with a creation time betwzen
the Start and End datesselected) for the selected classification with a further
break down by categony. Select dates forstart and end periods.  Start Date
<= Registration Time < End Date

[

invent

Start Date

IWed Dec 102003 - l

End Date

II"\."Ion Dec 06 2004 = l

Classification

Zoeken config (voor rapporten)

Search aricle

Open Probl. by Spec.

Iain screen SC
Main screen Crg.
Session manitor
Add uzer vwizard
Check List

Ernpty Database
ITP Connections

Date Calculstions (Deadline, Durstion, Start and...

weekly | manthty | Quartarty |

Prablem Caunt

Jan 21 2004

Feb 04 2004

Fetching Service - SLA - Service Level

# Probiems Opened
a2

for the sefected Classification

# Probiems Opened

»

Defact
Known Error
Enhancement Reguest

3 ORD ORI ORX ORI ORI ORI ORI ORI ORI ORI ORI D

=

Weekly Total Problems
for the Selected Classification

Fehb 18 2004

Mar 03 2004

Mar 17 2004

Mar 31 2004

Apr14 2004
Apr 28 2004
ey 12 2004
Wy 26 2004
Jun 09 2004
Jun 23 2004
Jul 07 2004
Jul 21 2004
Aug 04 2004
Aug 18 2004

Date

Sep 01 2004

Category # Probiems Opened

Sep 152004
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Problems Closed before Deadline by Category

This report shows the percentage of problems closed before the deadline in the selected
category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Problems closed table Total number of problems closed

Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Drill-down category table Per category:

Number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number closed after deadline

Click the drill icon to display information for a
particular category.

Closure code table Per closure code in the selected category:
Number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number closed after deadline

Tabbed area with bar charts | Number of problems closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period and in the
selected category.
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Help Desk

Thizs report showe the percentage of problems clozed before the deadline (with a
creation time bebween the Start and End dates selected) for the selected categony

and closure code. Select dates forstart and end periods. Stant Date <=
Registration Time < End Date

Problems Closed Before Deadline by Category

A

nvent

Start Date End [ate

|Wed Dec 10 2003 Ll II'\."Ion Diec 06 2004 LI # Problems Closed Before -
Closed Deadine
2,508 263 10.49
for the sefected Cate
Category # Probiems Before Pct After gory
Enhancetnent Reguest (=] 73 11.34 610 Closire Code # Problems
Unkrown T2 76 1053 B46  Solved in customization(patch)
Defect 734 71 987 BE3  SolvedinITSM5.2.4
Krosen Errar 364 35 10.44 326 Solvedin ITSM 5.6 patch 02
Knowledge base
Solved in Service Desk 2.0 SP3
Solved in WEBConnect 5.7 2
Cloged on customer request
Solved in ITSM 5.5 patch 02
Solved in Service Desk 4.0 3P2
Cormplete solution offered
Unable to reproduce error
Unkrowyr
Wiaakhy I donthly | Quarterly |
Weekly Closed Before Deadline Total
For the selected Category
g 20
=16
&
}1 2
=
= 8
i)
£ 4
o U | s | s | g | s |
* o =t =t =t =T =t =t =t =t =t =t =t =t =t =t =t =t =t =t =t =T =t =t
= = = = = = = = = = = = = = = = = = = = = = =
= = = = = = = = = = = = = = = = = = = = = = =
o (] (o] o o~ (o] o [l o4 (o] [l o4 (o] o o4 (o] o o (o] (o] o~ [l (o]
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g8 s ete 2222222333323 88¢8¢969
Date

Closed After
Deadiine
2,245

11
10

13
15
14
13
13
13
12
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10

Moy 10 2004

Before

L3

B3 B3PI RX R ORI ORI ORI RX L) G LD

K

Moy 24 2004
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Problems Closed by Deadline

This report shows the percentage of problems closed before the deadline per classification,
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Problems closed table Total number of problems closed

Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Classification table Per classification:

Number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number closed after deadline

Category table Per category:

Number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number closed after deadline

Priority table Per priority code:

e Number of problems closed
e Number of problems closed before deadline
e Percentage closed before deadline

e  Number closed after deadline

Organization table Per organization:

e Number of problems closed
¢ Number of problems closed before deadline
¢ Percentage closed before deadline

e  Number closed after deadline

Tabbed area with bar charts | Number of problems closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period.
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This report showes the percentage of problems closed before the deadline (with a creation time
bebween the Start and End dates selected) par classification, categony, priority and wotgroup.
Select dates for start and end periods. Start [rate <= Registration Time < End Date

[

invent
Problems Closed Before Deadline
Start Date End Date
IWBd Dec 10 EL‘IUSLI IMon Dec 06 2004L| # Probiems Closed Before - Closed After
Closed Deadiine Deadiine
2,508 263 10.49 2,245
_ _ # Problems Before After # Problems Before After
Classification ! Pct . Cate ! Pct y
Closed Deadine Deadline by Closed  Deadiine Deadiine
Linking SC to Praok. 7 3 4286 4 & Enhancement Reguest 638 78 1134 E10
Cracle Developer Tools 7 3 4286 4 Lnknowen 722 76 1053 G456
Maintenance messages 11 4 3E36E 7 Kriowwn Error 364 38 1044 326
Print appointmerts g 3 3333 5] Defect T34 il 967 BE3
Main screen Def. Soft. Lib. -1 2 3353 4
Ul Rules 5] 2 3333 4
Application Server 13 4 3077 9
Maintenance search codes 13 4 3077 9
Main screen SC 10 3 3000 7
Information screen 14 4 2857 10
Forms Beeper 7 2 2857 5
Cpen time of SC by priority 7 2 2857 5
Caoarch Thae T 7 R ET = ;I
o # Probiemns EBefore After L # Probiems Before After
Priori ! Pct y Organization - Pct y
ty Closed  Deadine Deadine Closed  Deadine Deadiine
Lo 374 500 1337 324
Medium 3592 46  11.73 346
Critical 420 48 1143 372
Ezcalated 332 32 9.64 300
Mare 402 37 920 365
Serious 382 39 5493 387
Urktuzter 196 15 7 ES 181
Wackly | wanthly | Cuartarty |
Weekly Closed Before Deadline Total
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Problems Closed on First Call

This report shows the percentage of problems closed on the first call per classification,
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Problems closed table

Total number of problems closed
Number of problems closed on first call
Percentage closed on first call

Classification table

Per classification:

Number of problems closed

Number of problems closed on first call
Percentage closed on first call

Category table Per category:
Number of problems closed
Number of problems closed on first call
Percentage closed on first call

Priority table Per priority code:

Number of problems closed
Number of problems closed on first call

Percentage closed on first call

Organization table

Per organization:
Number of problems closed
Number of problems closed on first call

Percentage closed on first call

Tabbed area with bar charts

Number of problems closed on first call at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period.
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Service Desk Thiz repart showes the percentage of problems clozed on the first call (with 3 ereation time ﬂp]

beteen the Start and End dates selected) per classification, category, prienity and watgroup.
Help Desk

Select dates forstart and end periods. Start D ate <= Registration Time < End Date
Problems Closed on First Call

invent

Start Crate End Date
|Wed Diec 10 2003 v | |Mon Dec 05 2004 v | # Problems # Closed on -
Closed Tst Call
2,508 0 0.00
; _ # Prohiems # Closed on # Probiems # Closed on
Classification Closed 15t Caif Pct Category Closed st Caif Pct
Main scr. stand. workorders 19 0 000 = Defect T34 0 000
[Zelf) Service Pages 18 u] 0.00 Unknawen T22 o 000
Date Calculations (Deadlineg, Du... 15 a 0.00 Enhancement Reguest G55 o 000
Classificatie relaties 17 0 0.00 Known Error 364 0 000
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Update &l 17 u] 0.00
Creerviewy Cl relations 17 0 0.00
Generate ClWwizard 17 1] 0.00
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CMDE 16 0 .00
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Cinai waameleeed b s Rae e ines 18 n nnn I
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Problems Details

This report shows the problem records which have been received for reporting and processing

by the warehouse system.

The user selects start and end dates for the evaluation period. The user can also set filters to
reduce the selection and find specific cases. The primary table displays a limited set of rows
(defaulted to 500 at most) and the lower table provides further details for the selected item.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Choose Category

Limit the report to a category.

Choose Classification

Limit the report to a classification.

Choose Workgroup

Limit the report to a workgroup.

Choose Priority

Limit the report to a priority code.

Choose Closure Code

Limit the report to a closure code.

Choose Impact

Limit the report to an impact.

Choose Organization

Limit the report to an organization.

Change details list

Details of the problems which meet the selected
parameters. Select an object for further details.

Further details list

Further details of the selected object.

Help Desk: Problems
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Help Desk

This repart showes the problem records which have been received for reporting and processing by the
warehouse system. Use the filters to reduce the selection and find specific cases. The primary table
displays a limited =set of rows (defaulted to 900 at most) and the lower table provides futher details for
the zelected item.

A

invent

Problems Details

7100

Start Date

IMon Nav 01 EDD4ﬂ

End Date

II‘\."Ion Dec 08 2004 vl

Maodification Time
Sun, Dec 5 819 P
Sun, Dec 5 7:50 P
Sun, Dec 5 707 P
Sun, Dec 5 6:20 PM
Sun, Dec 5 6:035 PM
Sat, Dec 4 9:40 PM
Sat, Dec 4 9:24 PM
Sat, Dec 4 911 PM
Sat, Dec 4 8:56 PM
Sat, Dec 4 G335 PM
Sat, Dec 4 8:42 PM
Sat, Dec 4 5:33 PM
Sat, Dec 4 531 PM
Sat, Dec 4 8:29 PM
Sat, Dec 4 G625 PM
Sat, Dec 4 8:26 PM
Sat, Dec 4 5:24 PM
Sat, Dec 4 5:24 PM
Sat, Dec 4 821 PM
Sat, Dec 4 7:39 PM
Sat, Dec 4 715 PM
S?t, Dec 4 710 PM

4

L]

IChoose Category

L]

IChoose Classification

L]

IChoose Warkgroup

L]

IChoose Priority

L]

IChoose Closure Code

L]

IChoose Impact

L]

IChoose Organization -

Problem Details
Only Recent Problems Will Be Available

Caller Org Name Category Hame Workgroup Hame Classification Name
HP Openvies Performance Insight Defect Standards & Technology Dh, takl, index related inci's =
HPF Operrviewy 1M Enhancement Request Migration project team Etnpty Database
HP Openview SPis Enhancetnert Reguest Deszign Archive SC

HP Operrviewy 1M
HP Operview TeMP

HP Openview Performance Insight

HP Operviewy M
HP Openview Operstions
HP Operview SIP
HP Operrviewy 1M
HP Operviews M
HP Operviewy M
HP Cperviess I
HP Operview TeMP
HP Opernview SIP
HP Operviews M
HP Operview TeMP
HP Openview SPis
HP Operview TeMP
HP Operrviewy 1M
HP Openview SPls
Linknown

Unknown

Defect

Enhaticetment Reguest
Defect

Defect

Enhancement Request
Enhancement Request
Knowen Error
Enhancement Request
Known Error
Unknown

Defect

Lnkhioswh

Known Error
Unknowvn

Known Error
Unknawn
Enhaticetment Reguest
Enhancement Request

Special Projects Engineering Maintenance Appointmemts

Design

Documertation
Technical Marketing
Change &Advisary Eoard
Future Procucts
Integration project tearm

tdain screen Release

ther

Create Distribution list

Dh, takl, index related inci's
Mairtenance user preferences
Global updste prices

Special Projects Engineering Actions

Interface Design team
Documentation
Design

Test & Quality Assurance

Integration project teatn
Documentation

Change &Advisary Eoard
Migration project team
Migration project team
Change Advisary Board
Standards & Technologr

Further Details for the Selected Item

Security

Achranced and Guick Find
Open workard. by specigrpiorg
Evert Interface Developers Kit
Forms

Mairtenance user language
Data Access Layer

Main screen Cliemplate
Search Standard YWarkorder
Aot

Cther

o

Folder Name Creation Date Deadline Date Actual Duration in hours Workgroup Searchcode
Developtnent Fri, Mary 2 433 P Fri, May 16 433 P 0.00 CURRENT
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Problems by Closure Code

This report shows the total number of problems for the selected category with a further

breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows problems

that were registered on or after the start date, and before the end date.

Field/Drop-Down

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Drill-down category table

Per category:

Number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number of problems closed after deadline

Click the drill icon to display information for a
particular category.

Total problems table

Total number of problems closed

Number of problems closed before deadline
Percentage closed before deadline

Number of problems closed after deadline

Closure code table

Number of problems per closure code in the selected
category.

Tabbed area with bar charts

Number of problems closed before deadline at
weekly, monthly or quarterly intervals (where
applicable) within the evaluation period and in the
selected category.
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Service Desk This report showes the total number of problems (with a creation time bebween the Start and End [ﬁ]

dates selected) for the selected category per closure code. Select dates for start and end periods.

Start Date <= Registration Time < End Date
Problems by Closure Code

invent

Start Date
IWed Dec 10 2003 vl Category # Probfems Before Pct After Closed # Problems Closed
Enhancement Reguest 635 78 11354 610 Before Pet After
End Date Unknown 722 76 1053 645 Deadine  0%ed Deadline
[Mon Decos 2004 5] Defect 734 o987 BE 263 2,508 1049 2,245
Krnoven Error 364 38 1044 326
Closure Code # Problems
Krowledge base 15 ﬂ
Solved in Service Desk 2.0 SP3 15
Mo salution could be found 14
Solved in WEBConnect 5.7.2 14
Solved in Service Desk 3.0 SP2 14
Closed on customer reguest 13
Solved in ITSM 5.5 patch 02 13 LI

Wizakly | Menthly | Quarterly |

Weekly Closed Before Deadline Total
For the selected Category

- =
[ N R R = V=

Dec 24 2003 i

# Closed hy Deadline

Jan 07 2004
Jan 21 2004
Feb 04 2004
Feb 18 2004
Mar 03 2004
Mar 17 2004

i
Mar 31 2004
Apr 14 2004
Apr 38 2004

]
May 12 2004
May 26 2004

£ Junoazo044

&

Jun 23 2004
Jul 07 2004
Jul 21 2004
Aug 04 2004
Aug 182004
Sep 01 2004
Sep 15 2004
Sep 29 2004
Qct12 2004
Qct 27 2004
Nov 10 2004
Now 24 2004
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Incoming Problems (History)

This report shows the total number of problems per classification, category, priority and
organization.

The user selects start and end dates for the evaluation period. The report shows problems
that were registered on or after the start date, and before the end date.

Filed/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Problems table Total number of problems opened.

Classification table Number of problems opened per classification.

Category table Number of problems opened per category.

Priority table Number of problems opened per priority code.

Organization table Number of problems opened per organization.

Tabbed area with bar charts | Percentage of problems opened at weekly, monthly or
quarterly intervals (where applicable) within the
evaluation period.
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Service Desk
Help Desk
Total Incoming Problems (Historical)

Thiz report shows the total number of problems (with a creation time betwzen the Stat and End
dates selected) per classification, categorny, priority and organisation. Select dates for start and
end periods. Start Date == Registration Time < End Date

[

invent

Start Date End Date

IWEd Dec 10 znnsﬂ IMon Dec 06 Eﬂﬂdﬂ

Classification

Foeken config (voor rapporten)

Aoid user wizard

Check List

Etnpty Database

Fetching Setvice - SLA - Service Level
Date Calculstions (Deadline, Duration, Start an...
ITP Connections

Main screen Crg.

Open Prokl. by Spec.

Search articls

Standard service call

Session manitor

Security

Mroaruicus T hroalddnuoaon

Category

# Probiems Opened
38 Defect

Unknown
knawn Errar

2R3 BRI RX R R ORI ORI RN BRI ORI ORI BRI

zl

Priority # Problems Opened
Critical 17
Escalated 16
Loy 16
Mahe 14
Serious 13
tedium 10
Unkhiowwi ]

Qrganization

wieakly | manthly | Quartarty |

Weekly Total Problems

L= o

(%)

Problem Count

o

Jan 14 2004
Jan 28 2004
Feb 11 2004
Feb 25 2004
Mar 10 2004
Mar 24 2004
AprQy 20041
Apr21 2004
May 05 2004
May 19 2004
Jun 02 2004
Jun 16 2004
Jun 30 2004
Jul 14 2004

o
]
=5
o

Enhancemert Reguest

Jul 28 2004

Aug 11 2004

Aug 25 2004

Sep 08 2004

Sep 22 2004

Oct 06 2004

# Problems Opened

Oct 20 2004

92

# Probiems Qpened
35

27

22

-]

# Problems Opened

Mow 03 2004
Mow 17 2004
Mee 01 2004
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Incoming Problems (Recent)

This report shows the total number of problems per classification, category, priority and

workgroup.

The user selects start and end dates and times for the evaluation period. The report shows
problems that were registered on or after the start date and time, and before the end date and

time.

Field/Drop-Down

Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.
End Hour The end time of the evaluation period.
Problems table Total number of problems opened.

Classification table

Number of problems opened per classification.

Category table

Number of problems opened per category.

Priority table

Number of problems opened per priority code.

Organization table

Number of problems opened per organization.

Tabbed area with bar charts

Number of problems opened at hourly or daily
intervals (where applicable) within the evaluation
period.

Help Desk: Problems
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SerVice Desk Thiz repart shows the total number of problems (with a creation time betwzen the Stat and End (bﬁ]

dates zelected) per classification, categony, prierity and wofgroup. Select dates for start and &nd

periods. Start Hour <= Registration Time < End Hour
Total Incoming Problems (Recent)

Start Date End Date

invent

ISun Moy 28 2004 Ll IMon Dec 08 2004 Ll # Problems Qpened
-1

Start Hour End Hour

INOVEBB:DDPM ﬂ |Dec54:ﬂﬂPM ﬂ

Classification # Problems QOpened Category # Problems Opened
Db, takl, index relsted inci's 1 Defect 2
Fetching Service - SLA - Service Level Enhancement Recuest 2
Mairtenance user language Unknower 2
Cither

Search Standard Workorder
Security

s oa a aoa

Frioriiy # Probiems Qpened Qrganization # Probiems Opened
Mone 2

Escalated
Serious
Unktiowt
Medium

A

1

Hourly Total Problems

Haurky | Doaiy |

[ox] [o5]

—

Prohlem Count

=

Date
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7 Change Management Reports

Administration

Configuration and logging Report

Change Management

Average Duration of Changes

Changes by Category

Changes by Classification

Changes Closed before Deadline by Category
Changes Closed by Deadline

Changes Closed on First Call

Changes Details

Changes by Closure Code

Incoming Changes (History)

Incoming Changes (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B,

Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to Service Desk Reporting data
import. It lists the most recent log table entries for report pack internal procedures. The
report is limited to the 200 most recent entries.

Field/Drop-Down

Description

Current logging level

Options (one or any combination):
e Error

e Warning

¢ Information

Log entries

Time the log entry was created
Component to which the log entry refers

Message

Service Desk
Change Management
Configuration and Logging

Thiz report displaws configuration information relating to Sendice Desk Reporting data import, it ﬁ
listz the mast recent log table entries for RepodPack internal procedures. The report is limited to
the 200 most recent entries.

invent

Time
Tue Dec 07 12:17 PM
Tue Dec 07 12:17 PM

Current Logging Level:

Errors, Warnings and Info

ReportPack Leg Entries

{most recent first)
Component Message
SenD_Changes_map_p Info: 4437 rowes inserted
SenD_Changes_map_p Info: 4437 rowes in datapipe table
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Average Duration of Changes

This report shows the total number of changes, and the average duration of changes, in days.

You can view these statistics on by classification, by category, by priority code, and by

workgroup. Once you select start and end dates for the evaluation period, the report shows
changes that were registered between the start date and the end date. The bar charts at the

bottom of the report show how the duration of changes has fluctuated from week to week,

month to month, and quarter to quarter.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Total changes table

Total number of changes and average duration (in
days).

Classification table

Number of changes and average duration per
classification.

Category table Number of changes and average duration per
category.
Priority table Number of changes and average duration per

priority code.

Tabbed area with bar charts

Average duration of changes at weekly, monthly or
quarterly intervals (where applicable).

Change Management Reports
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Service Desk

Change Manag
Average Durati

This report shows the awerage duration of changes in days (with a creation time between the Start

and End dates selected) per ¢lassification, categony, priority and wotkgroup, Choose a day for start

ement
on of Changes

and end periods. Start Date <= Registration Time < End Date

O

invent

Siari Dafe

End D2k

ITUB Dec 0B 2003 LI

Classification

Appl. Programmer Interface
Irtegrity

Cost Manager

System technology
Configuration manager
Systetn upgrade

Systetn administration

Task manager

Software Control&Distribution
Report manager

Software modification
Platform part

Helpdesk manager

Clhsmes wsmansy

FPriority
Serious
Escalated
Marne
Iledlium
Lo
Critical
Unknosn

Waakly | tanthly | Cuarterty |

II'\."Ion Dec 08 2004:|

# Changes

15
17
16
11
13
17
16
14
1
19
14

LT

# Changes
B5
G5
70
55
=l
55
37

1
1
1
1
1
1
1
1

Avg
L
2310
17.93
17.73
165.27
05.52
0515
.45
99 .95
9792
95.75
95.03
94 24

a2 e I

Avg
10525
9565
9180
an.g4
§3.93
7681
76.81

Category

Change manager decision
Cancelled

Unknown

Proposed for release

Upgrade of customization

Cust. Specific Customization
Early MewFesture Customization
Planned far release

Change &dvisory Board decision
Confirmed for release

Qrganization
HP Cpenview TetP
HF Cpenview SFls
HF Openviewy M
HF Openview Operations
HF Openwiew [
HF Cpenview SIP
Unknown
HF Cpenviewy Performance Insight

WeeKly Average Duration of Changes

Average
# Changes Duration (days)
400 90.99
# Changes Avg
42 113.30
20 105.43
47 101.07
55 95 69
32 an.55
47 86.53
40 G4.94
44 g0.21
42 573
i | E9.456
# Changes Avg
41 111 .28
42 104.22
47 101.05
BA 93.63
59 5670
34 85.23
20 584.35
51 7042

[ar] o
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=] =
o~ o~
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—_ o1
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[} ]

Jan 14 2004
Jan 28 2004
Feh 11 2004
Feh 25 2004
Mar 10 2004
Mar 24 2004

Apr 07 2004

Apr21 2004

Wlay 05 2004

hlay 19 2004

Jun 02 2004
Jun 16 2004
Jun 30 2004
Jul 14 2004
Jul 28 2004
Aug 11 2004
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a
o
[

Aug 25 2004

Sep 08 2004

Sep 22 2004

Oct 06 2004

Oct 20 2004

Moy 03 2004

Moy 17 2004
Mar 11 2004
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Changes by Category

This report shows the total number of changes in the selected category, with a further

breakdown by impact, priority and classification.

Once you select start and end dates for the evaluation period, the report shows changes that
were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Category table Number of changes per category. Click the drill icon
to display information for a particular category.

Total changes table Total number of changes.

Impact table Number of changes opened per impact code in the
selected category.

Priority table Number of changes opened per priority code in the

selected category.

Classification table

Number of changes opened per classification code in
the selected category.

Tabbed area with bar charts

Number of changes at weekly, monthly or quarterly
intervals (where applicable) within the evaluation
period and in the selected category.

Change Management Reports
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dates selected) for the selected categony perimpact, priority and classification. Select dates for

Service Desk This report showes the total number of changes (with a creation time bebween the Start and End (ﬁ]

start and end periods. Star Date <= Registration Time < End Date

Change Management T
Changes by Category

Start Date
IW Category # Changes Opened # Changes Opened
Propozed for release 24 419
End [ate Unknowen 21
IW Cust. Specific Customization 50
Change manager decision 46
Planned for release 4
Change Advisory Board decision 40
Confirmed for release 40
Upgrade of customization 39
Early MewFeature Customization 37
Cancelled 21
# Changes - # Changes 3 . # Changes
Impact Opened Priority Opened Classification Opened
Lowe [ 1 person affected) 15 Serious 11 Workarder module 6 S
Mane 11 Low 10 Unknawn £}
Meddivtn (Group [ Unit affected) 11 Critical 10  Doc: Document Reguirements 4
Top (Site J Organization affected) 9 None 9 Notification 3
Unknovan 4 hedium E  Integration 3
High (Department affected) 4 Unknown 4 Configuration manager 3
Escalated 4 System extension 2
Software madification 2
Problem manager 2
Organization manager 2
Doc: Error in docurmentation 2
Appl. Programmer Interface 2
Tasl vamamar el LI

Waskly I hanthly | Cuarterty |

Weekly Total Changes
for the Selected Category

— =
L o == R e |

Dec 17 2003 i

Change Count

Dec 31 2003
Jan 14 2004 §
Jan 28 2004
Feb 11 2004
Feh 25 2004
Mar 10 2004 §
Mar 24 2004 §
Apr 07 2004
Apr 21 2004
May 05 2004
Way 19 2004

O Jun 02 2004
Jun 16 2004
Jun 30 2004
Jul 14 2004
Jul 28 2004
Aug 11 2004
Aug 25 2004
Sep 09 2004
Sep 22 2004
Ot 06 2004 £
Oct 20 2004
Mow 03 2004 §
Now 17 2004
Mear N1 20N

ate
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Changes by Classification

This report shows the total number of changes by selected classification, with a further

breakdown by category.

Once you select start and end dates for the evaluation period, the report shows changes that
were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Changes table Total number of changes.

Classification table

Number of changes per classification. Click the drill
icon to display information for a particular
classification.

Category table

Number of changes per category with the selected
classification.

Tabbed area with bar charts

Number of changes at weekly, monthly or quarterly
intervals (where applicable) within the evaluation
period and with the selected classification.

Change Management Reports

113



114

Se rvice Desk This report shows the total number of changes (with a creation time between
the Start and End dates selected) for the selected classification with a futther ﬁ

break dowen by categony. Select dates for start and &nd periods.  Start Date

Change Management <= Registiation Time < End Date e

Changes by Classification

Start Date

Tue Dec OB 2003 |« # Changes Opened

419
End Date

Mon Dec 06 2004 »

Classification # Changes Opened
Task manager 23 =l Category # Changes Opened
Platform port 20 Upgrade of customization

Configuration manager 19 Unknowen
Problem manager 15 Change Advizory Board decision

Software CortroldDistribution 17 Cust. Specific Customization
17 Change manager decizion

Propozed for release

for the selected Classification

Wiorkorder mociule

System upgrade 16

Flanned for releasze
Change manager 16 .

Confirmed far relesse
Unknown 15
Report matager 15
Doc: Error in documentation 13
System extension 15 _I

Waakly ] Manthly | Cuarterty |

Weekly Total Changes
for the Selected Classification

= m o

%]

Change Count

=

Jan 21 2004
Feb 04 2004
Feh 18 2004
Mar 03 2004
Mar 17 2004
Mar 31 2004
Apr14 20047
Apr 282004
May 12 2004
May 26 2004
Jun 09 2004
Jul07 20041
Jul 21 2004+
Aug 04 2004
Aug 18 z004
Sep 01 2004
Sep 152004
St
oct122004 4
Oct 27 2004
Moy 10 2004

Y
o Jun 232004 I

LS N R VI R N SR
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Changes Closed before Deadline by Category

This report shows the percentage of changes closed before the deadline in the selected

category, with a further breakdown by closure code.

Once you select start and end dates for the evaluation period, the report shows changes that
were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Changes closed table

Total number of changes closed

Number of changes closed before deadline
Percentage closed before deadline
Number closed after deadline

Category table

Per category:

e Number of changes closed

e Number of changes closed before deadline
¢ Percentage closed before deadline

e Number closed after deadline

e C(Click the drill icon to display information for a
particular category.

Closure code table

Per closure code in the selected category:

e Number of changes closed

e Number of changes closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Tabbed area with bar charts

Number of changes closed before deadline at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period and in the selected
category.

Change Management Reports
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This report shows the percentage of changes clozed before the deadline (with a
creation time between the Start and End dates selected) for the selected categony

Service Desk

and closure code. Select dates forstat and end periads. Start Date <=
Change Management Ragistration Time < End Date ’
Changes Closed Before Deadline by Category

O

invent

Start Date End Date
|Tue Dec 08 2003 Ll II'\."Ion Dec 06 2004 Ll # Changes Closed Before -
Closed Deadiine
400 7 1.75
Category # Changes Before Pct After foieseleciedia teqony
Early MewFeature Customization 40 2 500 38 Closure Code # Changes
Proposed for release a5 1 1582 24 ProMelpdesk release 44 .03
Unkrosan 47 1 213 46 Solved in Service Desk 4.0 SP4
Planned for releasze 44 1 227 43 Salved in WEBConnect 5.7.5
Change manager decision 42 1 235 41 Owverture
Upgrade of custotmization 32 1 312 31 Solved in ITSM 5.6
Cust. Specific Customization 47 0.0o 47 Solved in ITSM 5.7
Change Advizory Board decisi... 42 0.00 42 Solved in customization(patch)
Confirmed far relesse | 0.00 31 Solvedin Service Desk 4.5 SP2
Cancelled 20 0.00 20 Solved in Service Desk 3.0 SP2
Unktioseet
Solved in WEBConnect 5.6
Solved in Service Desk 5.0

Visakly I Monthly | Quarterly |

Weekly Closed Before Deadline Total
For the selected Category

Closed After
Deadiine

Ee e 6 T ST O SR R L P

393

Before

# Closed by Deadline

Dec 31 2003
Jan 14 2004
Jan 28 2004
Feb 11 2004
Feb 24 2004
far 10 2004
tar 24 2004
Aprov 2004
Apr 21 2004
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May 19 2004
Jun 02 2004
Jun 16 2004
Jun 30 2004
Jul 14 2004
Jul 28 2004
Aug 11 2004
Alg 25 2004
Sep 08 2004
Sep 222004
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Oct06 2004

Oct 20 2004

Mov 03 2004
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Changes Closed before Deadline

This report shows the percentage of changes closed before the deadline per classification,
category, priority and workgroup.

Field/Drop-Down List Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Changes closed table Total number of changes closed

Number of changes closed before deadline
Percentage closed before deadline
Number closed after deadline

Classification table Per classification:

e Number of changes closed

e Number of changes closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Category table Per category:

e Number of changes closed

e Number of changes closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Priority table Per priority code:

e Number of changes closed

e Number of changes closed before deadline
e Percentage closed before deadline

e Number closed after deadline

Organization table Per organization:

¢ Number of changes closed

e Number of changes closed before deadline
¢ Percentage closed before deadline

¢ Number closed after deadline

Tabbed area with bar charts | Number of changes closed before deadline at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period.
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Se rVice Desk This repart showes the percentage of changes closed before the deadline (with a creation time
betwzen the Stat and End dates selected) per classification, categony, priority and wadgroup.
Change Management

Select dates for start and end periods. Start Date <= Registration Time < End D ate

Changes Closed Before Deadline

O

invent

Start Date End Date
ITue Dec08 2003 v | II'\."Ion Dec 5 2004 v | # Changes Closed Before Pet Ciosed After
Closed Deadiine Deadiine
400 7 1.75 393
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Doc: Document Reguirements 17 0o onoo 17 Cust. Specific Customization 47 0 000 47
Doc: changed Standards 17 0o 000 17 Change Advisory Board deci... 42 o000 42
System technology 17 0o onoo 17 Confirtned for release il 0 000 i |
Change manager 16 0o 000 16 Cancelled 20 0 000 20
Softweare Contral&Distribution 16 0 0noo 16
Problem manager 16 0 0noo 16
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Prior _ Pct . Qrganization _ Pct .
ty Closed  Deadiine Deadine Closed  Deadiine Deadine
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HP Openview SIP 34 0 000 34
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Changes Closed on First Call

This report shows the percentage of changes closed on the first call per classification, category,
priority and workgroup.

Once you select start and end dates for the evaluation period, and select an organization, the
report shows:

e  Number of changes closed on first call by classification, category, priority and workgroup
e Total number of changes opened during selected timeframe

e Total number closed on first call

e Percentage closed on first call

e Weekly, monthly, and quarterly graphs of total changes closed on first call

Field/Drop-Down List Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Changes closed table Total number of changes closed

Number of changes closed on first call
Percentage closed on first call

Classification table Per classification:

e Number of changes closed

e Number of changes closed on first call
e Percentage closed on first call

Category table Per category:

e Number of changes closed

e Number of changes closed on first call
e Percentage closed on first call

Priority table Per priority code:
¢ Number of changes closed
e Number of changes closed on first call

¢ Percentage closed on first call

Organization table Per organization:
¢ Number of changes closed
e Number of changes closed on first call

¢ Percentage closed on first call

Tabbed area with bar charts | Number of changes closed on first call at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period.
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Service Desk
Change Management

This repart shows the percentage of changes closed on the first call (with a creation time betwean
the Start and End dates selected) per classification, categony, priority and wodigroup. Select dates
forstart and end periods. Start Date <= Registration Time < End Date

Changes Closed on First Call

A

invent

Start Date

End Date

ITue Dec 05 2003 ﬂ

Classification

Platform part

Doc: Document Reguiretnents
System technology

Doc: changed Standards
Task manager

Workorder module

Change manager

Integration

Probiletr tranager

Software Control&Distribution
Configuration manager

Additional software
et hdanamar

Priority
Maone
Escalated
Serious
Medium
Critical
Lo
Unkrown

Wiaakhy | Manthly | Quartsrly |

o
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=]
]
[
—

o

o
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Dec 31 2003
Jan 14 2004

# Changes
Closed

Jan 28 2004
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17
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17
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15
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# Changes

Feh 11 2004

Closed
70
B&
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56
5
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a7

Feh 25 2004

|Mon Dec 06 2004:'

# Closed ol

War 10 2004

Tst Cail
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13
11
11
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# Closed on
Ist Calf

47
44
4
3
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6316 =
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64.71
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64.71
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av.a0
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75.00
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AR RT
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66 &7
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2336
5318
66 &Y
7027

Cateqory

Proposzed for release

Cust. Specific Custarization
Unknawn

Planned for release

Change Advisory Board decision
Change manager decizion

Eatly MNewFeature Customization
Upgrade of customization
Confirmed for release

Cancelled

Organization

HP Openviewy Operations

HP Openviews Performance Insi...
HF Qpenviesn I

Unknown

HP Openviews MRk

HP Openview SPls

HP Openviews TebP

HF Qpenvies SIP

Weekly Closed on First Call Percentages

War 24 2004
Apray 2004

Apr21 2004

May 05 2004
May 19 2004
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400
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35
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Mar 04 3004
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ari4
6667
4750
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6315
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&7 &0
G4.00
5745
a4
6341
73453
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Changes Details

This report shows the change records which have been received for reporting and processing
by the warehouse system. Only recent changes are available.

The user selects start and end dates for the evaluation period. The user can also set filters to
reduce the selection and find specific cases. The primary table displays a limited set of rows
(defaulted to 50) and the lower table provides further details for the selected item.

Field/Drop-Down List

Description

Start Date

The start of the evaluation period.

End Date

The end of the evaluation period.

Choose Category

Limit the report to changes in the selected category.

Choose Classification

Limit the report to changes with the selected
classification.

Choose Workgroup

Limit the report to changes for the selected
workgroup.

Choose Priority

Limit the report to changes with the selected priority
code.

Choose Closure Code

Limit the report to changes with the selected closure
code.

Choose Impact

Limit the report to changes with the selected impact.

Choose Organization

Limit the report to changes for the selected
organization.

Change details

Details for changes that meet the selected
parameters. Select an object for further details.

Further details

Further details about the selected object.

Change Management Reports
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Service Desk
Change Management

Changes Details

This report shows the change records which hawe been received for reporting and processing by the
warehouse system. Use the filters to reduce the selection and find specific cases. The primany table
displays a limited set of roves (defaulted to S00 at maost) and the lower table prowides futther details for
the selected item.

[

invent

Start Date

|M0n Now 01 zunaﬂ

End Date

Mon Dec 06 2004w

Modification Time
Sun, Dec 51206 PM
Sat, Dec 4 2:56 PM
Sat, Dec 4 1:54 PM
Sat, Dec 4 1:43 PM
Sat, Dec 4 1:23 PM
Sat, Dec 4 1:27 PM
Sat, Dec 4 1235 PM
Sat, Dec 4 10053 AM
Sat, Dec 4 10:49 AM
Sat, Dec 4 10045 Ak
Sat, Dec 4 10:46 AM
Sat, Dec 4 10045 A
Sat, Dec 4 10:44 A6
Sat, Dec 4 10:42 A0
Sat, Dec 4 9023 AWM
Sat, Dec 4 8:37 AM
Sat, Dec 4 5:36 AM
Sat, Dec 4 8:35 AM
Sat, Dec 4 8:31 AM
Sat, Dec 4 645 AWM
Sat, Dec 4 6:40 AWM

| Choose Category

L]

|Ch0053 Classification

L]

|Ch0053 Waorkgroup

L]

|Ch0053 Priority

L]

|Ch0053 Closure Code

L]

|Ch0053 Impact

L]

| Choose Organization

Caller Org Hame
HP Openview Performance Ihsight
HP Openview: SPls
HP Qpenviess Performance hsight
Unkror
HPF Qpenviesy Operations
HP Operiess M
HP Cperviessy LR
HP Qperviesse LI
HP Openview: Operations
HP Qpervviess LR
HP Operiess M
HP Cperviess M
HP Qperviess MM
HP Openview Performance Insight
HP Qpenviesy SPls
Unkriowh
HP Openvies TebP
HP Qperviesse LI
HP Openviesws TebP
HP Qperviess MM
HP Openview SPIs

Change Details

Only Recent Changes Will Be Available

Category Hame
Change manager decision
Planned for release
Upgrade of custormization
Upgrade of customization
Change manager decision
Cust. Specific Custamization
Early MewFesture Customization
Planned for release
Upgrade of customization
Planned for release
Unkriosh
Change manager decision
Cust, Specific Custamization
Planned for release
Change Advisory Board decision
Change Advizory Board decision
Cust. Specific Customization
Cust, Specific Custamization
Upgrade of customization
Cust, Specific Customization
Cust. Specific Custamization

-

L]

Workgroup Name
Documertation
Test & GQuality Assurance
Change &dvisary Board
Change Advisory Board

Classification Hame
Wiarkorder mocule =
System administration
Report manager
Additional software

Special Projects Enginesring Organization manager

Miggration project tearm
Current Products
Documertation

Currert Products

Design

Test & Guality Assurance
Unknoean

Migration project tesin
Interface Design team
Interface Design team
Standards & Technalogy
Migration project team
Test & Quality Assurance
Change Advisory Board
RFC Azzessment Team
Technical Marketing

Wiarkorder mocule

System administration

Doc: Error in documentation
Helpdesk manager

Problem manager
Matitication

Unknawn

Doc: Document Reguirements
Dioc: Error in documentation
System upgrade

Taszk manager

Matification

System administration
Helpdesk manager

System upgrade

Syatem extension

Fri, Dec 3 338 PM HP Openviess Wb Upgrade of customization RFC Azsessment Team Service Level Manager _H
4 1
Further Details for the Selected Item
Folder Name Creation Date Deadline Date Actual Duration in hours Workgroup Searchcode
Development Sat, Jun 21 1120 A 0.o0 CURREMT
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Changes by Closure Code

This report shows the total number of changes in the selected category, with a further
breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows changes that
were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Category table Per category:

¢ Number of changes

e Number of changes closed before deadline
¢ Percentage closed on before deadline

e Number of changes closed after deadline

e C(Click the drill icon to display information for a
particular category.

Total changes table Total number of changes

Number of changes closed before deadline
Percentage closed on before deadline
Number of changes closed after deadline

Closure code table Number of changes per closure code in the selected
category.

Tabbed area with bar charts | Number of changes closed before deadline at weekly,
monthly or quarterly intervals (where applicable)
within the evaluation period and for the selected
category.
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Service Desk
Change Management

Changes by Closure Code

This report shows the total number of changes (with 3 creation time between the Start and End

dates zelected) for the selected categony per closure code. Select dates forstart and end periods.

Start D ate <= Registration Time < End Date

O

invent

Start Date

ITue DecO0 2003 |- I

End Date

II‘\."Iun Dec 08 2004 vl

Wikl | wanthly | Quartsrly |

# Closed hy Deadling

Categmry # Changes Before Pct After Closed # Changes Closed
Early MewFeature Customization 40 2 500 38 Before Pct After
Proposed for release 55 1 182 54 Deadiine Closed Degdiine
Unknown 47 1 213 48 7 400 1.75 393
Planned for release 44 1 227 43
Change manager decision 42 1 235 41
Upgrade of customization 32 1 312 31 GClosure Code # Chanqes
Cust. Specific Customization 47 0.0o 47 =qlved in WEBConnect 5.7.5 g
Change Advisary Board decisi... 42 0.00 42 overture 2
Caonfirtmed for release | 0.oo 31 sovedin ITSM56 2
Cancelled 2 a.00 20 zolved in Service Desk 3.0 P2 2
Saolved in Service Desk 4.5 SP2 2
Solved in ITSM 5.7 2
Solved in customization{patch) 2 =l
Weekly Closed Before Deadline Total
For the selected Category
(3] =t =t =t =t =t =t =t =t =t =T =t =t =t =t =t =t =t =t =t =t =t =t
= = = = = = = = = = = = = = = = = = = = = = =
= = = = = = = = = = = = = = = = = = = = = = =
(o] (o] (o] (o] o (o] (o] o o o o~ [l o4 (] (o] (o] o4 (o] (o] (o] (o] (o] (o]
— =+ ==} -— o = =t - — o o [ L= = -+ ==} -— uw [==1 [} (=1 = o
8§ 5 5 3 F £ L 22 FEg 5553322385888 &8
Drate
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Incoming Changes (History)

This report shows the total number of changes per classification, category, priority and

organization.

The user selects start and end dates for the evaluation period. The report shows changes that
were registered on or after the start date, and before the end date.

Field/Drop-Down List

Description

Start Date The start of the evaluation period.
End Date The end of the evaluation period.
Changes table Total number of changes opened.

Classification table

Number of changes opened per classification.

Category table

Number of changes opened per category.

Priority table

Number of changes opened per priority code.

Organization table

Number of changes opened per organization.

Tabbed area with bar charts

Percentage of changes opened at weekly,
monthly or quarterly intervals (where
applicable) within the evaluation period.

Change Management Reports
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Change Management

end periods. Start Date <= Registration Time < End Date

Total Incoming Changes (Historical)

This report showes the total number of changes (with a creation time between the Stat and End
dates selected) per claszification, categony, priority and organization. Select dates for start and

A

invent

Start Date End Date

|Tue Dec 05 2003 j ||"."|0n Dec 06 2004 ﬂ

Classification # Changes Qpened Category

Task manager 23 |18 Proposed for release

Platforrm port 20 Unknowwn

Configuration manager 18 Cust. Specific Customization
Problem manager 18 Change manager decision
Software ControldDistribution 17 Planned for release

Woarkorder module 17 Change Advisory Board decision
Change mahager 16 Confirmed for release

Systemn upgrade 16 Upgrade of custamization
Additional software 15 Early MewFesture Customization
Doc: Error in documentation 15 Cancelled

Service Level Manager 15

Svstem docurnentation 15

Unknoweh 15

Custar avdansinm 15 LI

Priority # Changes Qpened Qrganization

Ezcalsted 69 Unknown

Maoke E¥ HP Qperviess LI

Critical B3 HP Openview: Operations
Serious B3 HP Openview TebP

Loy B3 HP Openview Performance hsight
Meddivm ] HP Openview: SPls

Unknioea 41 HP Qperviess MM

HP Openview: SIP

Waskly ] Manthly | Quarterly |

Weekly Total Changes

= 160

=

=

<120

T

=1

= 80

m

=

<40

o R P Y P, i P i e
[ I T =+ =+ = = o= =+ =+ = == =+ =+ = ==
o o O =1 =1 o o O =1 =1 o o O =1 =1 o o O
o o O =1 =1 o o O =1 =1 o o O =1 =1 o o O
[ I = B ] ™~ ™~ [ I S Y] ™~ ™~ [ I = B ] ™~ ™~ [ I = B ]
- = = == — [P — - — wooom o = =1 = W —
i o~ — L . ] = ™~ =T = — ™ R =
(=} (=3 [ = = e — — = = == == o = = = = =
@ ) m ] a o (L G q% q% m m = =1 =1 = S =
o o ] - s [ = E = = = = = z
Date

Aug 25 2004

# Changes Qpened

419

# Changes Qpened

a4
=1
a0
46
H
40
40
39
a7
21

# Changes Openead

G4
&0
55
55
a4
43
43
&

Sep 082004

Sep 222004

Oct06 2004

Oct20 2004

Moy 03 2004

Moy 17 2004
Mer M1 7N04
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Incoming Changes (Recent)

This report shows the total number of changes per classification, category, priority and
workgroup. Once you select start and end dates and times for the evaluation period, the
report shows changes that were registered on or after the start date and time, and before the
end date and time.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.

End Hour The end time of the evaluation period.

Changes table Total number of changes opened.

Classification table Number of changes opened per classification.

Category table Number of changes opened per category.

Priority table Number of changes opened per priority code.

Organization table Number of changes opened per organization.

Tabbed area with bar charts | Number of changes opened at hourly or daily
intervals (where applicable) within the evaluation
period.
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Service Desk
Change Management
Total Incoming Changes (Recent)

Thiz report shows the total number of changes (with a creation time between the Start and End ﬁ
dates selected) per classification, categony, priority and wotgroup. Select dates for start and end F

perinds. Start Hour <= Registration Time < End Hour

invent

Start Date End Date

ISun Nov 28 2004 :' II"."Iun Des 06 2004:'

Start Hour End Hour

|Nov23 700 AM :l IDBCE‘ID:OO AM Ll

Classification # Changes Opened
Helpdesk manager 1
Unknown 1

Priority # Changes Opened
Critical 1
Serious 1

Haurhy | Daily |

Category
Proposed for release
Unknown

Qrganization
HP Openviews Opetations
HP Openvieswy Performance Insight

Hourly Total Changes

Change Count

=t =t =t
= = =
= = =
(] [l o
==} o =
i~ o~ o
= = =
=] (=] (=1
= = =
= = a
= (=] =
n = =

Wed Dec 01 2004
Thu Dec 02 2004

Date

# Changes Qpened

Fri Dec 03 2004

2

# Changes Opened
1
1

# Changes Opened
1

1
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8 SLM Reports

Administration

Configuration and Logging Report

Customer Business Manager Reports

SLA Overview for Customer Business Manager
SLA Detail for Customer Business Manager
Service Detail for Customer Business Manager

SLO Detail for Customer Business Manager

Customer Relationship Manager Reports

SLA Overview for Customer Relationship Manager
SLA Detail for Customer Relationship Manager
Service Detail for Customer Relationship Manager

SLO Detail for Customer Relationship Manager

Service Manager Reports

Service Overview for Service Manager
Service Detail for Service Manager

Configuration Item Detail for Service Manager

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B,

Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to data import for the SLM Report
Pack. Use this report to locate a list of the most recent log table entries for report pack
internal procedures. The report is limited to the 200 most recernt entries.

Field/Drop-Down

Description

Current logging level Options (one or any combination):
e Error
e Warning
e Information

Log entry Time the log entry was created

Message

Component to which the log entry refers

Service Desk
Service Level Management
Configuration and Logging

This repior displavs oordguratien infomabion ilabing f» S0SLM Repading data imgart. { Btz the
o cawnd fag table enbder for Repod®ack interral procedunss The repod s limibed 4o e 200

o eecend gatner

Time
Fri &ar 1§ 0525 P
Ful Wlar 13 0525 P
Fui Wil 15 0520 Frd
Fii ar 15 06520 Frd
Fui star 45 0525 P
Fri Mar 48 05:25 P
Fri sar 18 0925 PM
Fui Wiar 15 0520 PR
Fui beflar 135 0520 Pid
Fii i 15 06520 Frd
Fui Mtar 15 05:28 FM
Fri tar 48 0425 P
Fri War 19 0425 PR
Fri Wtigr 15 0520 PR
Fui lflar 15 0520 Pid
Fii Mtir 12 0520 Frd
Fui Mlar 15 05:28 FM
Fii Star 18 0825 Prd
Fri War 13 0425 PR
Fui Wlar 13 0525 P
Fui Wtar 15 0525 P
Fii Wtar 13 (525 Pid
Fui Mlar 45 05:25 FM
Finbaar 10 0525 PM

130

Current Legging Level:
Errers, Warnings and Infe

Reportfack Log Entries
{rrstrsd rcent first)

A3 e et
SLM_Paripd Updass_p
SLK_Perdod _Update_p
S _Peniod_Update_p
LA _Panied_Updat_p
Sipd_Faned Updata_p
SLM_Panod Updaete_p
SLM_Parod_Updass_p
SULM_Pariod_Updase_p
SLkd_Feriod_Update_p
L _Paniod_Updata_p

SLM_Ficaarty_Usdala_g
SLW Picgarty_ Usdale g
SLE_Ficgsrty Uipdate_p
SLW_Fiogerty_Updabe_p
SLWI_Fiogeity_Usdabe_p
SLWI_Ficdaily_Lisdale_g
SLW_Ficparty Uzdals_p
SLW_Ficgarty Ligdals g
FLE_Fropardy Update_p
SLW_Fiogerty_Updabe_p
SLW_Fiogaty_Updabe_p
Slki_Fiepaily_Usdale_p
SLM_Ficgarty_Usdals_p
SLE_Ficgary Ugdats g

¢ Wrdachisg pieeadurs SLM_Farcd_Lpdats p
¢ Mesmiboer o deleded rowes 10

Celeting Time shifl efdarthas £2.0ECH

L Mmoo dalled riei O

Dataling EvalFanad cidar than 18- iaf-0d

: Updating Deovan Tima
o Wp-dating Sersice Houe

Up-dating EvalusiianFeiod propartytable
Updating $¥mesfamps in Rabe tables

: Locking pracaduts SLE_Fesad_Updale_s

: Upladuag precaduis SLM_Propesy Updata_p
2 rowm vpdaied

¢ Up-fating CSLOTHREESH prapesy takile

1 rowes wpdabed

: Upsfating CELO0ZSL0, propeity table

i) jews wadaled

: Updabing CEL0GEF propardy Eable

-0 rewvam wpdated

: Wpdating SLOZSLA prapary {asls
2 owe wpdated

o Uptating BLOGEF peaperty labi
L) e ppdaied

: Updaling Mabio peaparky lakla

- rewve wpdated
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SLA Overview for Customer Business Manager

This report provides overview information about all service level agreements, related to the
target user, in a specific reporting interval.

Field Description
Active SLA List
SLA (linked) List of service level agreements associated with

customer relationship manager. If the CRM is not
specified, all service level agreements.

Link: SLA Detail for Customer Business Manager

CRM Customer relationship manager associated with the
service level agreement

Service Level Service level for this agreement

Current Status Status of the agreement; options are green (complies
with the objective) or red (fails to comply with the
objective).

Drill-down Click the drill-down icon to display details about the

services associated with a particular SLA.

Evaluation Periods

Selection box Evaluation period for the selected SLA

SLA Summary for Current Period

Start Date Start date for the evaluation period
End Date End date for the evaluation period
Latest Status Latest compliance status for the selected evaluation

period (Compliance or Violation)

Latest Status Date Date when the latest compliance status was calculated

Services and Service Level Objectives

Service Service related to the service level agreement
Compliance SLO Service metric related to the service
Achieved Compliance Compliance value achieved by the service metric for the

selected evaluation period

Compliance Objective Compliance violation threshold value for the service
metric
Compliance Status Compliance status of the service metric for the selected

evaluation period (Compliance or Violation)
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hp OpenView Service Desk

Service Level Management

SLA Overview for Customer Business Manager

(3

inwvent

Select a name from the list of S0%=, and then one of its recent evaluation periods, to examine its compliance status. The bar chart shows
compliance and wielation distribution ower each day within the evaluation period. Note that the graph can not show data for curent day.

Achive SLA Lisf

oA

SLA CRM Service Level Current Status
EMail dlot com CRM EMail dct com EMail clot com Gold | B |
Edail up.inc CRM EMail upinc Ebail up.inc Silver D
EMail rry top 1 CRM EMail iy tap 1 EMail iy top Silver ] <4
EMail vy top 2 CRM EMail iy tap 2 EMail iy top Silver ] < -
EMail rry top 3 CRM EMail iy tap 3 EMail iy top Silver ] R | |
Evaluation periods :
From 30-may-2005" to 05-jun-2005' j
SLA Summary for current period
Start Date : 30-MAY-2005 Y}
End Date ; 05-JUn-2005
Latest Status ; |:j
Latest Status Date; 30-M&Y-2005 235500
Senvces and Senvice [ evel Objectives ﬁ
Service Compliance SLO ““““?“"“ Curr!plla_nt:e Compliance Status
Compliance Ohjective
Efdail Berlin Silver Email tvailability (Ehtail up.inc) .77 |:j
Endail Berlin Silver MTTR (Ehdail up.inc) 85.76 a0 |:'|

132
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SLA Detail for Customer Business Manager

This report shows compliance status details for a particular service level agreement during a

specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the
customer relationship manager. If the CRM is not
specified, all service level agreements.
Link: SLO Detail for Customer Business Manager

CRM Customer relationship manager associated with the

service level agreement.

Service Level

Service level for the SLA.

Current Status

Status of the SLA for the current evaluation period;
options are green (compliance) or red (violation).

Drill-down

Click the drill-down icon to display information for a
particular service level agreement.

Evaluation Periods

Selection box

Evaluation periods for the selected SLA

SLA Summary for Current Period

Start Date

Start of the evaluation period.

End Date

End of the evaluation period.

Latest Status

Latest compliance status for the selected SLA for the
selected evaluation period.

Latest Status Date

Date and time when the latest compliance status of the
drilled-down service level agreement was calculated.

Services

Selection box

Services associated with the service level agreement.

Service Summary for Current Period

Description

Description of the selected service.

Latest Compliance Status

Latest compliance status of the selected service for the
selected evaluation period.

Latest Status Date

Date when the latest status was calculated for the
selected evaluation period.
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Field

Description

Service Compliance Status
Distribution

Bar chart showing ratio of violation status to

compliance status for each day during the evaluation

period.

Service Infrastructure
Availability Status
Distribution

Bar chart showing ratio of achieved, not achieved, and
not yet calculated for each day during the evaluation

period.
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hp OpenView Service Desk (ﬁF]

Nervice Level Management

invent

SLA Detail for Customer Business Manager

Select 3 name from the list of SL%s, one of its recent evaluation periods, and then one of its active serices to examine the service
compliance and objective statuses. The two graphs respectively show compliance status and objective status distribution. Mote that all
graphs ¢an not show data for current day.

Aclive SLA Lisf M a
SLA CRM Service Level Current Status
Etdail dot .catm CRM EMail dot.com Ehdail dot.com Gald i ﬂ:q]
Ehdail up.inc CRM EMail up.inc Ehdail up.inc Silver = ﬂa
Ehdail ny top 1 CRM EMail ny top 1 EMail ny top Silver
Ehdail ny top 2 CRM EMail ny top 2 Ebail ny top Silver @ ﬂ:q] b
Etdail ry top 3 CRM Ehdail iy top 3 Etdail ney top Silver ™ ﬂ:ﬂi LI
Fvaluation periods : Senvices :
From 09-may-2005' to 15-may-2005" | | EMail News ork =
SLA Summary for current period Service Summary for current period
Start Date : 09-MAY-2005 o Description : Ehail Meww York o}
End Date : 15-MLY-2005 Latest Compliance Status : [
Latest Status : 1 Latest Status Date : 15-mary-2005 23555:00
Latest Status Date: 13-MAY-2003 23:353:.00

-
Service Compliance Status Distribution w( Service Infrastructure Availakility Distribution W

Sendce Compliance Status Distribution for cirrent period

100
a0
20
o
= Jo
= a0
=
g 50
w 40 W violation %
m oo .Enmpllance%
£
20
10
u}
I's} '} '} ') 's] I's} I's}
= =1 =1 = ] =1 =1
=1 =1 =1 =1 =1 =1 =1
™ e e & ™ o~ o~
N £ £ £ £ £ £
m m m m m m m
= = = = = = =
o =1 - 2] o + 1
[ - - - - - -
Date
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Service Detail for Customer Business Manager

This report provides service metric status details associated with a specific service.

Field Description

Active SLA List

SLA Service level agreements associated with the
customer relationship manager. If the CRM is not
specified, all service level agreements.

CRM Customer relationship manager associated with the

service level agreement

Service Level

Service level for the service level agreement.

Current Status

Status of the SLA; green (compliance), yellow
(jeopardy), or red (violation).

Drill-down

Click the drill-down icon to display information for a
particular service level agreement.

Evaluation Periods

Selection box

Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date

Start of the evaluation period.

End Date

End of the evaluation period.

Latest Status

Latest compliance status of the drilled-down service
level agreement for the selected evaluation period

Latest Status Date

Date and time when the latest compliance status of
the drilled-down service level agreement was
calculated

Services

Selection box

Services associated with the service level agreement

Service Summary for Current Period

Description

Description of the selected service

Latest Compliance Status

Latest compliance status of the selected service for
the selected evaluation period

Latest Status Date

Date when the latest status was calculated for the
selected evaluation period

Service Metric List for Current Service

Name

Name of the service metric

Latest Compliance

Latest compliance status of the service metric

Chapter 8



SIM Reports

Field

Description

Latest Date

Date and time when the latest service metric status
was calculated

Drill-down Click the drill-down button to display metric value
information for a particular service metric
Metric Value Graphical display of maximum metric values,

minimum metric values, and compliance metric
values against time for the drilled-down service
metric
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hp OpenView Service Desk (ﬁfn

service Level Management

inwvent

service Detail for Customer Business Manager

Select 3 name from the list of SLA=, an Evaluation Period, and an active Semice to examine their statuses and list associated Senvice
Metrics. Select 3 Sendce Metric to examine its detailz and a Metric values graph, for each day of selected evaluation period. Mote this
graph ¢an not show data for current day

Aclive SLA List o .
SLA CRM Senvice Level Current Status
Etvtail dot.com R EMail dot.com EMail dot.com Gold i B |
EMail upinc CRM EMail up.inc EMail up.inc Silver D
Email riy top 1 CRM EMail iy top 1 EMil iy top Siver ] e |
EMail riy top 2 CRM Ehtail ry top 2 EMail rry top Silver ] B | =l
Evaluation periods : Services :
From 02-may-2005" ta 08-may-2005" _ﬂ I Etdail Berlin vi
SLA Summary for current period Service Summary for current period
Start Date : O2-p8Y-2005 ﬁ Description : EMail Betlin De=cription ﬁ
End Date : 05-h2Y 2005 Latest Compliance Status : [
Latest Status : =] Latest Status Date : 05-mary-2005 23:55:00
Latest Status Date: 05-mMAY-2005 23:55:00

Service ffefric 5§ far current serrice ﬁ
Hame Metric Latest Compliance Latest Date
Silver MTTR (Ebail upine) MTTR |:j Sun May 08 11:55 PM

Metric Value
20,0007
16,000 T
= 12'000-/
= 3
= —hax hetric Wal
= goo0T ax hletric Walue
1 —hdin Metric Walue
d.000T Objective Walue
a + !
'} '] L '] L '} y
[ [ [} fou] & & £
=1 o =1 =] =1 =1 c
=] % 7] % & =] I3
2 2 = S S 2 3
m m m m m m 1
= = = = = = H
o ol + i o [ 4
=} =] = [ =1 =} c
Cate
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SLO Detail for Customer Business Manager

SIM Reports

This report provides information about the service level objectives associated with a service.

Field Description

Active SLA List

SLA List of service level agreements associated with the
customer relationship manager. If the CRM is not
specified, all service level agreements.

CRM Customer relationship manager associated with the

service level agreement.

Service Level

Service level for the service level agreement.

Current Status

Status of the SLA; options are green (compliance),
yellow (jeopardy), or red (violation).

Drill-down

Click the drill-down icon to display information for a
particular service level agreement.

Evaluation Periods

Selection box

Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date

Start of the evaluation period.

End Date

End of the evaluation period.

Latest Status

Latest compliance status of the drilled-down service
level agreement for the selected evaluation period

Latest Status Date

Date and time when the latest status was calculated.

Services

Selection box

Services associated with the service level agreement

Service Summary for Current Period

Description

Description of the selected service

Latest Compliance Status

Latest compliance status of the selected service for
the selected evaluation period

Latest Status Date

Date when the latest status was calculated for the
selected evaluation period

Service Metric List for Current Service

Name

Name of the service metric

Compliance Status

Compliance status of the service metric

Category

Category of service metric; options are Standard,
Aggregated, or Infrastructure.
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Field

Description

Achieved Compliance

Aggregated compliance value achieved by the service
metric

Objective Compliance

Compliance violation threshold value for the service
metric.

Drill-down

Click the drill-down icon to display metric value
information for a particular service metric.

Service Metric Compliance Percentage Distribution

Service Metric Compliance
Percentage Distribution

Graph showing the compliance percentage for each
day during the evaluation period.
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hp OpenView Service Desk

Service Level Management

O

invent

Service Level Objective Detail for Customer Business Manager

Select 3 name from the list of S0L%=, an evaluation period, and an active sanice to examine their statuses and list associated Semice

hetrics. Select a3 Senvice Metric to examine its final status, its global compliance percentage and its compliance percentage distribution
over each day of evaluation period with its aszociated thresholds. Mote that the graph can not show data for current day.

Aclive 5LA Li5f

A

SLA CRM Service Level Current Status
Ehdail dat.com CRM Ehdail dot.com Ebdail dot.com Gold i ﬂ:qi
Ebdail up.ine CRM EMlail up.inc Ebdail upLing Silver [:j ﬂ:q]
Ehail my top 1 CRM EMail iy top 1 Etdail my top Silver G
Ebdail iy top 2 CRM EMail my top 2 Etdail iy top Silver |:j —_qa bz
Etdail my top 3 CRM EMail my top 3 Etdail my top Silver [ ﬂ j
Evaluation periods : Services :

From D2-may-2003" to DB-may-EEIEIE';I

SLA Summary for current period

Start Date : 02-MAY-2005 »
End Date : 08-mAY 2005
Latest Status : i

Latest Status Date; 03-MAY-2005 23:55:00

| EMail Mew ark =]

Senvice Summary for current period

Description : Email Mewe “ork
Latest Compliance Status : i
Latest Status Date : 08-may-2005 2355

o

ao

Compliance

SIM Reports

Hame
Status
|j Silver MTTR (EMail ry top 1)
i Sliver Emailayvailability (EMail iy top 1)

Serrice flefric 5§ far currenf serrice

Achieved Ohbjective
Category Compliance Compliance
Standard 100 S0
Infrastructure 57.04 a0
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SLA Overview for Customer Relationship Manager

SIM Reports

This report provides overview information about all service level agreements that are related
to the target user in a specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the
customer business manager. If the CBM is not
specified, all service level agreements.
Link: SLA Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the

service level agreement

Service Level

Service level for the service level agreement

Current Status

Status of the service level agreement for the current
evaluation period; options are Compliance, Jeopardy,
Violation.

Predictive Status

Status predicted to be reached at the end of the
current evaluation period’ options are Compliance,
Jeopardy, Violation.

Drill-down

Click the drill-down icon to display information for a
particular service level agreement

Evaluation Periods

Selection box

Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date

Start date of the evaluation period

End Date

End date of the evaluation period

Latest Status

Latest status for the selected evaluation period;
options are Compliance, Jeopardy, or Violation.

Latest Status Date

Date when the latest status was calculated.

Services and Service Level Objectives

Service

Service related to the service level agreement.

Compliance SLO

Service metric related to the service.

Compliance Objective

Compliance violation threshold value for the service
metric.

Actual Compliance

Compliance value achieved by the service metric for
the selected evaluation period.

Compliance Status

Status of the service metric for the selected evaluation

period; options are Compliance, Jeopardy, or Violation.
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service Level Management

invent

SLA Overview for Customer Business Manager

Select a name from the list of SLA4=, and then one of its recent evaluation periods, to examine its compliance status. The bar chart shows
compliance and wiolation distribution owver each day within the evaluation period. Mote that the graph can not show data for current day.

Ackive SLA Lisf o a
SLA CEM Senvice Level Current Status
Ehdail clot.cam CRM Ehdail dot.cam Ehdail clat.com Gald i ﬂ:q]
EMail up.inc CRM EMail up.inc EMail upinc Silver |:j
Ebaail ry top 1 CRM Ehlail ny top 1 Ehdail ey top Sikver |:j "%
Ebdail ny top 2 CRM Ehail ny top 2 Ehdail ey top Sikver |:j ﬂ b
Etdail vy top 3 R Ehdail ny top 3 Etdail iy top Silver [:j ﬂ:q] LI

Evaluation periods :

From '30-rmay-2005" to 05-jun-2005" j

SLA Summary for current period

Start Date : 30-MAY-2005 e
End Date : 05-JUM-2005
Latest Status : |:j

Latest Status Date: 30-MaN-2005 23:55:00

Sendces and Senvice [ evel Qbjectives ﬁ
Senvice Compliance SLO ““““?“"“ CDI’I‘!HIIEI_HEE Compliance Status
Compliance Ohbjective
Ehdail Berlin Silver Emaildyvailability (Eail upinc) 9177 |':j
Ehdail Berlin Sibver MTTR (Enail up.inc) 8576 a0 |:j

I

@ Back to Top
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SLA Detail for Customer Relationship Manager

This report shows compliance status details for a particular service level agreement during a

specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the
customer relationship manager; if the CRM is not
specified, all service level agreements.
Link: SLO Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the

service level agreement

Service Level

Service level for the service level agreement

Current Status

Status of the service level agreement for the current
evaluation period; options are Compliance, Jeopardy,
Violation.

Predictive Status

Status predicted to be reached at the end of the
current evaluation period; options are Compliance,
Jeopardy, Violation.

Drill-down

Click the drill-down icon to display information for a
particular service level agreement.

Evaluation Periods

Selection box

Evaluation periods for the service level agreement

SLA Summary for Current Period

Start Date

Start of the evaluation period.

End Date

End of the evaluation period.

Latest Status

Latest status for the selected evaluation period.

Latest Status Date

Date and time when the latest status was calculated

Services

Service (selection box)

Services associated with the service level agreement

Service Summary for Curren

t Period

Description

Description of the selected service

Latest Compliance Status

Latest compliance status of the selected service for the
selected evaluation period
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Field

Description

Latest Status Date

Date when the latest status was calculated for the
selected evaluation period

Service Compliance Status
Distribution

Bar chart showing ratio of Compliance, Jeopardy, and
Violation for each day during the evaluation period.

Service Infrastructure
Availability Status
Distribution

Bar chart showing ratio of Achieved, Not Achieved,
and Not Yet Calculated for availability for each day
during the evaluation period.
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SL.A Detail for Customer Relationship Manager

Select 3 name from the list of SL%=, one of its recent evaluation periods, and then one of its active services to examine the sarvice
compliance and objective statuses. The four graphs respectively show compliance status percentage and distribution, and abjective status
percentage and distribution. Mote that all graphs can not show data for current day.

Aclive SLA Lisf e a
SLA CRM Service Level Current Status Predictive Status
Etdail dat.com CRM EMail dot.com EMail dot.com Gald ] i» ﬂ:q]
Etdail up.inc R Ehdail up.inc Ehdail up.inc Sikver @ ™ ﬂ::]
Etil rey tog 1 CRM EMail ry top 1 Etdail ry top Silver =] [ ]
Edtail my top 2 CRM EMail oy top 2 EMdail my top Silver @ E ﬂ:qi —
Etdail ry top 3 R Ehdail ey top 3 Etdail ney top Silver ™ ﬂ::] LI
Fvaluation periods : Services :
From 03-may-2008' to 15-may-2005" »| | EMail Mews York >
SLA Summary for current period Service Summary for current period
Start Date : 09-MAY-2005 Fo! Description : EMail Mew ark bl
End Date : 15-h&Y-2005 Latest Compliance Status : [
Latest Status : [ Latest Status Date : 15-may-2005 235500
Latest Status Date: 15-mM2%-2005 23:55:00

e

Service Compliance Status Distribution W( Service Infrastructure Availakility Distribution 1
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100
aa
a0
i)
=)
= Fo
= &0
=
@ G0
= W il ation %
E A D..Ieu:upard'g.r%
r_% 30 Bcompliance %
20
10
u]
o o o o ") o o
o o o o o o o
=1 =1 =1 =1 =] o o
o o o b 2] o] &~
L. £, £, £, £, L. L.
m m m m m m m
= = = = = = =
fu} =} - o ch <+ 's)
[m] - - - — - —
Date

SIM Reports 147



148

Service Detail for Customer Relationship Manager

This report provides service metric status details associated with a specific service.

Field Description

Active SLA List

SLA List of service level agreements associated with the
customer relationship manager (if specified), or all
service level agreements (if customer relationship
manager not specified).

CRM Customer relationship manager associated with the

service level agreement

Service Level

Service level for the service level agreement

Current Status

Compliance status of the service level agreement for
the current evaluation period (Compliance,
Jeopardy, or Violation)

Predictive Status

Compliance status predicted to be reached at the end
of the current evaluation period (Compliance,
Jeopardy, or Violation)

Drill-down

Click the drill-down button to display information for
a particular service level agreement

Evaluation Periods

Evaluation Period (selection
box)

Evaluation periods for the drilled-down service level
agreement

SLA Summary for Current Period

Start Date

Start date of the selected evaluation period

End Date

End date of the selected evaluation period

Latest Status

Latest compliance status of the drilled-down service
level agreement for the selected evaluation period

Latest Status Date

Date and time when the latest compliance status of
the drilled-down service level agreement was
calculated

Services

Selection box

Services associated with the service level agreement

Service Summary for Current Period

Description

Description of the selected service

Latest Compliance Status

Latest compliance status of the selected service for
the selected evaluation period

Latest Status Date

Date when the latest compliance status was
calculated for the selected evaluation period
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SIM Reports

Field

Description

Service Metric List for Current Service

Name

Name of the service metric

Latest Compliance

Latest compliance status of the service metric

Latest Date Date and time when the latest service metric
compliance status was calculated

Drill-down Click the drill-down button to display metric value
information for a particular service metric

Metric Value Graphical display of maximum metric values,

minimum metric values, and compliance metric
values against time for the drilled-down service
metric
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Service Level Management

Service Detail for Cusiomer Relationship Manager

(3

invent

Select a name from the list of SLAs, an Evaluation Period, and an active Service to examine their statuses and list associated Service
Metrics. Select a Service Metric to examine its Metric walues graph, for each day of selected evaluation period. Hate this graph can not

show data for current day

Acfive SLA 15§

N

SLA CRM Senvice Level Current Status Predictive Status
Ehail dot.com R EMail dot.com  EMail dot.com Gald ] [ ﬂ;q]
EMail up.inc CRM EMsil upinc EMail up.inc Silver [:] i
EMtail rry top 1 CRM EMail my top 1 ENtail ny top Silver =] =] '-Q-Tq]
Etdail rey tap 2 CRM EMail ny top 2 Edail ry top Silver i i q -
Etdail ney top 3 CRM Ebail ny top 3 Etail ny top Silver [ ™ ﬂﬂ_q] LI
Evaluation periods : Services :

Start Date :
End Date :

Latest Status :
Latest Status Date: 03-MAY-2003 235500

From UZ-may-2005' to DB—may—EDDE'j

SLA Summary for current period

02-pAay- 2005
05-hALY- 2005

o

IEMaiI Berlin 'l

Service Summary for current period

Description : Etdail Berlin Description ﬁ
Latest Compliance Status : ([
Latest Status Date : 08-may-2005 23.55:00

Hame X
Silver MTTR (EMail up.inc)

1200071
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Metric Value
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Sun May 05 1155 PM
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u]

0Z-May-2005
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SLO Detail for Customer Relationship Manager

SIM Reports

This report provides informati

on about the service level objectives associated with a service.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the
customer business manager. If the CBM is not
specified, all service level agreements.
Link: SLA Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the

service level agreement

Service Level

Service level for the service level agreement

Current Status

Status of the service level agreement for the current
evaluation period; options are Compliance, Jeopardy,
Violation.

Predictive Status

Status predicted to be reached at the end of the
current evaluation period; options are Compliance,
Jeopardy, Violation.

Drill-down

Click the drill-down icon to display information for a
particular service level agreement

Evaluation Periods

Selection box

Evaluation periods for the drilled-down service level
agreement

SLA Summary for Current Pe

riod

Start Date

Start of the evaluation period.

End Date

End of the evaluation period.

Latest Status

Latest status of the service level agreement for the
selected evaluation period

Latest Status Date

Date and time when the latest compliance status of
the drilled-down service level agreement was
calculated

Services

Selection box

Services associated with the service level agreement

Service Summary for Current

Period

Description

Description of the selected service

Latest Compliance Status

Latest compliance status of the selected service for the
selected evaluation period

Latest Objective Status

Latest objective status of the selected service for the
selected evaluation period
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Field

Description

Latest Status Date

Date when the latest status was calculated

Service Metric List for Current Service

Name

Name of the service metric

Compliance Status

Compliance status of the service metric

Category

Category of service metric (Standard, Aggregated, or
Infrastructure)

Achieved Compliance

Aggregated compliance value achieved by the service
metric

Objective Compliance

Compliance violation threshold value for the service
metric.

Drill-down

Click the drill-down icon to display metric value
information for a particular service metric

Service Metric Compliance Percentage

Ref Name of compliance threshold

Objective The objective threshold value and operator for the
compliance threshold

Severity The severity of the compliance threshold

Service Metric Compliance Percentage Distribution

Service Metric Compliance
Percentage Distribution

Graphical display of achieved compliance values over
the selected evaluation period.
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hp OpenView Service Desk

Service Level Management

Service Level Objective Detail for Customer Relationship Manager

[

inwvent

Select a name from the list of S0L%=, an evaluation period, and an active service to examine their statuses and list associated Sernvice
Metrics. Select a Service Metric to examine its global compliance percentage, and its compliance perzentage distribution ower each day
of evaluation periad, as its associated thresholds. Mote that both graphs can not showe data for current day.

Ackive SIA LisF

o

SLA CRM Service Level Current Status Predictive Status
Etvlail dot.com CRM EMail dot.com  EMail dot.com Gold [ i e |
EMail up.inc CRM EMail up.inc EMtail up.inc Silver ] (] B |
Ehdail ry top 1 R Ehdail ny top 1 Ehdail ey top Silver ) (=) ||
Ehdail ry top 2 CRMEMail nytop 2 EMail iy top Silver ] ] e |
-
[=CH PR B - | TR Al o b T CrA~l maadmm Tl =1 [—1 =k —
Evaluation periods : Services :

From 02-may-2005'to DB-may-QDDE';I

SLA Sununary for current period

Start Date : 02-h 2 -2005
End Date : 08-h 2N -2005
Latest Status : i

Latest Status Date: 05-MAN-2005 235300

o

| EMail Mew York x|

Service Sunmmary for current period
Description : EMail Mesw Work -
Latest Compliance Status : i
Latest Objective Status: [

Latest Status Date : O5-may-2005 2355500
Service feirkc lis for currenf sarvice ﬁ
Latest Achieved Compliance
Hame Cateqol z 5 N5
gory Compliance Compliance Ohjective
Silver MTTR (EMsil ry top 1) Standard ] 100 a0 B |
Sliver Email&yvailability (EMail ny top 17 Infrastructure i a7.04 =in}

Senvice Welric Compliance Percentage

A

Service hetnc Complianee Threshold Detail

Ref. Obhjective Severity
Threshald 1 = 80 critical
Threshold 2 =83 major
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Service Overview for Service Manager

SIM Reports

This report provides a list of all services that are managed by target user, together with

summary information.

Field

Description

Active Service List

Service Name of the service. Click the service to link to the
Service Detail report (Service Manager).
Description Description of the service

Service Manager

Service manager assigned to the service

Drill-down

Click the drill-down button to display information for
a particular service

Associated SLA (selection
box)

Service level agreements associated to the
drilled-down service

Associated Service Compliance Status

Last Compliance Status

Traffic light indicator of the last known compliance
status of the service (Compliant, Jeopardy, and
Violation) and the date and time the status was
calculated

Last Predictive Compliance
Status

Traffic light indicator of the last known predictive
compliance status of the service (Compliant,
Jeopardy, or Violation) and the date and time the
status was calculated.

Service Availability Status Distribution

Duration selection box

Duration for the graphs below showing the service
availability in sections of Achieved, Not Achieved,
and Not Yet Computed according to the time period
chosen. You can choose to view the graphs in
minutes, hours or days. The periods during which
the service is in the state Not In Service according to
the service hours schedules appear as dark areas in
the bar charts.
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Field

Description

5-Minutely Service
Availability

Service availability at 5-minute intervals over the
default duration (last two complete hours plus the
current hour up to the present moment), or the
duration specified using the Edit Graph button.

Hourly Service Availability

Service availability at hourly intervals over the
default duration (last complete day plus the current
day up to the present moment), or the duration
specified using the Edit Graph button.

Daily Service Availability

Service Availability values at daily intervals over the
default duration (last complete month plus the
current month up to the present moment), or the
duration specified using the Edit Graph button.
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inwvent

Service Overview for Service Manager

Select 3 name from the list of Services and one of its associated SLA to examine the compliance status of active zervice. Then zelect a
duration to examine the availability status through Service Awvailability Distribution graphs. Default durations are 2 hours# 1 day £ 1 month

until now,
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Service Detail for Service Manager

This report provides lists and links to underpinning services and configuration items, plus
information about service metrics for the selected service.

Field Description

Service Information

Service Name of the service

Service Manager Service manager assigned to the service

Last Availability... Most-recently calculated availability for the service
... for SLA Service level agreement associated with the service
Drill-down Click the drill-down button to display information for

a particular service

Underpinning Service List

Service Name of the subordinate service
Service Manager Service manager assigned to the service
Last Availability Status Most-recently calculated availability for the service

Underpinning Configuration Item List

Configuration Item Name of the subordinate configuration item

Last Availability Status Most-recently calculated availability for the CI

Service Metric List

Metric Name Name of the metric

Description Description of the metric

Unit Units for the metric data values

Category Category of metric (for example, Standard)

Metric Value Distribution

5-Minutely Metric Value Metric values at 5-minute intervals over the default
duration (last two complete hours plus the current
hour up to the present moment), or the duration
specified using the Edit Graph button.

Hourly Metric Value Metric values at hourly intervals over the default
duration (last complete day plus the current day up
to the present moment), or the duration specified
using the Edit Graph button.

Daily Metric Value Metric values at daily intervals over the default
duration (last complete month plus the current
month up to the present moment), or the duration
specified using the Edit Graph button.
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SIM Reports

hp OpenView Service Desk

Sservice Level Management

Service Detail for Service Manager

[

invent

Select 3 name from the list of Senvices to examine underpining Senvices and Configuration ltams of active service. Then select a duration
to examine the metric wvalue through Metric Walue Distribution graphs.

Senvice information ﬁ =
Service Service Manager _Las_t_ .. Tor SLA Service Level Customer
availahility...
Edsil Berlin Sry Mor Eail wp inc ﬁ Ehdail upinc Ebail up.inc Silver  PE EMail upline
Ebail Amsterdam Sy Mgr EMail daot.com i Endail dot.com EMail dot.com Gold - PE EMail daot.com ﬂ'::i bl
Edail Metwe “ork  Srv Mor EMail ny top ﬁ Ebail iy top 2 EMail iy top Silver  PE EMail ny top 2 ﬂ:qi
ChA=il hlmaay W el T R Ehdmil a0 dmm [— ] Chdmil oo dmm 4 Chimil mao dmam Thilome ME CrA~il mas b= 4 _—'m :.
Underpining Service List
Service Service Manager Last availahility status ﬁ
M Data
Underpining Confiquration item List
Conf. lkemn Last availability status ﬁ =
Exchance Berlin i
SGL Server Berlin ]
15 Betlin |:j
Metwvork Betlin i —
-
Service Metric List 5
Metric Name Description Unit Category
MTTR MTTR Integer Standlard

AN NN AN AN Y
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Configuration ltem Detail for Service Manager

SIM Reports

This report provides detailed information about a given configuration item. The target user

typically links to this report from the Service Detail for Customer Relationship Manager

report.

Field

Description

Configuration Item Informatio

n

Name Name of the configuration item

Latest Availability... Most-recently calculated current availability status
for the configuration item

... for SLA Service level agreement associated with the

configuration item

Service Level

Service level associated with the service level
agreement

Customer Service receiver associated with the service level
agreement
Drill-down Click the drill-down button to display information for

a particular combination of configuration item and
service level agreement

Configuration Item Availability Distribution

5-Minutely CI Availability

CI availability at 5-minute intervals over the default
duration (last two complete hours plus the current
hour up to the present moment), or the duration
specified using the Edit Graph button

Hourly CI Availability CI availability at hourly intervals over the default
duration (last complete day plus the current day up
to the present moment), or the duration specified
using the Edit Graph button

Daily CI Availability CI availability at daily intervals over the default

duration (last complete month plus the current
month up to the present moment), or the duration
specified using the Edit Graph button

Configuration Item Metric List

Metric Name

Name of the metric

Metric Unit

Units for the metric data values

Metric Value Distribution
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Field

Description

5-Minutely Metric Value

Metric values at 5-minute intervals over the default
duration (last two complete hours plus the current
hour up to the present moment), or the duration
specified using the Edit Graph button

Hourly Metric Value Metric values at hourly intervals over the default
duration (last complete day plus the current day up
to the present moment), or the duration specified
using the Edit Graph button

Daily Metric Value Metric values at daily intervals over the default

duration (last complete month plus the current
month up to the present moment), or the duration
specified using the Edit Graph button
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Configuration Ttem Detail for Service Manager

Select a name fram the list of Configuration Items, and then select a duration to examine itz awailability status pereentge through
Caonfiguration ltem Distribution graphs. Default durations are 2 hours ! 1 day /1 month until now.
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Q Troubleshooting the SD45 Datapipes

This chapter covers the following topics:
¢ Troubleshooting installation problems
e Verifying that views were created

e Verifying that data is being collected

Installation Problems

If problems come up during installation of one or both SD45 datapipes, the most likely cause
of the problem is an unsuccessful connection to the Service Desk 4.5 database.

Check the following two logs for errors:
{DPIPE_HOME}/log/report *.log
{DPIPE_HOME}/log/trend.log

If there are problems with Serverfile.txt in the {DPIPE_HOME}/data/ directory, trend.log will
contain the following errors:

2006-05-02 13:56:15:000, India Standard

Time,+05:30, trend proc_ launch,,DEF ERROR, 6084,6012,0,"The following command exited with
code 1: C:/0OVPI/jre/bin/java -classpath "C:/0OVPI/lib/SD.jar;C:/OVPI/lib/pidb.jar;C:/OVPI/
lib/jconn2d.jar;C:/0OVPI/lib/classesl2.jar;C:/0OVPI/1lib/0Opta2000.jar;" SD C:/OVPI c change"

2006-05-02 13:56:15:000, India Standard
Time,+05:30, trend proc,,DEF ERROR, 6012,5708,0,"Child terminated with exit code 1"

2006-05-02 13:56:16:000, India Standard

Time,+05:30, trend proc_ launch,,DEF ERROR, 4688,6336,0,"The following command exited with
code 1: C:/0OVPI/jre/bin/java -classpath "C:/OVPI/lib/SD.jar;C:/OVPI/lib/pidb.jar;C:/OVPI/
lib/jconn2d.jar;C:/0OVPI/lib/classesl2.jar;C:/0OVPI/1ib/Opta2000.jar;" SD C:/OVPI c help"

2006-05-02 13:56:16:000, India Standard
Time,+05:30, trend proc,,DEF ERROR, 6336,6020,0,"Child terminated with exit code 1%

If the one or both datapipes are unable to connect to the Service Desk 4.5 database, trend.log
will contain the following errors:

2006-05-03 15:33:20:843,GMT+05:30 Standard, 05:30 , , , ERROR, 0, 0, 0, Io exception: The
Network Adapter could not establish the connection [ErrorCode:17002]
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Were Views Created?

Installing the SD45 datapipes creates database views. Follow these steps to verify that view
creation was successful:

1 Login to the Service Desk 4.5 database.
2  Run the following commands at the sql prompt:

Oracle:

e desc ITSM_INCIDENTS_V

e desc ITSM_PROBLEMS V

e desc ITSM_SERVICECALLS_V

e desc ITSM_CHANGES_V

MS SQL:

e sp_help ITSM_INCIDENTS_V
sp_help ITSM_PROBLEMS_V
e sp_help ITSM_SERVICECALLS_V
e gsp_help ITSM_CHANGES_V

If the views were created, the Service Desk database will display a description of each view.

Why View Creation Might Fail

If views were not created, you probably made a mistake when you tried to configure OVPI to
recognize the Service Desk database an external database. As explained in Chapter 2, an
incorrect entry in the database connection information window will cause the connection to
fail, making it impossible to create views.

Verify the following:

1 Check that there is a Serverfile.txt file in the {DPIPE_HOME}/data/ directory and that
the entries in this file are correct.

2 Check for installation errors in trend.log.

3 The Service Desk server must be up when you install the datapipes. So, just before
installing the datapipes, check for database connectivity by pressing the Test Connection
button in Management Console.

4 You cannot create views unless your username has that privilege. Verify that your
username was granted sufficient privileges. Run the following commands at command
prompt in OVPI system:

Windows:

{DPIPE_HOME}\jre\bin\java -classpath
“{DPIPE_HOME}\1lib\SD.jar; {DPIPE HOME}\lib\pidb.Jjar; {DPIPE HOME}\lib\jconn2d.jar; {DPI
PE_HOME}\lib\classesl2.jar;{DPIPE_HOME}\1lib\Opta2000.jar;” SD {DPIPE_HOME} c change

and

{DPIPE_HOME}\jre\bin\java -classpath
“{DPIPE_HOME}\1lib\SD.jar; {DPIPE HOME}\lib\pidb.Jjar; {DPIPE HOME}\lib\jconn2d.jar; {DPI
PE_HOME}\lib\classesl2.jar;{DPIPE_HOME}\1lib\Opta2000.jar;” SD {DPIPE_HOME} c help
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Unix:

{DPIPE_HOME}/jre/bin/java -classpath “{DPIPE_HOME}/lib/SD.jar:{DPIPE_HOME}/lib/
pidb.jar: {DPIPE_HOME}/lib/jconn2d.jar:{DPIPE HOME}/lib/classesl2.jar: {DPIPE_HOME}/
1lib/Opta2000.jar:” SD {DPIPE_HOME} c change

and

{DPIPE_HOME}/jre/bin/java -classpath “{DPIPE_HOME}/lib/SD.jar:{DPIPE_HOME}/lib/
pidb.jar: {DPIPE_HOME}/lib/jconn2d.jar:{DPIPE HOME}/lib/classesl2.jar: {DPIPE _HOME}/
1lib/Opta2000.jar:” SD {DPIPE_HOME} c help

If the privileges were not right, the following error will be captured at the command prompt:
Message : ORA-01031: insufficient privileges
SQLState : 42000

ErrorCode : 1031

How to Create Views Manually

Follow these steps to create views manually:

1 Configure OVPI to recognize the Service Desk 4.5 database as an external database.
2  Perform any other pre-installation tasks.

3 Run the following commands at the command prompt.

{DPIPE_HOME}/bin/perl {DPIPE_HOME}/packages/SD45 Datapipe/
SrvDsk_ChangeManagement45 DP.ap/Launch _Create.pl

{DPIPE_HOME}/bin/perl {DPIPE_HOME}/packages/SD45 Datapipe/SrvDsk HelpDesk45 DP.ap/
Launch_Create.pl

s Data Being Collected?

Collecting data about incidents, problems, service calls or changes items raised during the
last three days populates the following tables on the report pack side:

e RSERVD_PROBLEMS_DATAPIPE

e RSERVD_INCIDENTS_DATAPIPE

e RSERVD_SERVICECALLS_DATAPIPE
e RSERVD_CHANGES_DATAPIPE

If data collection took place as expected, the system can tell you how many rows of data were
collected for each table. Follow these steps:

1 Login to OVPI.
2  Run the following queries at the sql prompt:
e select count(*) from RSERVD_INCIDENTS_DATAPIPE;
e select count(*) from RSERVD_PROBLEMS_DATAPIPE;
e select count(*) from RSERVD_SERVICECALLS_DATAPIPE;
e select count(*) from RSERVD_CHANGES_DATAPIPE;
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For each query, the system displays the number of rows collected.

Collecting Data Manually

Follow these steps to collect data manually:

1

2
3
4

Stop OVPI Timer and wait for processes to terminate.
Open the command prompt.

Change to the {DPIPE HOME}/scripts/ directory.
Run the following commands:

trend_proc -f SrvDsk Hlpd Retrieve_Data.pro
trend_proc —-f SrvDsk Chm Retrieve Data.pro
Verify that data was collected.

What to Do If No Data Is Collected

select
select
select

select

If you try to collect data manually, but the collection still does not take place, follow these
steps:

1
2

Connect to Service Desk 4.5 database using user id and password.

Column ta_period in views gives the time period at which incidents, problems, servicecalls
or changes were registered in service desk or its status was modified.

Run the following queries:

count (ta_period) from itsm_incidents_v where ta_period>sysdate-3;

count (ta_period) from itsm problems v where ta period>sysdate-3;

count (ta_period) from itsm_servicecalls v where ta period>sysdate-3;

count (ta_period) from itsm changes_v where ta_period>sysdate-3;

3

Check if any number of rows selected for Time Period that fall within the last 3 days
duration.

Check if the OVPI system has been configured properly.
Check whether the following two .pro files are modified for —S option

{DPIPE_HOME} /packages/SD45 Datapipe/SrvDsk HelpDesk45 DP.ap/
SrvDsk Hlpd Retrieve Data.pro

{DPIPE_HOME}/packages/SD45 Datapipe/SrvDsk ChangeManagement45 DP.ap/
SrvDsk Chm Retrieve Data.pro

The Server name with the -S option should be exactly same as the name you added as
external database.

Check {DPIPE_HOME}/log/trend.log file for information about errors that occurred
during data collection. An excerpt from trend.log, below, contains examples of the error
messages that were generated during data collection.
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:30,trend proc launch, ,DEF ERROR,Z30336,230292,0,"The following comoand exited wit
:30,trend proc, ,DEF ERROR, 230292, 5228,0,"Child terminatgd with exit code 17

130, crendtimer,  INFO, 52258,304,0, "Process [(id=23029Z) terminated. 108 sec.'

130, crendtimer,  INFO, 52258,304,0, "Process [(id=230560) términated. 154 sec.”

130, trendtimer, , INFO, 5225,304,0, "[Pid=225196] C:WOVFIfbin/mw collect -n -i 5 -K 1'
130, crendtimer, , INFO, 5225,304,0, "[Pid=230368] C:WOVPIYbinfee collect -i 5¢

130, trendtimer,  INFO, 52258,304,0, "Process [(id=228196) fterminated. 1 sec.”

:30,trend proc launch, ,DEF ERROR, Z30056,230083,0, "ThHe following comoand exited wit
:30,dpipe file,,ERROR,2304:28,230412,0, "Incorrect syntax in file 'CINOWPR TN toph Serid
130, ww_collect, , WARNING, 230412, 5644, 0, "collectd able BSERVD TNCIDEMTS DATAT
:30,trend proc, ,DEF ERREOR,Z3 60,0,"Child terminated with e e 107
130, trend proc launch _ERROR,Z30476,230058,0,"The following compand exit
:30,dpipe file,, F,Z230100,230388,0, "Incorrect syntax in £ile 'C:\OWPIS troph Servi
130, ww_collect  WARNING, Z303585,230540,0, "collection for table RIERVD PROBLEMS DATI
130, trend prog, ,DEF ERROR,230033,Z30560,0,"Child terwinated with exit code 107
t30.crend nroe launch. .DEF ERROR.5644.230055.0."The following command exited with

No Data in Reports

Since most reports are built on daily, weekly, and yearly tables, your first step is to verify that
tables contain data for the reporting period. A report needs at least 1 day, 1 week, 1 month,
and 1 year before data can roll up to daily, weekly, monthly, and yearly tables, respectivly.

Make sure that all the entries, including Category Name, Classification Name, Organization
Name, Actual Start Date, Actual Finish Date, and Actual Duration, were entered properly in
Service Desk. For example, if the Service Desk user fails to indicate the category, then the
OVPI report will report the incident category as unknown, making it impossible to locate the
incident in a by-category report. The same is true for changes, problems, and service calls. If
the attributes are not specified, the sorting function in OVPI will not be able to categorize the
item.
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10 Troubleshooting Help Desk and Change
Manager Data

The export of Help Desk and Change Manager data from Service Desk to OVPI is automatic.
No user intervention is necessary.

Entity Exporter and the OVPI SOAP Interface

The diagram below shows Service Desk exporting data to OVPL.

T T

[ o
L] [T
Ficl
Operations DB
[Chied Server)
|
Tahles
Sl-E OVPI: defirition
L Mgy, Server
| S Ee_callect Data Pipe
! '. Trend_sum
i . ! —Tmtz—— | Feports
FrilEspertr D:Errtrhesf Summan Tatio
[} a I
oL
ORI SOAP HelnD eskiCharge
Report Packs
hierface

The SD platform on the left is using Entity Exporter to export SD Entities (ServiceCall,
Problem, Incident, Change), configured by the XML entity mapping file, to the OVPI system
through an OVPI Simple Object Access Protocol (SOAP) interface. The SD entities are stored
in staging tables.

Moving Change Manager and Help Desk Data to OVPI

Following is a step-by-step description of data flow.
1  Entity Exporter reads the SDEntitiesReportMapping.xml file, located here:
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C:\Program Files\HPOpenView\data\conf\report\SDEntitiesReportMapping.xml

2 Entity Exporter exports SD entities to staging tables on OVPI.

3 Entity Exporter updates the following log:

C:\Program Files\HP OpenView\data\log\sd report admin.log0.0.en US

MNow 7, 2005 10:20:14

AM:15:10:;com.-hp.ov.sd. impl.report.entityExporter .EntityExporterLaunch: displayExportParamneter
*porter; INFO; The entity module name = HelpDesk

WNow 7, 2005 10:2Z0:14

AM:;16:10;com.hp.ov.sd. impl.

®*porter; INFO;: The exporter
MNow 7, 2005 10:20:14

AM ;1710 com.hp.ov.sd.impl.

Hporter ;IHF0: The exporter
MNow 7, 2005 10:20:14

AM:15:10;com.hp.ov.sd. impl.

report.

name =

report.

type =

CEPOrT.

*porter; INFO: The start datelonly

Mow 7, 2005 10:z20:14

AM:19:10:;com.hp.ov.sd. impl.

report.

entityExporter .EntitcyExporterLaunch: displayExportParsmet el
OVPT

entityExporter. . EntityExporterLaunch ;displayExportParamete;

FULL

entityExporcer .EnticyExporterLaunch: displayExportParametel
for incremental) = Mon MNow 07 10:20:13 CET 2005

entityExporter .EntityExporterLlaunch:displayExportParameter

*porter; INFO; The end date(only for increwental) = Hon MNowv 07 10:20:13 CET 2005

MNow 7, 2005 10:20:14

AM:;20;10;com.hp.ov.sd.impl.report.entityExporter .EnticyExporterLaunch: displayExportParswnet el
*porter; INFO;: The next schedule in hour (only for incremental launch manually) = 1

Now 7, 2005 10:20:15

AM:21:10:com.hp.ov.ad. impl.

of the module(Helphesk) is
Now 7, 2005 10:20:17

AM:z22:10:com.hp.ov.sd. impl.

entities found in datsbase
Now 7, 2005 10:20:17

AM:Z3:10:com.hp.ov.sd. impl.

entities found in datcabase
Now 7, 2005 10:2Z0:17

AM:;z24:10;com.hp.ov,.sd. impl.

rEport.

entityExporter.EntityExporter;duwp: sd.report.entityExport:

running. ..

CEpOrt.

entityExporter.ObhslUtil;getTotalEntities; sd.report.entityE:

for the entity : Probhlem

report.

entityExporter. DhsTcil;getTotalEntities;sd.report.entityE:

for the entity : Incident

report.

ter; INFO; Humber of new entities:

entityExporter .EntitcyExporterLaunch: displayExportResult; 5.
334

Now 7, ZDDS 10 ZD 17

. e - ——— =l Saeen 1

e m i S A e Tane m i mem Tandn S dm e Tl e e = em T mnman = Te m 1S e T e T m e T m e T o

4 Every hour trend _timer calls a PL/SQL procedure (ServD XXX map p).

5 The PL/SQL procedure uses ee_collect to transfer entities from staging tables to:
e Data tables (RSERVD_xxx)
e  Property tables (K__SERVD_xxx)
6 The PL/SQL procedure updates the following logs:
e RSDCM _PROCEDURELOG
e RSDHD_PROCEDURELOG

7 Once an hour, trend_timer calls SrvDsk_HelpDesk_Hourly.pro and
SrvDsk_ChangeManagement_Hourly.pro; based on directives in this files, trend_sum
calculates hourly totals and hourly averages.

8 OVPI updates trend.log.

9 Once a day, at 2:00 a.m., OVPI summarizes data for the day based on hourly
summarizations that took place during the previous 24 hours.

The following diagram illustrates the data flow described above.
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11 Troubleshooting Dimension and Fact Data

The SLM core exports data to OVPI. Fact data is exported to DataFeeder on OVPI, and
dimension data is exported to DimensionManager on OVPI. The .csv files created by
DataFeeder and DimensionManager on OVPI are collected by ee_collect and aggregated by
trend_sum. The diagram on the next page shows the SLM core exporting data to OVPI.

For a list of SLM dimensions and facts, see Appendix D, SLM Dimensions and Facts.

Data Flow for Dimension Data

The following procedure describes how dimension data moves from Service Desk to OVPI.
1 From the SLM core system, launch ReportingConfigTool.bat.

2 The Reporting Config Tool exports SLA, Service, and SLO information (the entire model)
to Dimension Manager.

3 The Reporting Config Tool logs all exported Dimensions to:
C:\Program Files\HP OpenView\data\log\ReportingConfigTool0.0.en US
4 Dimension Manager generates CSV files and spools CSV files to the following directory:
{DPIPE HOME}\data\ImportData\SLM\Dims\
5 Dimension Manager logs all the Dimensions received to this spool directory:
C:\Program Files\HP OpenView\data\log\DimensionManager0.0.en US
6 OVPI (trend_timer) calls import_SLM_data.pro, which scans the spool directory.
7 import_SLM_data.pro calls ee_collect; ee_collect uploads data to:
e Staging tables (SLM_P_xxx)
¢ Dimension tables (SLM_K_ xxx)
8 import_SLM_data.pro archives uploaded CSV files to:
{DPIPE HOME}\data\ImportData\SLM\Archived\
9 OVPI updates the trend.log file.
10 import_SLM_data.pro calls the following script:
execute PLSQL update SIM P tables.sqgl

11 The PL/SQL update script uploads dimension data from staging tables (SLM_P_xxx) to
property tables (SLM_K_xxx).
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12 The PL/SQL update script updates foreign keys in the SLM_K_SLA property table:

e The OID in the Paying Entity column is cross-referenced against the SLM_K_User
table, and the corresponding dsi_key_id is updated in the PayingEntity column.

e The OID in the CRM column is cross-referenced against the SLM_K_User table, and
the corresponding dsi_key_id is updated in the CRM column.

¢ The OID in the ServiceLevel column is cross-referenced against the
SLM_K_SERVICELEVEL table, and the corresponding dsi_key_id is updated in the
ServiceLevel column.

13 OVPI updates the SLM_R_PROCEDURE_LOG table.
14 OVPI empties the staging tables.

The diagram on the next page illustrates the flow of dimension data from Service Desk to
OVPL
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Sample CSV File

ee_collect loads CSV files from the following directory:
{DPIPE_HOME}\data\ImportData\SLM\Dims\

If the CSV files that reach this directory are staying there, not disappearing within a few
minutes, there is a problem. The problem could be that Oracle is down, or a disk is full. If the
database is down or if a disk is full, ee_collect won’t be able to remove files from this directory.

00000000-0000-0000-02h9-a24703967da72 SLA O 3 01/ Apr/z004
30/ Jun/2005 23:59 PE EDupont CEMN EDupont 00000000-0000-0000-0Z95
1 0 = iy =

oooooo00-0000-0000-0225-95032173f1%9e SLha 1 4 01/ Apr/2004
30/ Jun/z2008 23:589 PE EDupont CRMN EDupont 00000000-0000-0000-0z295
1 o o [ 2

oooooo00-0000-0000-0285-9a0532173f1a4 SLif:z 4 01/ Apr/2004
30/ Jun/2005 23:59 PE EDupont CREM EDupont 00000000-0000-0000-0Z295
1 o - e

oooooo00-0000-0000-0285-9a032173f1laa SLA 3 3 01/ Apr/z004
30/ Jun/2005 23:59 PE EDupont CEMN EDupont 00000000-0000-0000-0Z95
1 o = O: =

oooooo00-0000-0000-0295-951k40c1cf0f SLil=1xTd 4 19/ Now/ 2004
19/Nov/2005 6:49 PE EDupont CEMN EDupont 00000000-0000-0000-0295
il o SLA 1T1 descripTion

Sample Log Created by DimensionManager

DimensionManager is a simple program. It writes files to the spool directory. If
DimensionManager encounters a problem, it writes an error message. See the sample log
below. The following events will cause DimensionManager to generate an error message:

e DimensionManager cannot locate the spool directory
e DimensionManager cannot write to the spool directory

If DimensionManager cannot write to the spool directory, either the system is full or access
rights were not properly set.

Oct 6, 2005 5:21:07 <SOAP-ENV:Envelope xzmlns:SOAP-ENV="http://
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/
SOAP-ENV:encodingStyle="http://schemas.xmlsoap.orqg/soap/encod
<SOAP-ENV:Body>
<AddDimension>
<TransId>0</TransId>
<DimName>SLA 0</DimName>
<0ID>00000000-0000-0000-02b9-a470a2ded5ed</0ID>
<Attributes>
<Name>MySLA</Name:>
<EvalPeriod>4</EvalPeriod>
<StartDate>0Oct 1, 2005 3:15:07 PM</StartDate:>
<ServiceLevelRef>00000000-0000-0000-02b%9-a47039%9¢c7da72<
<IsActivated>1</IsActivated>
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SQL Procedure Log Updated by OVPI

The SQL Procedure log records foreign key updates only. Reviewing this log is an easy way to
verify that the system is working correctly. Use this log to see how many rows per property
table were updated. If no rows are being updated, the source of the problem could be Oracle.

Thu Oet 27 03058 Pl 5L _Property Update p Info: Unlocking precedure SLM _Property Update p
Thu Oet 27 0305 Pl SLM_Property_Update p Info: 18 rows wpdated

Thu Oct 2T 0306 P SLM_Froperty Update o Infa: Updating CSLOTHRESH proparty table
Thu Oct 27 03005 P SLM_Property Updste o Infz: 10 rows psdsted

Thu Oct 2T 0305 P SLM_Property Update p Info: Updating CSLOZSLA praperty table
Thu Ot 2T 0305 P SLM_FProperty Updats p Infio; & rows wpdatsd

Thu Ot 27 03065 Pl SLM_Property Updsts_p Infio: Updating CSLODEF property tsbls

Thu Ot 2T 0300 Fl SLM_Froperty Updste Info: 26 rows wpdated

Thu Oct 2T 0305 P SLM_FProperty Update p Info; Updating SLOZSLA property table

Thu Oct 2T 0305 P SLM_Property_ Update p Info: 31 rows wpdated

Thu ot 2T 0305 P SLM_Property_Updats_p Infio; Updating SLODEF property table

Thu Ot 277 0305 PR SLM_Property Update p Info: 21 rows wpdated

Thu Oet 27 02059 PR SLW_Property_Update p Info: Updsting Mstric property table

Thu Oct 2T 0305 P SLM_Froperty Update p Info: 20 rows wpdated
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Using Report Builder to Identity Tables and Views

If a report contains no data, use Report Builder to verify that tables contain data and that
foreign keys were updated correctly. In the example below, the user is opening a report from
Report Builder and checking for data in two places, SLM_RV_SLA_EXT and its property table
SLM_KV_SLA.

hp OpenView Service Desk “fn

service Level Management

inwvent

SLA Overview for Customer Relationship Manager

Select 3 name from the list of S0%=, and then one of its recent evaluation periods, to examine its compliance status. The pie chart shows
compliance, jeopardy and wiolation percentage owverthe entire evaluation period, and the bar ¢chart shows compliance, jeopardy and
wvialation distribution ower each day within the evaluation period. Note that both graphs can not show data for current day.

Active SLA List
SLA CBM Service Level Current Status  Predictive Status
Ehdail dot.com PE Ebail dot.com Ehdail dot .com Gold [ [ =
Etdail L it FE EMsil up inc Etdail up.ine Sikver & [
Envtail vy fop 1 FE Etdail ry top 1 Ehdail iy top Silver (%] ¥
Etdail riy top 3 FE Ehail ry top 3 Etdail ry top Sikeer & [ =4
Ehd=il ws dm0m 3 OE Ekd=il s dmun 3 Erd=il s dman Tilosse ==} =11 o

=

A Explanation -]
9 HP Logo
™, Line
—HEE Active SLA List
| Statistics
] Sort Order
] Constraint List
] Modes ;l
Property | Yalue |
Takle Marme SLM_RY_SLA_EXT
Diztinct False
M Rowes an
Drilldowen Constraints .. [And
Deferred Mode False
Froperty Tahle Mame  |SLM_KW_SLA
Table Type Rate |

After ee_collect imports dimensions, the script execute_ PLSQL_update_SLM_P_tables.sql is
invoked. This script updates the foreign keys in the SLM_K_SLA table. It updates foreign
keys by setting the PayingEntity column to the foreign key in the SLM_K_USER table, by
setting the CRM column to the foreign key in SLM_K_USER table, and by setting the
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ServiceLevel column to the foreign key in the SLM_K_SERVICELEVEL table. As a result,
these columns, containing OIDs, are updated with table dsi_key_ids. The PLSQL update
script records the number of rows that were updated in SLM_R_PROCEDURE_LOG.

Moving Fact Data to OVPI

The export of fact data to OVPI is automatic. No user intervention is required. This is how it
works:

1

SLM core creates two kinds of DataPoints:

e (Configuration DataPoints

¢ Runtime DataPoints

SLM core sends DataPoints to DataFeeder on the OVPI server:

¢ Configuration DataPoints are sent at SLM startup (timestamp=0).

e Runtime Datapoints are sent when a new metric value is received, when calculated
status is changed, at SLA Evaluation Period start/end, and for CI Planned Downtime
and Service Hours.

SLM core updates the following log file:
C:\Program Files\HP OpenView\datal\log\slm0O.0.en US

The SLM core uses a reliable communications system based on store-and-forward. If the
SLM core is unable to send data, it stores the data it cannot send in a spool directory.
Later, when sending data is possible, the SLM core retrieves data from the directory and
sends it. This is the path to the store and forward spool directory:

C:\Program Files\HP OpenView\data\data\Data Exporter\snf
DataFeeder updates temporary storage table, SLM_STAG_xxx.

DataFeeder updates staging tables. The staging tables contain current values (no history)
for all the metrics and all the status facts managed by SLM.

Sample staging table:

o= |

L

K=

[ R
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00000000-0000-0000-0281-a2a2224175aa| 1124358565156 | 0 4 4
00000000-0000-0000-02841-3232224175ah | 1124207100000 |0 0 0
7 DataFeeder spools CSV files containing current fact data to the following directory:
{DPIPE_HOME}\data\ImportData\SLM\Facts\
8 Every 5 minutes, import_SLM_facts.pro scans the spool directory; if files are located,
import_SLM_facts.pro calls ee_collect.
9 ee_collect reads the CSV files and populates rate tables (SLM_R_xxx).
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10 Every hour, trend_sum calculates hourly statistics for:

SLA

Service

CI

SLO

SLO Compliance

1 Once a day, trend_sum calculates daily statistics for:

SLA

Service

CI

SLO

SLO Compliance

The diagram on the next page illustrates data flow.

Troubleshooting Dimension and Fact Data
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Hourly and Daily Summarizations

The following table provides a list of hourly and daily statistics calculated by trend_sum.

Fact In the Hour/In the Day Statistics

SLA e Total compliant time
e Total jeopardy time
e Total violated time

Service e Total compliant time

e Total jeopardy time

e Total violated time

e Total achieved time

e Total not achieved time

e Total not yet computed time

CI e Total achieved time
e Total not achieved time

e Total not yet computed time

SLO e Total achieved time

e Total not achieved time

e Total not yet computed time
e Min value

e Max value

e Average value

e Last objective value

e Total violation time

SLO Compliance e Total compliant time

e Total jeopardy time

e Total Violated time

e Max value

e Min value

e Total achieved time

e Total not achieved time

e Total not yet computed time
e Min value

e Max value

e Average value

e Last objective value

e Last value Total violation time

Log Files to Investigate

If an error occurs during an export, the Status field in the Reporting Administration
workspace view displays Error. To find out more about the error, check the following files:
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e Global Service Desk log file
<installDir>/data/log/System*.*en US

¢ Dedicated Service Desk Reporting log file
<installDir>/data/log/sd report admin.log*.*.en US

e OVPI log on the OVPI server:
<OVPIInstallDir>/log/trend.log

In addition, you can activate tracing and check the trace files.

C:\OVPN\data\ImportData\SLM\Facis\SLA_1131405300000_152.csv

00000000-0000-0000-0281-a2a2224175aa 20051108 00:15:004 4
00000000-0000-0000-0281-a2a2224175ab 20051108 00:15:000 O

Logging All Datapoints

DataFeeder logs all the DataPoints it receives to the following file:
C:\Program Files\HP OpenView\datal\log\DataFeeder0.0.en US

See below for a sample log.

0]k ] P B [ o R o e B

AM:EQ638: 12 rcom. . hp.ov.sd.slm.util.3lmLogger: log:com. hp.ov.2d.slm.reportinglierver. dat
Received: 10 o0o000000-0000-0000-02k2-54701401 600k Doukle

null

0]k ] PR B [ oy S e e R

AM:E9639: 12 rcom. . hp.ov.sd.slm.util.SlmLlogger: log:com. hp.ov.2d.slm.reportinglierver . dat
Receised - w0 Q0000000-0000-0000-0281-a2a2224175aa Irtecier

o0 MySLA 1 ServicelevelAgreement
B o-d i 1] e W R PR o B B
AM:59640;: 12 com.hp.ov.ad.alm.util.S31lmlogger; log:com. hp.ov.2d. 2l reporting3erver . dat

Received: 1 0O Qooooo00-0000-0000-0209-5470e35£1001 Douhle
85.70651455448355 E] Infrastructure Availabi!
o0o00-0000-02b9-a470a2dedsed) 1 SJerviceMetricitatus z

[0+ e ] B e 2 B [y o B G R
AM:E9641: 12 rcom. . hp.ov.sd.slm.util.S3lmLogger: log:com. hp.ov.2d.slm.reportinglierver. dat

Received: 10 oooo0000-0000-0000-02k2-5470e38£1001 Integer
b {7 e 1 B o Infrastructure Availabhility (Hy3erwv:
ad470a2dedbed) 1 ServiceMetricStatus 2 TotalViolat:

0t ] T ORGP L g i
AM:E59642 12 com.hp.ov.2d.slm.util.S1lmLlogger; log:com. hp.ov.2d. 3l reporting3erver . dat
Received: 1 0O Qooooo00-0000-0000-02b9-5470e35£1000 Boolean
o null 1 ServiceltatusPerSLA
6ot U] e W i o PO i e L
AM:E59643 12 com.hp.ov.ad.slm.util.S31lmLlogger; log:com. hp.ov.2d.slm.reporting3erver . dat

Received: 1 0O Qoooooo0-0000-0000-02b9-5470e35£1001 Boolean
] Infrastructure Availability (My3erwvice/00000000-
ad7lazdedsed) 1 ServiceMetricitatus 2 Ohjectivelt:

6 [y el o Bl B R O R B T
AM:E59644 12 rcom.chp.ov.sd.slm.util.SlmLlogger: log:com:.hp.ov.sd.slm.reportinglierver. dat
Receiwved: 10 oo0o000000-0000-0000-02b2-5470238£1002 Boolean

i} TESEET 1 Configurationltem3tatus
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Moving Time Periods to OVPI

The export of Time Periods from SLM core to OVPI is automatic. No user intervention is
required. Following is a step-by-step description of data flow.

1 SLM core creates two kinds of DataPoints:
e Configuration DataPoints (SLA Evaluation Periods)
¢ Runtime DataPoints (Service Hours and Planned Down Times)
2 SLM core sends Configuration DataPoints at SLM startup (timestamp=0).

3 SLM core sends Runtime DataPoints when a new metric value is received, when
calculated status has changed, at SLA Evaluation Period start/end, and for CI Planned
Downtime and Service Hours.

4 Each time DataFeeder receives a DataPoint, it updates the following staging tables:
e SLM_STAG_EVALPERIOD
e SLM_STAG_PLANNEDDT
e SLM_STAG_SERVICEHOURS
5 Every 5 minutes, DataFeeder generates CSV files containing all received Time Periods.

6 The import_SLM_facts.pro script scans the facts spool directory and uses ee_collect to
import Time Period data into the following staging tables:

e SLM_P_EVALPERIOD
e SLM_P_PLANNEDDT
e SLM_P_SERVICEHOURS

7 The import_SLM_facts.pro script calls SLM_Period_Update_p, a PL/SQL procedure.
SLM_Period_Update_p adds new Time Period to three tables:

e SLA Evaluation Periods --> SLM_K EVALPERIOD table
e Service Hours and CI Planned Downtimes --> DSI_SHIFT table
e Service Hours and CI Planned Downtimes --> DSI_SHIFT SET table

The diagram on the next page illustrates data flow.
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Report Builder: Service Hours and CI Planned Downtime

The CI and related SLA reference can be found in CI and SLA Dimension tables:

e SLM K CI

e SLM K SLA

With that information, you can get:

e The key_id of the corresponding entry in the SLM_K_CI2SLA table

e The PlannedDT id in the same table (9999 in this example)

In DSI_SHIFT_SET, the CI Planned Downtime is identified by this name:
PDT xxx

where xxx is the id found in:

e SLM_K CI2SLA table, or

e gshiftset_set_id (9999 below)

Knowing the shift_set_id (9999) you can find all the periods for CI planned Downtime, given
by start/end date, in the DSI_SHIFT table.

ble Editor - "DSI_DPIPE"."SLM_K_CI25LA"

DSI_KEY_ID ¥ OID K NaMmE K DESCRIPTI. ¥ CI_REF B’ SLA_REF LoF
LInknown

L L T T
LVAVALELRLE N WA Y TLU LR LE ol

00000000-0000-0000-02...

B 00000000-0000-0000-0

SVH_3
SVH_4
SVH_5
SVH_6

ditor - "DSI_DPIPE"."DSI_SHIFT"
_FROM § D/
1 03-Jul-2005 09:... |04
04-Jul-2005 09:... |05
6-Jul-2005 12.... 08

DT 20050703 09:00:00 |0 0 0 0
DT 20050704 09:00:00 |0 0 0 0
DT 20050706 12:00:00 |0 0 0 0
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Sample Log File for PL/SQL Procedure

Thu Oct 2T 04:08 P
Thu Ot 2T 04:08 PM
Thu et 2T 04:08 PM
Thu Ot 2T 04:08 P
Thu Ot 2T 04:08 P
Thu Oct 2T 04:08 P
Thu Oct 2T 04:08 Pl
Thu et 2T 04:08 PM
Thu Ot 2T 04:08 P
Thu Ot 2T 04:08 P
Thu Oct 2T 04:08 P
Thu Oct 2T 04:08 Pl
Thu et 2T 04:08 PM
Thu Ot 2T 04:08 P
Thu Ot 2T 04:08 P
Thu Oct 2T 04:08 P
Thu Oct 2T 04:08 Pl
Thu Ot 2T 04:08 PM
Thu Ot 2T 04:08 P
Thu Ot 2T 04:08 P
Thu Oct 2T 04:08 P
Thu Oct 2T 04:08 Pl
Thu Ot 2T 04:08 PM
Thu Gt 2T 04:08 PM
Thu Ot 2T 04:07 PM
Thu Ot 2T 04:07 PM

190

The import_SLM_facts.pro script calls SLM_Period_Update_p. SLM_Period_Update_p adds

new Time Period to three tables:

e SLA Evaluation Periods --> SLM_K_EVALPERIOD table

e Service Hours and CI Planned Downtimes --> DSI_SHIFT table

e Service Hours and CI Planned Downtimes --> DSI_SHIFT SET table
See below for an extract from the SLM_R_PROCEDURE_LOG table.

SLM_Penod_Update_p Infio: Unlocking procedure SLM_Period_Update p

SLM_Penied_Update p Info: Mumber of deleted rows: ©
SLM_Peniod_Update p Info: Deleting Time shift older than 27-0CT-04
SLM_Penod_Update p Info: Mumber of deleted rows: O

SLM_Pericd_Update p Info: Deleting EvalPernicd older than 27T-0CT-04

SLM_Pencd Update_p Inserting into dsi_shift: PDT 20050706 12:00:00 ,0,0,0,0, 406, MULL, 1, 20050706 12:00:00, 20050

SIM Period Update p  PlannedDT: shift_set_id for PDT_Zis: 405

SLM_Pered Update_p Inserting inte dsi_shift: PDT 20050704 05:00:00 ,0,0,0,0, 405, NULL, 1, 20050704 05:00:00, 20050

SLM_Ferod Updste p  PlannedDT: shift_set_id for PDT_Zis: 405

SLM_Peried_Update_p Insarting into dsi_shift: PDT 20050703 05:00:00 ,0,0,0,0, 406, MULL, 1, 20050703 05:00:00, 20050

SLM_Pericd_Update_p PlannedDT: shift_s=t_id for POT_Zis: 406

SLM_Peried_Update p Infio: Updating DownTime

SLM_Pericd Update_p Inserting into dsi_shift: SYH 20050706 09:00:00 ,0,0,0,0, 401, MULL,
SLM_Penod_Update p ServiceHours: shift_set M for 5WVH_Zis: 401

SLM_Pericd Update_p Insarting into d=i_shift: SVH 20050706 05:00:00 00,00, 401, MULL,
SLM_Pencd_Update p ServiceHours: shift_set i for 5VH_Zis: 401

SLM_Pericd Update_p Inserting into d=i_shift: S%H 20050705 05:00:00 0,0,0,0, 404, MULL,
SLM_Penied_Update p ServiceHouwrs: shift_set M for 5WVH_Zis: 401

SLM_Pericd Update_p Inserting into d=i_shift: SYH 20050704 05:00:00 00,00, 401, MULL,
SLM_Penod_Update p SaerviceHowrs: shift sat M for 5VH_Zis: 401

SLM_Pericd Update_p Inserting into d=i_shift: SYH 20050704 05:00:00 0,0,0,0, 401, MULL,
SLM_Peried_Update p SarviceHours: shift_set i for BWH_Zis: 401

SLM_Penied_Update p Info: Updating Service Hours

SLM_Penod_Update p Info: Updating EvaluationPericd propertytable

SLM_Penod_Update p Info: Updating timestamps in Rate tables

SLM_Pericd_Update p Info: Locking procedwere SLM_Period Update p

1. 20050705 050000, 2005]

1. 20050700 090000, 2005]

1,20050T05 09:00:00, 20050

1. 20050704 09:00:00, 2005]

1. 20050704 09:00:00, 20050
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Appendix A: Platform Requirements

This appendix covers the following topics:

e Supported operating systems and databases, per-component
e Metric adapter options for the Service Level Manager module
¢ Instructions for installing Oracle on the OVPI server

e Instructions for creating an Oracle database

Supported Operating Systems and Databases

See below for a list of supported operating systems and databases, per-component.

Component Operating System Database

SD Management Server | Windows 2000 SP4 Oracle 9.2.0.5 with patch
Windows 2003 SP1 Oracle 9.2.0.6e
HP-UX PA 11.11 Oracle 10g Release 1+

HP-UX 11.23 (PA-RISC and Itanium) | MS SQL Server 2000 SP 3a
Sun Solaris 9 and 10

SD 5.1 GUI Client Windows XP Professional Oracle 9.2.0.5 with patch

SD Object Loader Windows 2000 SP4 Oracle 9.2.0.6

SD Agent Windows 2003 SP1 Oracle 10g Release 1+
HP-UX PA 11.11 MS SQL Server 2000 SP 3a

HP-UX 11.23 (PA-RISC and Itanium)
Sun Solaris 9 and 10

OVPI 5.1 Windows 2000 SP4 Oracle 9.2.0.5 with patch
Windows 2003 SP1 Oracle 9.2.0.6

HP-UX PA 11.11

HP-UX 11.23 (PA-RISC and Itanium)
Sun Solaris 9 and 10

Metric Adapter Options for Service Desk

Service Level Manager uses HP OpenView monitoring applications to measure the
availability and compliance status of services. Without the regular collection of data from
these monitoring applications, you cannot monitor compliance nor can you view SLM reports.

197



Metric adapters do the work of collecting data. The following table provides a list of metric
adapters and indicates which OpenView monitoring application the adapter works with. You
can install metric adapters on the Service Desk Management Server or you can install metric
adapters on the system that is running the monitoring application.

Metric Adapter | Monitoring Application Function

OVIS MA Internet Services Measure availability and compliance
by collecting values from an OVIS
database.

OVPM MA Performance Manager Measure availability and compliacne
by collecting values available to an
OVPM server.

OVSD MA Service Desk Automatically installed and

configured when you install the
Service Desk management server.
Allows you to measure availability
and compliance based on analyzed
data criteria logged by a Service
Desk server.

OVSN MA Operations Service Navigator Collects and publishes metric data
values based on service status
change events. Measures the
availability of configuration items as
well as service compliance. Discovery
identifies all Service Navigator
services currently being monitored.
The initial discovery process delivers
service status to the application
server. Thereafter, the metric
adapter publishes each status
change event.

For more information about metric adapters, see HP OpenView Service Desk Open Metric
AdapterDeveloper Guide. Metric adapter installation and configuration is covered in the HP
OpenView Service Desk Installation Guide. For information about generic metric adapter
configuration settings, see the HP OpenView Service Desk Service Level Manager Guide.

Installing Oracle 9.2 on OVPI

1 Click Next in the “Welcome” screen.
Accept defaults (OraHome92). Click Next.
Accept default. Click Next.

Select Custom. Click Next.

u A 0N

Deselect the following options:
a Enterprise Edition Options:

— Oracle Advanced Security
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d
e

f

O 00 N O

— Oracle Spatial

— Oracle Data Mining

Oracle Enterprise Manager products:
— Enterprise Manager Web site

— Oracle Management Server

— Oracle Change Management Pack
— Oracle Diagnostics Pack

— Oracle Tuning Pack

Oracle9i Development Kit

Oracle9i Windows Documentation
Oracle HTTP Server

Oracle Transparent Gateways

Click Next.

Accept the defaults. Click Next.

Select No (do NOT create a database now). Click Next.
Click Install.

Creating a New Database

Follow these steps to create a new database:

1 Select Start > Programs > Oracle - OraHome92 > Configuration and Migration Tools > Database
Configuration Assistant.

2 Choose the following options and click Next after choosing each option:

Create a database

New database

Database name: OVPI

Accept defaults

Accept default

Memory Tab: select Typical, accept default memory percentage (70%)
Character sets Tab: select Use Unicode (AL32UTF8)

Accept defaults

3 Accept defaults — Click Finish

Platform Requirements
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Appendix B: Scheduling Reports

To generate a report, create a schedule that includes information about how and when the
Web Access Server should run the schedule. Then add the events (reports) you want to
generate to the schedule. You can add one or more reports to any schedule.

The higher-level tasks are as follows:

e Task 1: Create a new schedule

e Task 2: Add reports to the schedule

e Task 3: Specify the formats for reports

e Task 4: Schedule when the report runs

e Task 5: Select the recipients

e Task 6: Specify parameters

e Task 7: If necessary, change the schedule

Task 1:  Create a new schedule.

1 Use your web browser to access the Web Access Server.
Log in to the Web Access Server.
Click Schedule in the links bar. The Schedule page opens.

Expand the Schedules folder and click New Schedule. The Create a New Schedule page
opens.

A oW N

In the Schedule Title box, enter a name for the schedule you want to create.
Select Add to Generator Timer.

Select the hour, the number of minutes past the hour, and a.m. or p.m.

0 N O O»

Click Create. The schedule_name page opens.

Task 2:  Add reports to the schedule.
1 Click Add Event. The New Schedule Event page opens.
2 Click Browse to display the Report Browser window.
3 Expand the folders to locate the report you want to schedule.
4

Click the report when you locate it. The Report Browser window closes, and OVPI updates
the New Schedule Event page.

Task 3:  Specify the formats for reports

1 Click Next. The Formats page opens.
2  Click Activate.
3 Indicate a drilldown depth. The default value is 5.
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Task 4:

Task 5:

Task 6:

Task 7:

6

Select the report formats you want to generate. Your options are:

e _html — You can view HTML reports on your local system using the Web Access
Server.

e srep — A dataset report is a repository of queried data. Once it is generated, it does
not access the database, so this is a fast and efficient way to view data.

e _.csv (simple) — A comma separated value file in which all elements are displayed in
CSV format.

e .csv (hybrid) — A comma separated value file in which tables are displayed in CSV
format and charts and graphs are displayed as images.

e pdf— A Portable Document Format (PDF) file lets you view the report using Adobe
Acrobat Reader.

Type the number of days that you want to keep the report. The default is to keep the
report indefinitely. You can keep a report for any number of days.

Click Next. The Triggers page opens.

Schedule when the report runs.

1

Select one of these options:

e To generate the report on a specific day of the month, click the appropriate box for the
day or days of the month.

e To generate the report on a specific day of the week, click the box for the day or days of
the week.

e To generate the report quarterly, click Generate Report Quarterly.
Click Next or Finish to continue.

If you selected PDF for the format of the generated report, then the Email Generated PDF
page opens. If you do not want to email the PDF, click Next in the Email Generated PDF

page.

Select the recipients who will receive the generated PDF report.

1

u A 0N

If it is not already open, open the Email Generated PDF page.

Select a user in the Available Users/Groups box, and click Add. Repeat for each user.
In the Subject box, type the subject text for the email message.

In the Message box, type the message you want to send to the recipients.

Click Next. The Parameters page opens.

Specify the parameters for the report.

1
2

Type the values for any parameters listed.

Click Finish to schedule the reports for generation.

If necessary, change the schedule:

1
2

Open the Schedule Title page.
Click the title of an event in the Schedule Title page. The Formats page opens.
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3 Click the View Details button to display detailed information about the event.
4 Do one of the following:

e  (Click Finish to schedule the report for generation.

e Use cron or trendtimer to schedule report generation.
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Appendix C: View Options

You have multiple view options for any table or graph. While the default view is usually
adequate, you can easily change to a different view. If you are using Report Viewer, right-click
the object to open a list of view options. If you are using the Web Access Server, follow these
steps to change the default view of a table or graph:

1  Click Preferences on the links bar.

Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click the Edit icon next to the table or graph.

o O AW N

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Sek Time Period, ..
_hange Constraint Yalues, .,

Select Nodes|Interfaces, ..

—hange Max Fows. .,
Wiew in new Frame

Prink Table. ..

Expork Element as 34, ..
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

geg Table Yiewer

Polled IP Qo5 Statistics Data - Input
Orver Previous 6 Hours
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i} 105 688

L R e Y e e Y o |

[=1ulu]
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Switched Pkts

Time Period
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u] Tue Oct29 0700 Ak
u] Tue Dot 20 0700 AW
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u] Tue Oct29 0700 Ak
u] Tue Oct29 0700 Ak
4] Tue Dot 29 0700 AM
u] Tue Oct 29 0700 Al

G3s Tue Oct 29 0645 A
u] Tue Oct 29 0645 A
u] Tue Dot 29 0645 Al

=10l

| v

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.
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add Cverlay...

Remove Dwverlay

Set Time Period, ..
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Select ModesfInterfaces. ..

Displayed Data

Grid
Legend
Skl

v T v v

Change Max Rows. .,

Display Data Table
Export Element as Y.,
Displan. Dwerlay Daka Takble

Export Graph Gwerlay Data as E54..,

View in new Frarme

Print Graph...

Delete Graph
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The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines

Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

Set Time Period. .. 43 s
Change Constraint Yalues. ..
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Displayed Data [ % !
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Legend J /\
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Export Graph Overlay Data as C5.., # Flot

Yiew in new Frame Scatter Plot

Prink Sraph. .. AL B S
e B Hi-Lo-Cpen-Close —

—roa  Candle
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

T+

95 Ee0

olure

7170 ¢

Sat Feb 24 06:00 &M EST
Mormal Disconnect (107 j= 74.00

s

04 t L t + t t t t
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected

time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

11,2400 7
852920 {
715440 {
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Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.
200.00
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000
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B Util Threshald

View Options 203



Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

T8A0 T

E2.80 ﬂ
a7.10 § (T M

21.40 ¢
15.70 1
u] + +
hdan 04 Tue 02 hed 03
— Awg Wilization (H)
— Ml ax Wilization (H)
— Wil Thrashold
Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

B Under 1 minute

O eetween 1 and & minutes

O Between & and 20 minutes

O petween 30 minutes and 2 hours
M Between 2 hours and 12 hours
M Ower 12 hours

If you are looking at data for multiple days, you will see multiple pie graphs, one per day.

204 Appendix C



Display Data Table

This option changes a graph into a spreadsheet.

=1k
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View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.
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Appendix D: SLM Dimensions and Facts

The following table provides a list of dimensions and facts for SLM.

Dimensions Fact Data
SLA Name Compliance status
Description Predictive Compliance status
Evaluation Period
Start/End date
Users
Service Level
Service Name Compliance status
Description Predictive Compliance status
SLA Availability status (Objective Status
Users of the Service Infrastructure Metric)
CI Name Instant Availability status of the CI
Description per SLA
Category
SLA
SLO/Metric Name Instant Compliance status
Description Metric Value
Objective Condition Objective Value
Objective Value Type
SLA
CI
Metric
Compliance SLO/Metric | Name Instant Compliance status
Description Metric Value
Objective Condition Objective Value

Objective Value Type
SLA

Service

Metric

Compliance Thresholds
(%)

Compliance Status and %
Predictive Compliance Status and %
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Dimensions

Fact Data

Time Periods

SLA Evaluation Periods
Service Hours

CI Planned Downtimes

SLA evaluation periods are based on
a dedicated dimension table; values
for Service Hours and CI Planned

Downtimes are generated by an
OVPI shift set feature.
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Appendix E: Contiguring SD for Attachments

Service Desk can include attachments with Service Desk items. Attachments are handled by
an FTP server. This can be any third-party server, so long as Service Desk is configured to
communicate with it. Before configuring Service Desk for attachments, create a user account
and folder for Service Desk on the FTP server.

) To protect your system from virus attacks, install a virus scanner on your FTP server and
schedule it to regularly check the attachments.

Follow these setps to configure Service Desk for the Attachment server:
1 Log onto a Service Desk client as an Administrator.

2  From the OV Configuration workspace, choose System Settings and then choose
Attachment Settings. The Attachments Setting dialog box opens.

3 Enter the Hostname of the attachments server and the User name (account) and
Password that Service Desk will use to connect to the server.

The Target folder is the folder on the attachments server where the attachments are stored.
Create the folder before you configure these settings.

Click the Use passive FTP box on if you do not want to use active FTP. With Passive FTP you
can set up firewalls between the Service Desk Server and file server that opens specific ports
for transfer and control.

Test the connection by clicking Test connection. Test connection creates a test directory on the
file server, named test-<random number>. This directory is used for troubleshooting.

Click the Save attachments in background box on to continue working while you save an
attachment. This can be useful if your network connection is slow, resulting in delays during
the save process. Use this feature for slow connections only. The system assumes the
attachment will be saved successfully—no notification is provided in the case of unsuccessful
saves. If the save action fails, the attachment is lost and this remains unnoticed until you
attempt to retrieve the file.

209



210 Appendix E



Glossary

BS15000 Standard

A standard based on the ITIL framework, issued by the British Standards Institution, that
provides implementation guidelines for IT service management.

change

When a change is needed, details about the change are entered in the Service Desk change
form. The change form allows the user to select relevant approvers, indicate a deadline for
responses, create a series of work orders, and assign each work order to a work group.

COBIT
Control Objectives for Information and Related Technology is an open standard published by
the Information Technology Governance Institute (ITGI).

JSR-168

Java Specification Request #168 is a Java portlet definition that provides standards for API’s
to allow information transfer between applications, specifically the areas of aggregation,
personalization, presentation, and security. See: http://www.jcp.org/en/jsr/detail?id=168
ICMB

ITIL Certification Management Board.

incident

Similar to a service call, with a different source. The source of a service call is a customer. The
source of an incident is a network management tool, a system management tool, or possibly a
technician. Any notification that is generated automatically, say for example, in response to a
login error, or in response to a threshold breach, or in response to a printer not working, is an
incident. A Service Desk user will use an incident form to describe the incident.

ITIL

Information Technology Infrastructure Library (ITIL) is a series of book that specify best
practices for managing IT infrastructure processes and changes. The series was revised in
2000 and will be revised again in 2006. The titles in the series are:

e Software Asset Management

e Service Support

e Service Delivery

¢ Planning to Implement Service Management
e ICT Infrastructure Management

e Application Management
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e Security Management

¢ The Business Perspective

metric adapter

A software module that you install and configure to collect metric data values from
monitoring software applications.

metrics

The results of measurements that provide the basis for SLM reports on compliance and
availability, and for compliance status monitoring in the OpenView console. Metric data
values are collected from external monitoring applications (for example HP OV Performance
Manager) or from analyzed data collected from Service Desk.

problem

A service call, or an incident, that cannot be solved until it is investigated further. The person
responsible for investigating a problem will open a problem form. The status of the problem is
New. The problem form describes the problem, identifies the CI involved, and provides
information about service calls, work orders, and approvals related to the problem. As soon as
the problem is investigated and a remedy is identified, the person investigating the problem
changes the status to Route Cause Identified and and adds a change process to the problem
form.

service contract

Reduces administrative overheads by enabling legal entities and common data shared by
multiple service level agreements to be specified once instead of multiple times. The
agreements and services specify the deliverables and the associated service provider and
receiver parties. Service level managers may find service contracts useful when setting up
multiple services and agreements, especially for organizations with many sub-divisions, each
with their own service level requirements.

service definition

A conceptual description of a service that provides a blueprint for structuring a service. The
definition allows you to show how services, service levels (the degree of support provided to
the customer), Service Level Agreements, CI definitions, and other service definitions relate
to each other. The service definition allows you to create multiple service instances and
associated service levels.

service hierarchy

Specifies the relationships between the services and configuration items that a particular
service depends on.

service level agreement

Specifies which services are to be delivered, the associated service quality, for example,
performance aspects, and the associated quantity of each service, that is, the level of
availability. The service level agreement forms the core of HP OpenView Service Level
Manager.
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Display Data Table, 201
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editing parameters, 13
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error messages in trend.log, 165, 168
Evaluation Period Aging (form), 38
execute_PLSQL_update_SLM_P_tables.sql, 175

exporting data to OVPI
Change Manager, 35
dimension data, 37
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Help Desk, 34
SLM core, 37
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group filters, 13
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import_SLM_data.pro, 175

incremental export
Change Manager data, 36
HelpDesk data, 35

installing Oracle 9.2
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legend options, 201

M

metric adapters
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(o)
OvObsReportAdmin script, 35, 36

OVPI Timer
starting, 21, 30
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Product Manuals Search (web page), 14
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reporting
OVPI reports (CM)
average duration of changes, 109
changes by category, 111
changes by classification, 113
changes by closure code, 123

changes closed before deadline by category,

115

configuration and logging, 108

incoming changes (history), 125

incoming changes (recent), 127
OVPI reports (HD)

average duration of service calls, 43

configuration and logging, 42

incidents by closure code, 79

incidents closed before deadline by category,

71
incoming service calls (history), 59
incoming service calls (recent), 61
service calls by category, 45
service calls by classification, 47
service calls by closure code, 57
service calls closed before deadline by
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service calls closed by deadline, 51
service calls closed on first call, 53
service calls details, 55
summary, 41, 63, 85

Reporting Config Tool, 175
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reporting daemons
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report pack tables
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report parameters, 13
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scheduling reports
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schedule when the report runs, 196
selecting the recipients, 196
specifiying parameters, 196
specifying the formats, 195

Serverfile.txt, 19
SLA (hourly and daily statistics), 185
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SLM reports
administration reports, 37, 38
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Time Shift Data Aging (form), 38
trend_export, 16
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